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GENERAL INFORMATION

SECTION 1 GENERAL INFORMATION

1.1 SCOPE OF MANUAL

This service manual contains installation, opera-
tion, programming, alignment, and service information
for the EFJohnson® RS-5300 Auris™ mobile
transceivers.

1.2 TRANSCEIVER DESCRIPTION
1.2.1 GENERAL

The Auris™ RS-5300 mobile transceivers can
operate on various types of channels and with various
signaling protocols (see following information).
Models are or will be available for operation in the
VHF 136-174 MHz and 800 MHz 806-870 MHz
frequency ranges. Repeater talk-around is also avail-
able with all bands. Power output is user switchable
for low and high levels as follows:

VHF - 10 - 50 watts, low and high switchable
800 MHz - 10 - 35 watts low and high switchable

1.2.2 ANALOG/DIGITAL OPERATION

The Auris RS-5300 transceivers use a digital
signal processor {DSP) to provide the signal modula-
tion required to operate on the following types of
channels. This provides backwards compatibility with
existing equipment and also the ability to operate on
various types of radio systems.

Narrow Band Analog - FM modulation is used with a
maximum deviation of 2.5 kHz. This mode is usually
used in systems with a channel spacing of 12.5 kHz.

Wideband Analog - FM modulation is used with a
maximum deviation of 5 kHz. This mode is usually
used in systems where the channel spacing is 25 kHz
or 30 kHz.

Project 25 Digital - Operates on Project 25 compatible
systems. The voice is digitized, error corrected,
optionally encrypted, and then transmitted using
C4FM modulation according to the Project 25 stan-
dard. This mode uses a channel spacing of 12.5 kHz.

1-1

1.2.3 OPERATING PROTOCOLS

The RS-5300 can be programmed for all the
following operating protocols. Refer to Section 3 for
more operation information.

¢ Conventional analog
® (Conventional Project 25 (digital)
® SmartNet®/SmartZone® analog or Proj 25 (digital)

1.2.4 SYSTEMS, CHANNELS, AND ZONES

A zone and channel are selected to place and
receive calls, The following describes the relationship
between systems, channels, and zones.

Systems

A system as used with this transceiver is a collee-
tion of channels (talk groups) belonging to the same
repeater site. A system defines all the parameters and
protocol definitions required to access a site. Up to
1 conventional system and 15 SmartNet/SmartZone
systems can be programmed {16 total).

Channels

A channel selects a radio channel or talk group in
a system as follows:

Conventional Analog Mode - A channel selects a
specific radio channel, Call Guard (CTCSS/DCS)
squelch coding, and other parameters unigue to that
channel.

Conventional Project 25 Mode - A channel selects a
specific radio channel, NAC squelch coding, and other
parameters unique to that channel.

SmartNet/SmartZone Operation - A channel selects
a specific talk group, announcement group, emergency
group, and other parameters unique to that channel.

A maximum of up to 256 channels can be
programmed with the preceding modes. The conven-
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tional system can be programmed with up to 256 chan-
nels, and each of the SmartNet/SmartZone systems
can be programmed with up to 256 talk groups
(channels).

Therefore it is theoretically possible to program
any combination of these systems that produces up to
256 total channels. However, the maximum number
may be limited by the available memory. For example,
since more memory is required to program a SmartNet
system than a conventional system, the total number of
channels decreases as the number of SmartNet systems
increases. The programming software displays a bar
graph which shows the amount of available memory
space that is used by the current data. Refer to Section
4.1.9 for more information.

Zones

A zone is a collection of up to 16 channels of any
type (conventional or SmartNet/SmartZone). For
example, a zone could include 12 conventional chan-
nels and 4 SmartNet channels. Zones are similar to
banks used in other EFJohnson transceivers. One use
of zones may be to program the channels used for
operation in a specific geographical area. Up to 16
zones can be programmed.

1.2.5 SECURE COMMUNICATION

Secure communication is available with all the
preceding protocols. The following types of encryp-
tion are avatlable:

Conventional Analog and SmartNet/SmartZone
Operation

® SecureNet™ DES/DES-XL, DVP/DVP-XL
* 460 Scrambling (Transcrypt)

Conventional Project 25 Operation

* DES-OFB
1.2.6 PROGRAMMING

Transceiver programming is performed using a
PC-compatible computer and an EFJohnson RPI
(Remote Programming Interface) and PCTrunk™
programming software (see Table 1-1). Programming
is described in Section 4.
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1.2.7 ALIGNMENT

Transceiver alignment is performed using the
same computer and RPI used for programming (see
preceding section) and special PCTune™ software.
All adjustments are made using the software (no
manual adjustments are required). Alignment is
described in Section 6.

1.3 PRODUCT WARRANTY

The warranty statement for this transceiver is
available from your product supplier or from the
Warranty Department, EFJohnson, 299 Johnson
Avenue, P.O. Box 1249, Waseca, MN 56093-0514.
This information may also be requested from the
Warranty Department by phone as described in
Section 1.7. The Warranty Department may also be
contacted for Warranty Service Reports, claim forms,
or any other questions concerning warranties or
warranty service.

1.4 PART NUMBER BREAKDOWN

The following is a breakdown of the part number
used to identify this transceiver.

242-53F1-SEC-OADE

F (Frequency Band)
1 - VHF (136-174 MHz)
3 - UHF* (403-470 MHz)
4 - UHF* (450-512 MHz)
8 - 800 MHz

T (Type)
5 - Mid Power*, Dash Mount
6 - Mid Power*, Remote Mount
7 - High Power, Dash Mount

8 - High Power, Remote Mount
* These models are currently not available

S (Signaling, Primary)
0 - Analog
1 - Project 25
3 - SmartNet Il
5 - SmartZone
7 - Project 25 Trunking
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E (Encryption, Hardware)
0 - No encrypticn hardware
1-DES
2 - DES/DES-XL
3-DVP
4 - DVP/DVP-XL
5 - Project 25 DES
6 - Project 25 DES/DES-XL
7 - DVP/DES-XL

C (Configuration)
1 - 6 Button

O (Options, Installed Conventional)
A - No installed options
D - Data cable

A (Analog or Additional Signaling)
A - No additional signaling
C - SmartNet 1
E - SmartZone

D (Data Options)
A -No data
B - Circuit Data*
C - Packet Data*
D - Circuit and Packet Data*

* These models are currently not available

E (Encryption and Security Software)
A - No encryption
B - S5C20-460
C - SC20-DES/460

1.5 TRANSCEIVER IDENTIFICATION

The transceiver identification number is printed
on a label that is attached to the chassis. The following
information is contained in the identification number:

Model Revision Manufacture Warranty
From PN.  Letter Date  Plant Number

l | | | |

3xx X A 13 9 W 12345

LW = Waseca
Last Digit of Year

0 = Analog
1 = Digital

Week No.
of Year

L

1-3

1.6 ACCESSORIES

The accessories available for this transceiver are
listed in Table 1-1. A brief description of some of
these accessories follows:

Key Cap Kit - The key cap kit includes 19 key
caps labled for various function, 5 blank key caps, and
5 plugs that can be inserted in the front panel if a key
is not used. Refer to Section 2.5 for more information

Table 1-1 RS-5300 Mobile Accessorie

Accessory Part No.

Key Cap Kit 587-5300-001

Mgounting Accessories
023-9750-012
023-9750-010
023-9750-011
585-7000-185
023-9650-006

Mounting bracket & hardware kit
DC power cable & hardware, 22 ft.
Accessory cable

Lockable Mounting Tray

Adapter cable (to use 86xx-series
power cable)

Microphones
Standard amplified dynamic
Standard, environ sealed
DTMF w/o mem
DTMF w/o mem, env seal WRS805
DTMF w/20 no. mem, envir seal

250-0740-310
587-9650-010
589-0016-028
587-9650-015
587-9650-012
250-0742-011
250-0151-006

Desk microphone

External speaker, 5" 15W 3.2 ohm
environmental sealed

Control station power supplies
15 amp, 117 VAC, 60 Hz (light duty)
15 amp, 230 VAC, 50 Hz (light duty)
15 amp, 117 VAC (heavy duty)
15 amp, 230 VAC (heavy duty)

DC and speaker cable adapter for
-0226 supply

585-4001-202
585-4001-204
239-0226-111
239-0226-211
023-9650-004

Programming Accessories
Remote prog interface (RPI)
Cable, RPI to transceiver (std) 023-9750-005
Cable, xcvr-xevr (cloning) 597-2002-268
Cable, RPI to computer DBM-DB9F 6 {t 597-5900-002
Cable, RPI to computer DB25M-DB25F [023-5800-017
PCTrunk prog software, 3-1/2” disks 023-5000-003

023-5300-000

PCTune software, 3-1/27 disk 023-5000-093
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Mounting Hardware - The mounting hardware and
DC power cable are shown in Figures 2-1 and 2-3 in
Section 2. A 22-foot DC power cable is used for both
front and remote mount applications. The cable is cut
to the required length at installation and any excess
discarded. The accessory cable is used to connect such
things as an external speaker, ignition sense input, and
a horn alert to the transceiver. It includes two 22-foot
and three 2-foot wires that are connected as required to
external points. The adapter cable is used to connect a
86xx-series power cable to these transceivers.

Lockable Mounting Tray - This bracket allows the
transceiver to be locked in place to guard against theft.
In addition, it allows it to be easily unlocked and
removed from the vehicle. Refer to Section 2 for
installation information.

Microphones and Speaker - The microphones in
Table 1-1 have an impedance of 620 ochms. All DTMF
microphones are backlighted. The environmentally
sealed microphones are sealed against such things as
rain, sand, and dust. The desk microphone can be used
for control station applications.

The external 15-watt speaker can be used in place
of the internal 5-watt speaker. It is non-amplified and
weatherproof. This speaker is connected to pins 1 and
2 of the accessory connector pigtail on the back of the
transceiver.

Control Station Power Supply - With the -4001 light
duty power supplies, the transceiver slides into the
power supply housing and receives power from
banana jacks on the back of the power supply. The
standard power cable is used for connecting power,
and the internal transceiver speaker provides speaker
audio.

With the -0226 heavy duty power supplies, the
transceiver mounts on a pedestal. The -004 adapter
cable is used to connect the transceiver DC and acces-
sory pigtail cables to the power supply power cable
and speaker. The transceiver internal speaker also can
be used if desired.

Programming Hardware and Software - The RPI
provides the interface between the programming
computer and transceiver. The cables from the RPI to
computer and transceiver are not included with the
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RPI and must be ordered separately. The transceiver
programming software is available for PC-compatible
computers only. The cloning cable allows one trans-
ceiver to program another with identical information
(a computer is not required). For security purposes,
encryption and scrambling keys are not transferred.

Scrambling and Encryption Options - These options
allow secure communication with other radios
equipped with Transcrypt 460 scrambling or the
Motorola DES/DES-XL module. The keyloader cable
connects the Keyloader system to the transceiver to
allow the DES/DES-XL encryption keys to be loaded.

1.7 FACTORY CUSTOMER SERVICE

The Customer Service Department of EFJohnson
provides customer assistance on technical problems
and the availability of local and factory repair facili-
ties. Regular Customer Service hours are 730 AM. -
5:30 PM. Central Time, Monday - Friday. The
Customer Service Department can be reached using
one of the following telephone numbers:

Toll-Free: (800) 328-3911
{From within continental United States only)

International: (507) 835-6911
FAX: (507) 835-6969

E-Mail: First Initial/Last Name@efjohnson.com
(You need to know the name of the person you want to
reach. Example: jsmith@efjohnson.com)

NOTE: Emergency 24-hour technical support is also
available at the 800 and preceding numbers during off
hours, holidays, and weekends.

When your call is answered at EFJohnson, you
will hear a brief message informing you of numbers
that can be entered to reach various departments. This
number may be entered during or after the message
using a tone-type telephone. If you have a pulse-type
telephone, wait until the message is finished and an
operator will come on the line to assist you. When you
enter some numbers, another number is requested to
further categorize the type of information you need.
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You may also contact the Customer Service
Department by mail. Please include all information
that may be helpful in solving your problem. The
mailing address is as follows:

EFJjohnson

Customer Service Department
299 Johnson Avenue

P.O. Box 1249

Waseca, MN 56093-0514

1.8 FACTORY RETURNS

Repair service is normally available through local
authorized EFJohnson Land Mobile Radio Service
Centers. If local service is not available, the equipment
can be returned to the factory for repair. However, it is
recommended that you contact the Customer Service
Department before returning equipment because a
service representative may be able to suggest a solu-
tion to the problem so that return of the equipment
would not be necessary.

Be sure to fill out a Factory Repair Request Form
#271 for each unit to be repaired, whether it is in or
out of warranty. These forms are available free of
charge by calling Customer Service (see Section 1.7)
or by requesting them when you send a unit in for
repair. Clearly describe the difficulty experienced in
the space provided and also note any prior physical
damage to the equipment. Then include a form in the
shipping container with each unit. Your telephone
number and contact name are important because there
are times when the technicians have specific questions
that need to be answered in order to completely iden-
tify and repair a problem.

When returning equipment for repair, it is also a
good idea to use a PO number or some other reference
number on your paperwork in case you need to call the
repair lab about your unit. These numbers are refer-
enced on the repair order and it makes it easier and
faster to locate your unit in the lab.

Return Authorization (RA) numbers are not
necessary unless you have been given one by the Field
Service Department. RA numbers are required for
exchange units or if the Field Service Department
wants to be aware of a specific problem. If you have
been given an RA number, reference this number on
the Factory Repair Request Form sent with the unit.
The repair lab will then contact the Field Service
Department when the unit arrives.

1.9 REPLACEMENTPARTS

Replacement parts can be ordered directly from
the Service Parts Department. To order parts by phone,
dial the toll-free number as described in Section 1.7.
When ordering, please supply the part number and
quantity of each part ordered. EFJohnson dealers also
need to give their account number. If there is uncer-
tainty about the part number, include the designator
(C512, for example) and the model number of the
equipment the part is from.

You may also send your order by mail or FAX.
The mailing address is as follows and the FAX number
is shown in Section 1.7.

EFJohnson

Service Parts Department
299 Johnson Avenue

P.O. Box 1249

Waseca, MN 56093-0514

1.10 INTERNET HOME PAGE

EFJohnson has a site on the World Wide Web that
can be accessed for information on the company and
such things as products, systems, and regulations. The
address is http://www.efjohnson.com.
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GENERAL INFORMATION

AURIS RS-5300 MOBILE SPECIFICATIONS

The following are general specifications intended for use in testing and servicing this transceiver. For current
advertised specifications, refer to the specification sheet available from your sales representative. Values are
typical and are subject to change without notice.

Frequency Range

Operating Modes

Mounting Location
Zones/Channels
Transmit/Receive Separation
Channel Spacing

Maximum Deviation

Frequency Stability Rx and Tx
Dimensions (w/o0 antenna)
Weight (w/std battery)

Supply Voltage

Current Drain (maximum)

Sensitiviey

Selectivity

Spurious and Image Rejection
Intermodulation

Hum and Noise

Maximum Frequency Spread
Audio Power Output

Audio Distortion

RF Power Output

Spurious and Harmonic Emissions

FM Hum and Noise

Audio Modulation

Audio Distortion

Maximum Frequency Spread

GENERAL

VHF: 136-174 MHz

800 MHz: 806-870 MHz

Conventional, Project 25 Conventional, SmartNet, SmartZone
Dash Mount {(Remote mount optional)

Up to 16 zones with 16 channels per zone

Any frequency within the range

VHEF: 12.5, 15, 25, and 30 kHz

800 MHz: 12.5 and 25 kHz

25 kHz analog - 5 kHz

12.5 kHz analog - 2.5 kHz

12.5 kHz analog NPSPAC - 4.0 kHz

2.5 PPM VHF, 1.5 PPM 800 MHz -22° to +140° F (-30° to +60° C)
2Z1I"Hx72"Wx83"D(5.3cmx 182 cm x21.1 cm)

51ibs 4 0z. (2.38 kg)

13.6 volts DC nominal, negative ground

Standby - 600 mA

Receive (rated audio out) -2.7 A

Rated Tx Power - 13.2 A

RECEIVER

0.35 uV (analog mode 12 dB SINAD), 0.35 pV (digital mode 5% BER)
-75dB

-75 dB

—75 dB at VHF, -73 dB 800 MHz

40 dB at 25 kHz, 34 dB at 12.5 kHz

Any spread within the range

5 W with internal speaker (12 W w/external 4-ohm speaker)

Less than 3% at 1 kHz

TRANSMITTER

VHEF: 10 - 50 W variable

800 MHz: 10 - 35 W vanable

—70 dB (VHF), -60 dB (800 MHz)

—45 dB at 25 kHz bandwidth

11KOF3E, 16K0OF3E, 8K10F1E, 20KOF1E, 18K8F1E, 14K0F3E
Less than 3% at 1 kHz

Any spread within the band
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INSTALLATION

SECTION 2 INSTALLATION

/4

7
e

7

TO 1GMITION
SENSE

. TO HORN
1L/ ALERT

]

Item L. Item o
No. Description Part No. No. Description Part No.
1 Amplified dynamic mic 250-0740-310 7 Self-drilling screw (4) 575-9077-565
2 |Screw, 4-20 x 5/8” thread frmg (3) |575-5604-020 8 |Knob (4) 547-0016-003
3 Screw, 4-24 x 1/4” sheet metal (3) {575-3604-008 9  |Power cable (22") and hardware 023-9750-010
4 |Microphone hanger clip 023-3514-001 16 |Accessory wire and hardware 023-9750-011
5  |Mic hanger ground wire 023-7171-911 11 |5" remote speaker 250-0151-006
6  |Transceiver mounting bracket 017-2226-034 ---  |Butt splice connector (2) 586-9008-061
Figure 2-1 Front Mount Installation Components
2.1 GENERAL 2.1.2 PERFORMANCE TESTS

Although each transceiver is carefully aligned
and tested at the factory, shipment can alter these
settings or damage the transceiver. Therefore, it is
good practice to check transceiver performance before

1it1s placed in service.

2.1.1 SCOPE OF INSTRUCTIONS

Since each installation 1s somewhat unique, the
following installation instructions are intended only as
a general guide to installing this transceiver.
Described are the intended use of the mounting hard-
ware and the electrical connections that should be

made.

April 1999
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2.1.3 TRANSCEIVER PROGRAMMING

The transceiver needs to be programmed before it
is placed in service unless it was ordered as factory
programmed. Programming instructions are located in
Section 4. Transceivers not factory programmed are
shipped programmed with test channels and other
factory test parameters.

2.1.4 POWER SOURCE

This transceiver is designed for installation only
in vehicles which have a 12-volt, negative ground
electrical system. This type of electrical system has the
negative battery terminal connected directly to the
vehicle chassis. Other types of electrical systems
require a voltage converter.

2.2 TRANSCEIVER INSTALLATION
2.2.1 GENERAL

Cable and Hardware Kit, Part No, 023-9750-010,
includes a 22-foot power cable, microphone hanger,
hanger ground wire, splice connectors, and all the
hardware (such as screws) that is normally required for
installation. Transceiver Mounting Kit, Part No.
023-9750-012, includes a mounting bracket with
knobs and mounting screws. Accessory Wire Kit, Part
No. 023-9750-011, includes a wire assembly that is
used to connect the ignition sense input and accesso-
ries. These components are shown in Figures 2-1 and
2-3.

2.2.2 SELECTING A MOUNTING LOCATION

Front-mount transceivers are designed for
mounting in a location near the operator such as the
dash, console, or transmission hump. Remote-mount
transceivers are designed for mounting in a location
such as the trunk.

WARNING

The mounting location of the transceiver or control
unit can daffect safe operation of the vehicle. Follow
these precautions when installing this transceiver:
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® Mount it where it does not interfere with operation
of the vehicle controls.

® Mount it where the operator can easily see the
display and reach the controls.

* Mount it where it is least likely to cause additional
injury in case of an accident.

* Airbags deploy with great force. Therefore, do not
mount the transceiver anywhere near the deploy-
ment area. In addition, do not place any other
objects in the deployment area.

2.2.3 MOUNTING TRANSCEIVER

1. Check the area underneath the selected mounting
area for wiring, brake and gas lines, or other compo-
nents that could be damaged when the mounting
bracket is installed. Then install the mounting
bracket using the included self-drilling screws or
other screws if desired.

2. Install the transceiver in the bracket using the
included knobs.

3. With front-mount transceivers, install the micro-
phone hanger in a convenient location using the
screws for sheet metal or plastic. The hanger must
be connected to chassis ground for proper operation
of functions such as monitoring and scan. If
required, ground the hanger using the included
ground wire.

2.3 POWER CABLE INSTALLATION

NOTE: Both leads of the power cable should be
connected directly to the vehicle battery. Connection
to other points may result in increased interference
from the vehicle's electrical system. If noise is still a
problem, an optional DC noise filter is available (see
Table 1-2).

1. Disconnect the negative cable from the battery to
prevent damage from accidental short circuits.



INSTALLATION

Pin Function

Ext/int Spkr Out
Ext Speaker Out
Internal Spkr In
Horn Qut
Ground
Ign Sense In
Ext PA Out
Input B

L= <N I = 0 T & 1 BN/ T AN I

ACCESSORY CABLE
FROM TRANSCEIVER

INTERNAL
SPEAKER JUMPER

INSERT PIN WITH
THiIS SIDE UP

Figure 2-2 Accessory Jack

2. Route the red power cable to the battery. If there is
excess cable, cut it off at a convenient location and
then splice it using the included butt splice connec-
tors. You may also need to cut the cable if it must be
routed through the firewall and there is no opening
large enough to clear the fuseholder. If a hole is
drilled in the firewall, be sure to seal it when the
instaliation is complete.

3. Connect the red power cable to the positive (+)
terminal of the battery.

4, Connect the blue cable to the negative (—) battery
terminal.

5. Plug the power cable into the transceiver and recon-
nect the negative battery cable.

6. Install the antenna according to the manufacturer's
instructions. The transceiver has an “N” connector.
Check VSWR. Reflected power should be less than
4% of forward power (VSWR less than 1.5to 1).

2.4 ACCESSORY CABLE INSTALLATION

2.4.1 GENERAL

Accessory Cable Kit, Part No. 023-9750-011, is
standard with this transceiver. The cable in this kit

plugs into the accessory pigtail coming from the back
of the transceiver. It is used for connecting the ignition
sense input and the external speaker and horn alert
accessories.

Two 8-pin connectors are included. One has a
jumper installed from pin 1 to 3 for routing audio to
the internal speaker (see next section) and the other
does not have any wires installed. Also included are
two 22-foot and three 2-foot wires with attached pins
that can be used as required. Refer to Figure 2-2 and
install this cable as described in the following
information.

NOTE: The ignition sense input must always be
connected because the transceiver does not operate if
it is not. In addition, the speaker jumper must be
installed to route audio to the internal speaker (except
remote-mount models).

242 INTERNAL/EXTERNAL SPEAKER
CAUTION

Do not connect either speaker output to a supply
voltage because serious damage to the audio amplifier
will result. (The amplifier is designed to withstand
momentary grounding of the speaker outputs.)
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Internal Speaker

To enable the internal speaker of front-mount
transceivers, insert the plug with the jumper from pin 1
to 3 into the accessory jack. This routes the audio on
pin 1 back in to the internal speaker connected to pin
3. The other internal speaker terminal is internally
connected to pin 2.

External Speaker

With front-mount transceivers, 4-ohm, 15-watt
external speaker, Part No. 250-0151-006, or equivalent
can be connected to pins | and 2 of the accessory
connector. Proceed as follows:

a. Locate the connector included in the Accessory
Wire Kit that does not have pins 1 and 3 jumpered.

b. Ifinstalling the external speaker listed above, the
connector pins are already attached to the speaker
wires. Insert one pin into the pin 1 location and the
other into the pin 2 location. If installing some other
speaker, use a 2- or 22-foot wire as required.

2.4.3 IGNITION SENSE

This ignition sense line is pin 6 of the accessory
connector. It is connected using an included wire
assembly. When the ignition sense input is connected
to a source switched by the vehicle ignition switch, it
provides the following functions.

a. Power automatically turns on and off with the igni-
tion switch.

b. A turn-off delay can be programmed (see Section
3.4.4). An automatic turn-off delay may prevent
accidental discharge of the vehicle battery if the
transceiver is left on for extended periods (1 or 2
days). Standby current is approximately 600 mA.

If these features are not used and transceiver
power is to be controlled by the front-panel power
switch only, the ignition sense input can be connected
to an unswitched source.

2.4.4 HORN ALERT

The hom alert is currently not available.
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2.4.5 EXTERNAL PUBLIC ADDRESS

The speaker signal is routed to pin 7 of the acces-
sory connector. This output can be used for external
accessories such as a public address system. Use one
of the included accessory cable wire assemblies to
connect this output.

2.4.6 INPUT B (EMERGENCY SWITCH)

[f an emergency switch is used to set up a high
priority call (see Section 3.6.8), a front panel option
switch or an external switch such as a foot-operated
type can be used.

If an external emergency switch is used, the input
is pin 8 of the accessory connector. This input is active
high and requires a +12 VDC signal to activate. Use
an accessory cable wire assembly to connect this
switch.

2.5 KEY CAP INSTALLATION

Key Cap Kit, Part No. 587-5300-001, is included
with each transceiver. This kit includes 5 blank key
caps, 6 plugs that can be inserted in the front panel if
the key is not used, and keys labeled as follows. The
caps indicated by an asterisk ( * ) are installed at the
factory. Determine the function of each key and then
install the applicable key cap. To remove a key cap,
gently pull it out of the front panel with a wide-nose
pliers. A key extraction tool is included in the DC
power cable kit.

EMER* BKLHT* DISP* SEL SQ* SCAN*
TONES* C/S TGSEL TXPWR CALL
MON RWS PRIED  ALERT  RESP
MSG NUIS PHONE  STATUS

2.6 TRANSCEIVER MOUNTING TRAY
INSTALLATION

2.6.1 DESCRIPTION

Optional Transceiver Locking Tray, Part No.
585-7000-185, is a lockable mounting bracket for
RS-5300 transceivers and other transceivers that use
that chassis. This bracket provides theft protection and
also allows the transceiver to be quickly removed from
the vehicle with a key.
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2.6.2 INSTALLATION
Refer to Figure 2-3 and proceed as follows:

a. Install the transceiver in bracket MP2 using the four
10-32 x 1/2” screws (HW2) included. If desired, this
mounting bracket can be used to mount the trans-
ceiver directly to the vehicle.

b. Install lock bracket MP1 using the four self-drilling
screws (HW3) and washers (HWS) included. Make
sure that there is nothing under the mounting loca-
tion that will be damaged.

2.6.3 LOCKING AND UNLOCKING
TRANSCEIVER

To insert the transceiver with attached mounting
bracket into the locking bracket, set it over the locking
bracket and push it rearward slightly if necessary so
that it seats. Then pull it forward until it latches.

The lock operates in a manner similar to most
glove compartment locks. To release the transceiver,
press the button and at the same time push the trans-
ceiver rearward. The key locks the button so that it
cannot be pressed.

LOCKING BRACKET

MP 2
MOUNTING BRACKET

Figure 2-3 Locking Tray Installation Diagram
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SECTION 3 OPERATION

Option
Switches (6)

Multi-functio
Indicator

Display

On-Off/
Volume Switch

PTT Switch DTMF Microphone (Optional)

LEHOHNSON

Select Speaker

Figure 3-1 Front Panel Controls

3.1 FEATURES
3.1.1 GENERAL FEATURES

® Each channel programmable for one of the
following operating modes:
— Conventional analog or Project 25 (digital)
— SmartNet™/SmartZone™ trunked analog or

Project 25 (digital)

® Up to 16 zones with up to 16 channels each
programimable (256 channels total)

¢ Large liquid crystal dispiay (LCD) with backlight

* Six option switches that can be programmed with a
different function for each operating mode (conven-
tional and SmartNet)

® Standard and radio-wide scan inodes

® Operation on both narrow and wideband channels

®* Time-out timer

3.1.2 CONVENTIONAL FEATURES

® Each channel selects a different radio channel and
squelch coding
® Repeater talk-around

3-1

¢ Normal/Selective squelch selected by microphone
hanger or option switch

® (Carrier, tone (CTCSS), or digital (DCS) controlled

Call Guard® squelch on analog channels or NAC

on Project 25 channels

Penalty and conversation timers

Priority channel sampling when scanning

Busy channel lockout (Transmit Disable On Busy)

ANI (Automatic Number Identification)

SecureNet™ or 460 secure communication

available on analog channels or DES-OFB on

Project 25 channels

User selectable high and low power output

¢ Individual ID calls on Project 25 channels

®* Emergency switch

3.1.3 SMARTNET/SMARTZONE FEATURES

® Channels select talk groups

® Unit-to-unit and telephone calling

* Emergency alarms to alert dispatcher of emergency
conditions

* Emergency calling for high priority system access

® Failsoft operation on a predefined conventional
channel 1if trunked system fails
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®  Priority group calls detected while listening to other
group calls

® (all alert (send and receive pages)

® Predefined messages (upto 16) can be senttoa
dispatcher

® Predefined status conditions (up to 8) can be sent to
a dispatcher

® Dynamic regrouping (dispatcher can automatically
gather users on a channel to receive a message)

® Roaming {SmartZone only)

® SecureNet™ or 460 secure communication avail-
able on analog channels, DES-OFB available on
Project 25 channels

NOTE: The availability of many of the preceding
Sfeatures is controlled by transceiver programming
(see Section 4) and the capabilities of the radio system
being accessed.

3.2 CONTROLS AND DISPLAY

NOTE: The controls and indicators described in the
Jollowing information are shown in Figure 3-1.

3.2.1 FRONT PANEL CONTROLS

On-Off/Volume - Pressing this control turns power on
and off, and rotating it sets the volume level.

Select Switch - Selects zones/channels and is also used
for other functions such as selecting names from a call
list. When selecting zones/channels, a bar above the
zone or channel display indicates which is currently
being changed (see Figure 3-3). To switch this bar
between displays, press this switch, and to select zones
or channels, rotate it (see Section 3.3.5).

Multi-function Indicator - This is a two-color LED
that indicates the following:

Red (constant) - Transmitter keyed (PTT switch

pressed).
Green (constant) - Busy condition (carrier detected

in receive mode).

Option Switches - Each of the six options switches on
the front panel (including the one located to the left of
the display) can be programmed to control a function.

Different functions can be programmed for each oper-
ating mode (conventional and SmartNet). Therefore, up
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to 12 different functions can be programmed. Refer to
Section 3.4.1 for more information.

Speaker - An internal 16-ohm, 5-watt speaker is

located behind the grille. An optionat 4-chm, 12-watt
external speaker may be used if desired. The internal
speaker is disabled when an external speaker is used.

PTT Switch - This push-button switch on the micro-
phone is pressed to talk (key the transmitter) and
released to listen.

Accessory  Antenna

Unit Jack "' Jack Jack

Figure 3-2 Rear Panel Jacks
3.2.2 REAR PANEL JACKS

DC Power Jack - Connection point for a nominal
12-volt, negative ground power source (see Figure 3-2),

Antenna Jack - Type N jack for connecting the
50-ohm antenna.

Accessory Jack - Connection point for optional acces-
sories such as an external speaker, horn alert, and igni-
tion sense line {see Section 2.4).

Remote Control Unit Jack - Connection point for a
remote control unit (if used). This cable is optional with

front-mount models.
3.2.3 DISPLAY

Zone Number - Indicates the currently selected zone
from 1 up to 16 (see Figure 3-3). A zone is a collection
of channels that can be any combination of the conven-
tional and SmartNet/SmartZone types (see Section
1.2.4).



OPERATION

Telephone/Special
Call Mode Enabled

Encryption

MON

@/. “ 'I\WI\W“ ‘

O DA

10-Character Alphanumeric Display

SR ——
Zone Status Chnl
No. Display No.

Figure 3-3 Front Panel Display

Channel Number - Indicates the currently selected
radio channel (conventional) or talk group (SmartNet).

Alphanumeric Display - This 10-character area of the
display indicates the alias (alpha tag) for the selected
channel. It may also display other information such as
the channel frequency (conventional) if certain option
switches are programmed. It also displays various
status and error messages.

Status Display - These two characters indicate the
following status information:

—-_

'l This rotating clock-like symbol in the left posi-

—  tion indicates that scanning is occurring.

- This symbol in the right position indicates that
the displayed channei is in the scan list
(scanned normally).

L4
7

- Indicates that the telephone call mode or other
special call modes are selected.

@ - Indicates that voice encryption is enabled.

MON - Indicates that the conventional monitor mode is
enabled by taking the microphone off-hook or pressing
the MON switch (if available). This mode disables
squelch contro! features so that all messages are heard
on the channel (see Section 3.5.3).

=new - The lines above the zone and channel displays
indicate which display is changed if the Select switch is
turned. To switch between displays, press the Select
switch (see Section 3.3.5).

3.3 GENERAL OPERATION
3.3.1 TURNING POWER ON

Turn power by pressing the On-Off/Volume
knob. The multi-function indicator then flashes green,
a series of beeps sound, and an initial greeting is indi-
cated by the alphanumeric display. The zone and
channel displays then indicate the currently selected
zone and channel. Programming determines if the last
selected or home zone is selected at power up.

3.3.2 BACKLIGHT

The backlight for the display and option keys can
be programmed to automatically turn on with trans-
ceiver power or it can be disabled. If the Backlight
option switch is programmed, the user can manually
turn the backlight on and off.

3.3.3 SETTING VOLUME LEVEL

The relative volume setting can be determined by
noting the index on the On-Off/Volume knob. Other-
wise, a reference tone can be enabled as follows:

* If the key press tones are enabled {see Section
3.4.5), a short tone sounds when an option switch is

pressed or the Select switch is pressed or rotated.

If a conventional channel s selected, take the micro-
phone off-hook and if someone is talking, voice is
heard. If the Monitor option switch is programmed
{see Section 3.5.3), pressing it unsquelches the
transceiver and either voice or background noise is
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heard. If a SmartNet/SmartZone channel is selected,
the transceiver cannot be manually unsquelched.

3.3.4 ZONE/CHANNEL DISPLAY

The selected zone and channel are displayed by
the zone and channel displays shown in Figure 3-3. In
addition, the unique alphanumeric identification (alias)
programmed for the channel is displayed in the alpha-
numeric display area. With conventional operation, the
channel frequency may be displayed (see Section
3.5.10). Refer to Section 1.2.4 for more information on
zones and channels.

3.3.5 ZONE/CHANNEL SELECT

The front panel Select switch is used to change
the zone and channel. Pressing this switch toggles
between the zone and channel select modes, and
rotating it changes the zone or channel.

The current select mode is indicated by the bar
over the zone or channel display (see below). For
example, when the bar is over the zone display, the
zone select mode is enabled. Rotating the Select
switch clockwise increases the zone or channel and
rotating it counterclockwise decreases the zone or
channel number. After the highest zone or channel is
displayed, wrap-around to the lowest zone or channel
occurs and vice versa.

NOTE: When an unprogrammed channel is selected,
“"UNPROGRAMD" is displayed and a tone sounds.

Channel Select Indicator

Zone Select Indicator *3-

om0 1t
r_nrm j’_n v 1 4 el
Ty ey

Zone Chnl

No. No.

Select Mode Indicators

The transceiver can be programmed so that the
bar defaults to either the zone or channel display when
power is turned on and after a change is made. The
delay that occurs before it returns is programmable for
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1-15 seconds or infinite (“infinite” causes it to remain
in the last selected mode).

3.3.6 SETTING SQUELCH

This transceiver does not have a squelch control.
The squelch level is preset during alignment and does
not require readjustment by the user.

3.3.7 TRANSCEIVER OPERATING MODES

Each selectable channel can be programmed for
any of the following modes. For example, Zone 1/
Channel 1 could be a conventional channel, Zone
1/Channel 2 a SmartNet channel, and so on. Refer to
Section 1.2.4 for more information on systems,
channels, and zones.

Conventional - This is a non-trunked operating
protocol which accesses independent radio channels
(there is no automatic access to several channels).
Selecting a conventional channel selects a transmit and
receive frequency and other channel parameters such
as squelch control coding.

Conventional channels can be either standard
(analog) or Project 25 (digital). With digital operation,
the DSP (Digital Signal Processor) converts the audio
signal to digital data which is sent over the air as
complex tones. Another difference is that analog chan-
nels use Call Guard (CTCSS/DCS) squelch control
and Project 25 channels use a NAC (Network Access
Code). With NAC, a number similar to an ID code is
transmitted, and for communication to occur, it must
match one programmed in the base equipment and the
mobile(s) being called.

With conventional operation, a busy channel
condition is detected automatically if the busy channel
lockout {transmit disable on busy) feature is
programmed. Otherwise, it must be detected manually.
An out-of-range condition is not indicated by special
tones or messages as with SmartNet operation because
there is no initial data exchange with the repeater that
allows this condition to be detected. Operating
features unique to conventional channels are described
mn Section 3.5.

SmartNet/SmartZone - This is a Motorola trunked
protocol. Talk group 1D codes are used to select what
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mobiles are being called and what calls are received.
Monitoring is also performed automatically and
special messages and tones indicate busy and
out-of-range conditions.

SmartNet and SmartZone operation and program-
ming is very similar. Basically, SmartNet operation is
limited to a single repeater site and SmartZone opera-
tion allows automatic roaming between sites.

Enhanced features available with this protocol
include telephone, unit-to-unit, and emergency calls,
cali alert, messaging, and emergency calls. Either
analog or digital (Project 25) signaling may be
selected for each talk group. SecureNet™ or 460
secure communication is available with analog chan-
nels, and DES-OFB is available with digital channels.
Operating features unique to SmartNet/SmartZone
channels are described in Section 3.6.

3.4 RADIO-WIDE FEATURES
3.4.1 OPTION SWITCHES

The six option switches on the front panel
(including the one to the left of the display) can be
programmed to control different functions for each
operating mode. Therefore, up to 12 different func-
tions can be controlled by these switches (six each for
conventional and SmartNet/SmartZone channels) The
functions controlled in each mode and the section in
which the function is described are as follows:

Conventional Option Switches

Backlight (Section 3.3.2)
Clear/Secure (Section 3.4.7)

Digital TG Select (Section 3.5.14)
Displayed Information (Section 3.5.10)
Emergency (Section 3.5.11)

Hi/Lo Power (Section 3.5.9)

Home Zone (Section 3.4.3)
Individual ID List {Section 3.5.14)
Monitor (Section 3.5.3)
Normal/Selective (Section 3.5.5)
Priority (Section 3.5.12)

Radio Wide Scan (Section 3.4.6)
Repeater Talk-Around {Section 3.5.8)
Scan (Section 3.4.6)

Tones On/Off (Section 3.4.5)

SmartNet/SmartZone Option Switches

Backlight (Section 3.3.2)

Call Alert (Section 3.6.7)

Call Response (Section 3.6.5)
Clear/Secure (Section 3.4.7)
Emergency (Section 3.6.10)
Home Zone (Section 3.4.3)
Message (Section 3.6.8)
Nuisance Delete (Section 3.6.12)
Phone (Section 3.6.6)

Private Call {Section 3.6.5)
Radio Wide Scan (Section 3.4.6)
Scan (Section 3.4.6)

Site Lock Function (Section 3.6.14)
Site Search (Section 3.6.14)
Status (Section 3.6.9)

Tones On/Off (Section 3.4.5)

3.4.2 TIME-OUT TIMER

The time-out timer disables the transmitter if it is
keyed for longer than the programmed time. It can be
programmed for 15 seconds to 3 minutes, 45 seconds
or it can be disabled. If the transmitter is keyed for
longer than the programmed time, the transmitter is
disabled, a continuous tone sounds, and “TX
TIMEOUT” is displayed. Five seconds before
time-out occurs, a warning beep sounds to indicate
that time-out is approaching. The timer and tone are
reset by releasing the PTT switch. A different time can
be programmed for each system, and the timer can be
enabled or disabled on each channel.

3.4.3 HOME ZONE SELECT

If the HOME zone option switch is programmed,
it can be used to quickly select the preprogrammed
home zone. The transceiver also can be programmed
so that when power is turned on, either the home or
last selected zone is automatically selected.

3.4.4 POWER TURN-OFF DELAY

The transceiver can be installed so that the
vehicle ignition switch as well as the front-panel
power switch controls transceiver power. This is done
by connecting the accessory ignition switch wire to a
power source switched by the ignition switch (see
Section 2.4.3). Power off delays of 0-254 minutes or
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Forever can then be programmed. This delay can be
overridden at any time by turning power off using the
front-panel power switch or turning the ignition switch
back on.

A turn-off delay allows features such as the horn
alert and call indicator to remain active for the
programmed delay time after the ignition switch is
turned off. At the same time, advantages of ignition
switch control can be utilized such as preventing
battery discharge that may occur if the transceiver is
accidentally left on for an extended period.

3.4.5 TONE SELECT

The various alert tones that sound are described
in Section 3.7. To toggle all these tones on and off,
press the TONE option switch. When all tones are off,
“TONE OFF” is momentarily displayed, and when all
tones are on, “TONE ON” is momentarily displayed.
If this switch is not programmed, tones are fixed in the
on or off mode by programming.

3.4.6 SCANNING
Introduction

Scanning monitors the channels in the scan list
for messages that the transceiver is programmed to
receive. When a message is detected, scanning stops
and the message is received. Shortly after the message
is complete, scanning resumes (unless it has been
disabled). Scanning occurs with the microphone
off-hook. However, on conventional channels, selec-
tive squelch (such as CTCSS/NAC) is then disabled,
so any call occurring on a scanned channel is detected.

There are two basic scan modes available: Stan-
dard and Radio Wide. The operation of the standard
type is unique to the type of channel selected, and the
operation of Radio Wide type is the same regardless of
the type of channel selected. More information on
these types of scanning follows.

Standard Scanning

Standard scanning monitors only channels that
are the same type as that currently selected (see “Scan
Lists” which follows). More information on this type
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of scanning is located in the individual operating mode
descriptions as follows:

Conventional Mode Scanning - Section 3.5.12
SmartNet Mode Scanning - Section 3.6.12

Standard scanning is turned on and off as follows:

® Briefly press the SCAN option switch. Scanning is
enabled when “SCAN ON” is briefly displayed and
a rotating |} is indicated in the left status display as
shown below.

T T (5 11
Crur o 200

Scan Enable Indicator J

® To turn scanning off, briefly press the SCAN option
switch again. Scanning is disabled when “SCAN
OFF” is briefly displayed and }4 ‘ I is no longer indi-
cated in the status display.

® [f the zone or channel is changed while scanning is
selected, scanning continues on the scan list

programmed for the new channel.

Radio Wide Scanning

Radio wide scanning monitors the channels in the
radio-wide scan list. This scan list can include up to 16
channels of any type and assigned to any zone (see
“Scan Lists” which follows). Radio wide scanning is
turned on and off by the RWD option switch as
follows. If this switch is not programmed, radio wide
scanning is not available.

® To turn radio wide scanning on, press the RWD
option switch and “RWD ON” is briefly displayed.
In addition, H is displayed the same as with stan-
dard scanning.

® Only one type of scanning can be enabled. There-
fore, it standard scanning is enabled when the RWD
switch is pressed, it is automatically disabled and
vice versa.
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® To turn radio wide scanning off, press the RWD
option switch again and “RWD OFF” is briefly
displayed and } is no longer displayed.

* [Ifthe zone or channel is changed while radio wide
scanning, scanning continues normaliy.

Scan Resume Delay

When a message is received or transmitted while
scanning, there is a delay before scanning resumes.
The delay after receiving a call prevents another
message from being received before a response can be
made, and the delay after transmitting a call ensures
that a response is heard instead of another message
occurring on some other channel.

With conventional systems, a delay of 0-7.5
seconds in {).5-second steps can be programmed. With
SmartNet/SmartZone systems, the delay is determined
by the hangtime of the system. This delay is also used
by other features such as to determine if a response
occurs i the secure mode.

Transmitting in the Scan Mode

if the transmitter is keyed while scanning is
enabled, transmissions occur on various channels as
follows.

Conventional Operation - Transmissions can occur on
the priority, selected, or receive channel. Refer to
Section 3.5.12 for more information.

SmartNet/SmartZone Operation - If scanning is halted
to receive a message, transmissions occur on the
channel of the call. Transmissions made at other
times occur on the selected channel.

Standard Mode Scan Lists

NOTE: The selected channel is always scanned,

Conventional Operation - Up to three scan lists, each
containing up to 256 conventional channels, can be
programmed for conventional operation. The list
that is scanned is selected by the Scan option
switch (see Section 3.5.12). Selecting another
conventional channel does not change the scan list.

SmartNet/SmartZone Operation - Each SmartNet and
SmartZone system can be programmed with up to
three scan lists that can contain any combination of
the possible 16 talk groups assigned to that system.
Each SmartNet/SmartZone channel is then
programmed to select one of these lists,

Radio Wide Mode Scan List

With radio wide scanning, there is only one scan
list available regardless of the type of channel
selected. This scan list can contain up to 16 channels
of any type. For example, it could include six conven-
tional channels and ten SmartNet/SmartZone channels.

Scan List Channel Add/Delete

All scan lists are preprogrammed and new chan-
nels cannot be added by the user. However, channels
can be temporarily deleted from a scan list. For
example, a channel may be deleted if the messages on
it become annoying. Proceed as follows:

NOTE: The selected channel and also conventional
priority channels cannot be deleted from the scan list.

1. While receiving a message on the channel to be
deleted, press and hold for approximately 2 seconds
the option switch used to enable scanning (SCAN or
RWD).

2. Afier the channel is deleted, scanning of the
remaining channels in the scan list resumes.

3. Deleted channels are added back into the scan list if
any of the following occur:

* Scanning is turned off and then on again using the
scan switch.

* Transceiver power is turned off and then on again.

®* When standard scanning, if another scan list is
selected such as by changing channels
(SmartNet/SmartZone) or using the Scan List
Select switch {conventional).

Determining Which Channels are in Scan List

The channels in the radio-wide and conventional
scan lists are indicated as foHows. Channels in the
SmartNet/SmartZone lists are not indicated.
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1. To view the conventional scan list, enable standard
scanning by pressing the Scan switch. Likewise, to
view the radio wide scan list, enable radio wide
scanning by pressing the RWD switch. With
conventional scanning which can have up to three
lists, also select the scan list if applicable (see
Section 3.5.12).

2. Select the desired zone and then scroll through the
channels by rotating the Select switch. When the
displayed channel is in the scan list (scanned
normally), the }:{ symbol is displayed next to the
channel number as follows.

ey TR
Crongrov_ny 4V 4 %.':’U_!
—

Scan List Indicator J Chnl

No.

and digital (Project 25). Refer to the preceding section
(3.4) for information on features common to all oper-
ating modes.

3.5.2 MONITORING BEFORE TRANSMITTING

With conventional operation, you may need to
manually monitor the channel before transmitting to
make sure that it is not be used by someone else. With
SmartNet/SmartZone operation, monitoring is always
performed automatically. Monitor conventional chan-
nels automatically or manually as follows:

Automatic Channel Monitoring

If the selected channel is programmed with the
Busy Channel Lockout (Transmit Disable On Busy)
feature, monitoring is performed automatically. Refer
to Section 3.5.4 for more information on this feature.

Manual Channel Monitoring

3.4.7 SECURE COMMUNICATION

This transceiver may be equipped to provide
secure communication on some or all channels. This
feature encrypts your voice so that it can be under-
stood only by someone using a transceiver equipped
with a similar encryption device and encryption codes.

When a secure call is received or transmitted,
@ is indicated in the display. If equipped with the
Clear/Secure option switch and the current channel is
programmed to allow switch selection, secure commu-
nication can be manually enabled and disabled by that
switch. Secure communication can be programmed on
a per channel basis to operate in various ways. Refer to
the following sections for more information:

Conventional Mode - Section 3.5.15
SmartNet/SmartZone Mode - Section 3.6.15

3.5 CONVENTIONAL MODE FEATURES
3.5.1 INTRODUCTION

An overview of the conventional and
SmartNet/SmartZone operating modes is located in
Section 3.3.7. The following information describes the
features unique to conventional operation (both analog

April 1999
Part No. 001-5300-001

The automatic monitoring just described may
occasionally disable the transmitter when the channel
is not in use, such as if the repeater has extended hang
time. In this case, you may not want to use it and the
channel must then be monitored manually as follows:

Busy Indicator - With scanning disabled, note if the
multi-function indicator on the front panel is steady
green (see Figure 3-1). If it is not, the channel is not
being used and a call can be transmitted. It it is green, a
carrier is being detected.

Monitor Mode - If the busy indication is displayed, the
channel can be monitored to see if someone is actually
using it (see next section).

3.5.3 MONITOR MODE

Taking the microphone off-hook disables Call
Guard squelch (or NAC with Project 25 channels) so
that all messages occurring on the channel are heard
(unless off-hook detection is disabled by program-
ming). In addition, if the Normal/Selective option
switch is programmed, it can be used to monitor the
channel. Refer to Section 3.5.5 for more information
on this switch. When monitoring is enabled by either
of these methods, the receiver unsquelches only if a
carrier is present.
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[f the Monitor option switch is programmed,
pressing it unsquelches the receiver so that all traffic
on the channel can be monitored. Pressing this switch
briefly monitors the receive frequency, and pressing it
for at least 2 seconds monitors the transmit frequency.
To re-enable normal operation, briefly press the
Monitor switch again. When monitoring is enabled by
this switch, “MON?” is indicated in the display and
scanning is disabled.

3.5.4 BUSY CHANNEL LOCKOUT

The Busy Channel Lockout {also called Transmit
Disable on Busy) feature automatically disables the
transmitter if the channel is busy when the PTT switch
is pressed. When the transmitter is disabled by this
feature, “BUSY” is displayed, a busy tone sounds, and
the transmitter is disabled.

The Busy Channel Lockout feature can be
programmed to operate as follows. Each conventional

channel can be programmed differently.

Off - Busy channel lockout is disabled and the trans-
mitter keys even if the channel is busy.

Noise - If a carrier is detected on the channel, the

transmitter is disabled when the PTT switch is pressed.

Tone (NAC) - If an incorrect Call Guard
(CTCSS/DCS) or NAC code (see Section 3.5.14) is
detected, the transmitter is disabled when the PTT
switch is pressed. An incorrect code is any code other
than the one programmed for the current channel.

Tone (NAC) w/Lockont - Like “Tone” above except
transmitting is permitted if the “Normal” condition is
selected by the Normal/Selective option switch (see
next section).

3.5.5 CALL GUARD SQUELCH
Introduction

Tone or digital Call Guard squelch (also called
CTCSS/DCS signaling) can be programmed on each
conventional analog transmit and receive channel in
any order desired. The reverse burst and turn-off code
are always transmitted and also detected on channels
programmed with Call Guard squelch.

The Call Guard squelch feature eliminates
distracting messages intended for others using the
channel. This is done by using a subaudible tone or
digital code to control the squelch. This tone or code is
unique to a user or a group on that channel. This tone
or code is transmitted with the voice signal but is not
heard because it is in the subaudible range and is atten-
uated by a filter. Call Guard squelch must be used in
both the transmitting and receiving transceiver to be
functional.

Call Guard Squelch Enable/Disable

The Normal/Selective option switch (if
programmed) can be used to temporarily disable
receive Call Guard squelch on the current channel.
When Call Guard squelch is disabled, “NORMAL” is
flashed in the display. Conversely, when it is enabled,
“SELECTIVE?” is flashed. It is automatically
re-enabled on the channel when another channel is
selected or transceiver power is turned off and on.

Tone Call Guard Squelch

Tone-type Call Guard squelch utilizes subaudible
CTCSS tones from 67-254.1 Hz. Although there are
42 tones assigned, those above 33 (210.7 Hz) are
normally not used because of their close proximity to
the voice band which starts at 300 Hz. In addition,
tones 11 (97.4 Hz), 39 (69.3 Hz), 40 (206.5 Hz), 41
229.1 Hz), and 42 (254.1 Hz) are normally not used
because they may cause interference with adjacent
tones.

A reverse burst is transmitted when the
push-to-talk switch is released and also detected when
calls are received. It is a 180-degree phase reversal for
a period of time determined by the tone frequency, and
it eliminates the squelch tail (noise burst) in the
receiving transceiver. Both the transmitting and
receiving transceiver must be equipped with this
feature for it to be utilized.

Digital Call Guard Squelch

Digital Call Guard squelch (CDCSS) uses digital
data instead of subaudible tones to control the squelch.
This data consists of continuous repetitions of 23-bit
words. No bit or word synchronization information is
used. When the push-to-talk switch is released, a
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turn-off code is transmitted which eliminates the
squelch tail similar to the reverse burst.

Although there are thousands of possible code
combinations with 23 bits, only 83 are unique with the
data scheme used. The number specified when the
code is programmed is actually a seed for a special
algorithm used to generate the 23-bit data word. The
data is transmitted at a rate of 134.4 bits per second.
Therefore, approximately six words are transmitted
each second. When the data is decoded, 23-bit samples
are taken and then the bits are rotated to determine if a
valid code was received.

3.5.6 PENALTY TIMER

A penalty timer may be programmed on conven-
tional systems to prevent transmissions for the
programmed time after the time-out timer disables the
transmitter (see Section 3.4.2). The penalty timer can
be programmed for the same times as the time-out
timer, and timing starts when the PTT switch is
released. If the PTT switch is pressed during the
penalty time, the time-out indication occurs again.
When the penalty timer expires, a beep sounds and the
transmitter can be keved.

3.5.7 CONVERSATION TIMER

A conversation timer can be programmed on
conventional systems in addition to the time-out timer
(see Section 3.4.2). This timer limits that total length
of a conversation rather than just the length of each
transmission as with the time-out timer. The following
is more information on this timer.

® It can be programmed for times up to 7.5 minutes.
® It is reset when the time between transmissions

exceeds the time programmed for the penalty timer.

* A warning beep sounds 5 seconds before this timer
disables the transmitter.

*  When this timer disables the transmitter, a contin-
uous tone sounds and the red transmit indicator
turns off. The PTT switch must then be released

untif the penalty timer expires (indicated by a beep).

3.5.8 REPEATER TALK-AROUND

Normally, all transmissions go through a repeater
which usually increases range. However, there may be
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times when a mobile is out of range of the repeater and
therefore unable to talk to anyone even though the
mobile being called is only a short distance away. To
allow communication in this sitnation, repeater
talk-around can be selected. Transmissions then occur
on the receive frequency which permits direct
mobile-to-mobile communication.

Repeater talk-around can be selected if the RTA
option switch is programmed. When talk-around is
enabled by this switch, “RTA ON” is flashed in the
display, and when it is disabled, “RTA OFF” is
flashed. This feature remains enabled during scanning,
but changing channels or turning power off causes it to
revert to the off condition. Talk-around is available on
conventional channels only.

3.5.9 POWER OUTPUT SELECT

Each conventional channel can be programmed
for high, low, or switchable power. If the High/Low
Power option switch is programmed and selectable
power is programmed on the current channel, high and
low transmitter power can be selected. All models
support high/low power.

Pressing this switch toggles the power setting.
The new level is flashed in the display when this
switch is pressed as either “HIGH POWER” or “LOW
POWER?. If selectable power is not permitted on the
current channel, the programmed power level is
flashed and no power change occurs.

3.5.10 DISPLAYING TX/RX FREQUENCY

If the Displayed Information option switch is
programmed (see Section 3.4.1), it can be used to
display the channel frequency in megahertz. Pressing
this switch toggles between displaying the standard
channel alias and the channel frequency. The receive
frequency is displayed when receiving and the
transmit frequency is displayed when transmitting.
This feature is available on conventional channels
only,

3.5.11 EMERGENCY MODE

An Emergency option switch may be
programmed on conventional channels to alert a
dispatcher or someone else of an emergency condition.
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When this switch is pressed with an analog
channel selected, a Transcrypt emergency packet
(SC-460 emergency) is sent up to 20 times or until an
acknowledgment is received.

When this switch is pressed with a Project 25
(digital) channel selected, all transmissions have the
emergency flag set. Scanning is disabled and the trans-
ceiver remains in the emergency mode until power is
cycled.

3.5.12 CONVENTIONAL MODE SCANNING
General

Channel scanning features common to all oper-
ating modes are described in Section 3.4.6. The
following information describes features unique to
conventional operation.

Scan Lists

Up to three scan lists are selectable when stan-
dard scanning with a conventional channel selected.
The channels in these lists can be programmed only by
the programming software, and each list can inciude
up to 256 conventional channels. Scan lists are
selected by repeatedly pressing the Scan option
switch. For example, the first press of the Scan switch
activates scan list 1, the second press activates scan list
2, the third press activates scan list 3, and the last press
disables the scan mode. The currently selected scan
list is flashed in the display as “SCAN x”, where “x” is
the scan list number.

Transmitting in Scan Mode

Each conventional scan list can be programmed
for one of the following modes. These modes deter-
mine if priority sampling occurs and also the channel
on which transmissions occur while scanning. Refer to
“Priority Channel Sampling” which follows for more
information.

No Priority - No priority channel sampling occurs
when the list is selected. The radio transmits on the
selected channel.

Priority/I'x Priority - Priority sampling occurs and
the priority channel is the one programmed in the

selected scan list. The radio transmits on the priority
channel.

Priority/Tx Selected - Priority sampling occurs and
the priority channel is the one programmed in the
selected scan list. The radio transmits on the selected
channel.

Priority on Selected - The priority channel is always
the selected channel. The radio transmits on the
selected channel.

Talkback - No priority sampling occurs. The radio
transmits on the channel of a call while scanning is
halted. Then once scanning resumes, it transmits on
the selected channel.

Priority Channel Sampling

The priority channel sampling feature ensures
that messages on the priority channel are not missed
while listening to a message on some other channel.
The transceiver can be programmed as just described
s0 that the priority channel is a fixed channel
programmed in the current scan list, the currently
selected channel, or not used.

Priority channel sampling occurs only with stan-
dard conventional scanning. It does not occur with
radio-wide scanning, when listening to any type of
SmartNet/SmartZone call, or when transmitting. A
series of “ticks” may be heard when the priority
channel is sampled while listening to a message on
some other conventional channel.

The priority sampling times are programmed by
the following parameters:

Lookback Time A - This time determines how often
the priority channel is checked for activity. Times of
0.25-4.00 seconds in 0.25-second steps can be
programmed.

Lookback Time B - This time determines how ofien
the priority channel is checked once an incorrect Call
Guard (CTCSS/DCS) or NAC code is detected. Since
it takes much longer to detect an incorrect Call Guard
signal than a carrier, this time should be relatively long
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to prevent the interruptions from making a message
difficult to understand. Times of 0.5-8.0 seconds can
be programmed in 0.5-second steps.

3.5.13 PLACING AND RECEIVING
CONVENTIONAL CALLS

NOTE: A DTMF microphone is required to place
conventional mode telephone calls.

Placing a Standard Conventional Call

1. Turn power on and set the volume as described in
Sections 3.3.1 and 3.3.3. Select the channel
programmed for the mobile you want to call as
described in Section 3.3.5.

Monitor the channel automatically or manually as
described in Section 3.5.2.

Press the PTT switch and the call proceeds as
follows:

® If the Busy Channel Lockout feature is
programmed on the channel (see Section 3.5.4),
the transmitter is automatically disabled if the
channel is busy.

® Otherwise, busy and out-of-range conditions are
not indicated and speaking can begin after moni-
toring the channei.

Press (and hold) the PTT switch to talk and release

it to listen. When the call is finished, place the
microphone back on-hook.

Receiving a Standard Conventional Call

I. Select or scan the channel programmed for the call
you want to receive (refer to Sections 3.4.6 and
3.5.12 for more scanning information).

. When the call is received, take the microphone
off-hook and press the PTT switch to talk and
release it to listen. If scanning, responses may occur
on the priority, selected, or receive channel as
described in Section 3.5.12.

April 1999
Part No. 001-5300-001

3. When the call is finished, place the microphone
back on-hook.

3.5.14 PROJECT 25 MODE FEATURES

Individual, Group, and NAC Codes

Individual ID - Each transceiver that operates on
Project 25 (digital) channels is programmed with
an 8-digit individual ID. This ID is unique for
each transceiver and can be any number from
1-16777216. When power is turned on with a
Project 25 channel selected, this 1D is briefly
displayed.

Group ID - Each Project 25 channel is programmed
with a group 1D that determines which group of
mobiles will receive the call. A call is received if
any Project 25 channel is programmed with that
group and the correct NAC is detected (see
following description). Group IDs can be any
number from 0-4095.

NAC - Project 25 conventional channels use a NAC
(Network Access Code) instead of Call Guard
squelch coding (see Section 3.5.5) to control
which calls are received on a channel. The NAC
can be 0-4095, and each transmit and receive
channel can be programmed for a different code.
Other operation, such as monitoring before trans-
mitting, is similar to that of standard analog
channels.

To receive a Project 25 group call, the talk group
programmed with the group ID being transmitted must
be selected or scanned. In addition, the receive NAC
programmed for that channel must be detected. An
exception is if the receive NAC in the receiving radio
is 659 (293 hex). The receiving radio then basically
ignores the NAC so that all NACs can be received on a
talk group.

Changing Talk Group Assigned To A Channel

Group calls are placed by simply selecting the
channel programmed for the desired group, monitoring
the channel if required, and transmitting. If the Digital
TG Select option switch is programmed, the talk group
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assigned to a channel can be permanently changed by
the user. Therefore, the new talk group continues to be
assigned to the channel even after radio power is
cycled or another channel is selected. To change a
channel talk group, proceed as follows:

1. Select the channel to be changed and then press the
Digital TG Select option switch.

2. Rotate the Select switch until the alias (alphatag) of
the desired talk group is displayed.

3. To select that talk group and return to normal oper-
ation, press the TG Select option switch again or
press the Select switch. If tatk group selection has
been disabled on the channel by programming, “NO
LIST” is displayed and a tone sounds.

Individual Calls

Individual calls can be placed to a specific radio
on Project 25 channels if the Individual Call option
switch is programmed. With these calls, only the indi-
vidual ID of the target radio is sent (a talk group ID is
not sent). When this call is received, the individual ID
of the calling radio is transmitted back. Responses can
be made without changing the selected channel as long
as they are made before the call timer times out (set by
programming) or the channel is changed. To place an
individual call, proceed as follows:

1. Press the Individual ID List option switch and the
alias (tag) of the last individual call is displayed.

2. If required, rotate the Select switch to display the
desired number. The alias (alphatag) of each
number is displayed.

3. Press the PTT switch and begin talking.

The transceiver can be programmed to display the
following when an individual call is received (see
Section 3.3.4).

® Alias (or freq.) of the currently selected talk group

* Alias of the talk group on which the call is being
received

® ID of the mobile placing the call

3.5.15 CONVENTIONAL SECURE
COMMUNICATION

Introduction

There are two different protocols that can be used
to provide secure communication on conventional
analog channels: SecureNet™ and 460 scrambling.
More information on these protocols follows.

SecureNet

SecureNet is a proprietary Motorela protocol that
digitizes the voice and then encrypts it using the DES
algorithm. It provides the highest level of security.
There are two DES protocols:

* DES (CFB) uses cipher feedback DES encryption.
A disadvantage of this type is reduced communica-
tion range when compared to clear voice.

® DES-XL uses counter addressing feedback DES. It
provides better range but at lower voice quality.

The transmission mode {(DES or DES-XL) is
selected by the programming software for each
SecureNet analog channel. If a channel is programmed
for DES-XL, it will also receive DES, but transmis-
sions always occur in DES-XL.

Each SecureNet capable channel is assigned an
encryption number from 0-15. The key corresponding
to this number is loaded into the radio using the
Motorola key loader. There is a maximum of 16 keys
that can be loaded into the radio at one time.

Transmissions on an analog channel are in the
clear mode if the channel has been strapped to the
clear mode by programming, and in the SecureNet
mode if it has been strapped to SecureNet. If the
channel has been strapped to “switched”, the mode is
selected by the Clear/Secure option switch. When a
message 1s received or transmitted in the secure mode,

@ 1s displayed.

If an attempt is made to transmit a secure
message without loading the corresponding key,
“KEYFAIL” is displayed. The message must then be
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transmitted in the clear mode (this is possible only if
the channel is strapped to “switchable™) or the key
must be loaded.

460 Scrambling

The 460 Scrambling protocol is a proprietary
Transcrypt protocol that is compatibie with the
stand-alone scrambling option from Transcrypt. If
equipped with the 460 Scrambler, a Clear/Secure
option switch may be programmed. Pressing this
switch changes the transmission mode for the selected
channel and momentarily displays either “CLEAR” or
“SECURE”".

In the coded mode, transmissions are in scram-
bied voice on any 460-enabled channel and the mobile
receiving the call automatically responds in the scram-
bled mode because the receiver automatically switches
between the clear and coded modes.

Although 16 generic codes are loaded, only one is
active and all 460-enabled channels use this code. The
460 scrambling option also provides several other
signaling enhancements including Digital 1D, Auto-
matic Status and Location Update, Individual and
Group 1D calling, and Emergency.

Transmit Mode Options

Either the SecureNet or 460 protocol can be
selected, and then the following transmit options are
available for each:

Clear - All calls are in the clear mode unless
responding to a secure cali. If the response is then
made within the delay time (see Section 3.4.6), it
occurs in the secure mode.

Coded - All calls are made in the selected secure
mode.

Switched - The mode is selected by the Clear/Secure
switch. With 460 scrambling, if responding to a secure
call, the secure mode is automatically selected if the
response occurs within the delay time. When the clear
mode is selected by this switch, “CLEAR” is flashed,
and when the secure mode is selected, “SECURE" is
flashed.
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Receive Mode Options

With 460 scrambling, clear and scrambled signals
are always autodetected. In addition, the user can
switch between the clear and secure mode at any time
using the Clear/Secure option switch. SecureNet
signals are unintelligible when 460 scrambling is used
and vice versa.

With the SecureNet protocol, the following
receive options can be programmed:

No Autodetect - Only signals coded like the transmit
signals are received.

Secure Autodetect - Both clear and SecureNet signals
are automatically detected. This mode is automati-
cally selected if the transmit mode is switch selectable.

Proper Key Autodetect - An incoming Securenet call
is compared against all of the available keys
programmed into the radio. If a match is found, the
call is decrypted using matched key.

Project 25 (Digital) Channels

Project 25 digital channels use the DES-OFB
protocol. Using this protocol on digital channels does
not result in the degraded range that occurs with
analog channels. The same transmit mode options are
available as with the preceding analog operation. In
the receive mode, clear and secure messages are
always automatically detected.

3.6 SMARTNET/SMARTZONE FEATURES
3.6.1 INTRODUCTION

An overview of the SmartNet/SmartZone oper-
ating mode is located in Section 3.3.7. The following
information describes the features unique to the
SmartNet and SmartZone modes of operation. Refer to
Section 3.4 for information on features common to all
operating modes.

3.6.2 ANALOG AND DIGITAL OPERATION

Either analog or Project 25 (digital) operation can
be selected for communtication on SmartNet traffic
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channels. Each talk group can be programmed for
either type of operation.

3.6.3 VIEWING UNIT ID
When power is turned on with a SmartNet/Smart-

Zone channel selected, the six-digit Unit ID is briefly
displayed as IDxxxxxx.

3.6.4 GROUP CALLS

Placing a Group Call

1. Turn power on and set the volume as described in
Sections 3.3.1 and 3.3.3. Select the channel
programmed for the talk group you want to call (see
Section 3.3.5). A regular or announcement talk
group can be selected.

2. If the talk group is not strapped to Clear or Coded,
select the desired mode by pressing the Clear/Secure
option switch. The status of that switch is ignored if
the talk group is strapped to Clear or Coded. Refer
to Section 3.6.15 for more information.

3. Press the PTT switch and begin talking. A talk
permit tone may sound to indicate when talking can
begin. Events that may occur are as follows:

® If in the secure mode and your transceiver is not
programmed with the proper encryption key,
“KEYFAIL” is displayed and the call must be
made in the clear mode or the proper key must be
programmed.

® Ifthe busy tone sounds and “BUSY” is displayed,
the system is busy. Release the PTT switch and
wait for the call back tone to sound. Then press
the PTT switch within 3 seconds.

® [fa continuous tone sounds and “NO SYS” is
displayed, you may be out-of-range. Drive closer
or away from shielding objects and try again.

® Ifyour unit ID is invalid, the call is being made to
an invalid group ID, group calls are not enabled,
or the selected talk group is not programmed for
the selected secure mode, “DISABLED ID” is
displayed and an alert tone sounds.

® [fan attempt is made to change an analog call
from the clear to secure mode and there is no
available secure channel, “NO SEC” is flashed
and the call continues in the clear mode,

*® |fan attempt is made to change an analog channel
from the secure to clear mode, “SEC ONLY™ is
displayed and the call continues in the secure
mode. (Calls on digital channels can be changed
if not strapped.)

Receiving a Group Call

Group calls are automatically received if a
SmartNet/SmartZone channel is selected. The display
alternates between the selected channel alias
(alphatag) and the received talk group alias.

3.6.5 UNIT-TO-UNIT CALLS

Unit-to-unit calls allow calls to be placed to a
specific mobile unit. Either the Enhanced Private
Conversation™ or Private Conversation II™ modes
may be programmed. Operation in each mode is as
follows:

Placing a Unit-To-Unit Call
(Private Conversation II)

1. Momentarily press the Private Call option switch.
The alias of the last called mobile is displayed.

2. If required, select another mobile by rotating the
Select switch until the alias for the desired mobile is

displayed.

3. Press the PTT switch. Events that may occur are as
follows:

® The called party answers the call.

® The called party does not answer. Press the
Private Call option switch to end the call.

® [fthe selected mobile ID is not valid, “INVALID”

is displayed and an alert tone sounds.

¢ [fthe callis in the secure mode and the transceiver
does not have the proper encryption key,
“KEYFAIL” is displayed and the call must be
made in the clear mode by pressing the
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Clear/Secure option switch (if strapped to switch-

able). Otherwise, load the correct key.

4. When the call is fimshed or if it is not answered, end
it by pressing the Private Call option switch and
placing the microphone on-hook.

Placing a Unit-To-Unit Call
(Enhanced Private Conversation)

1. Momentarily press the Private Cail option switch.

The alias of the last called mobile is displayed.

If required, select another mobile by rotating the
Select switch until the alias for the desired mobile is
displayed.

Press the PTT switch. Events that may occur are as
follows:

If the mobile being called is on the air, “WAIT” is
displayed and ringing is heard until the called
party answers or for 20 seconds, whichever occurs
first. When the call is answered, the voice of the
called party is heard.

If the called mobile does not answer within 20
seconds, a continuous tone sounds and “NO ANS”
is displayed.

If the called mobile is not on the air, a continuous
tone sounds instead of the ringing tone and “NO
ACK” is displayed.

[f the busy tone sounds and “BUSY” is displayed,
the called mobile has answered the call but the
system is busy. When the system is no longer
busy, the call back tone sounds.

1f your transceiver or the called transceiver is
inhibited or not programmed to make this type of
call or for the requested secure mode, “REJECT”
is displayed and an alert tone sounds.

If your transceiver does not have the proper
encryption key, “KEYFAIL” is displayed and the
call must be made in the clear mode by pressing
the Clear/Secure option switch (if strapped to swit-
chable). Otherwise, load the correct key.
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4. When the call is finished or is not answered, end it
by pressing the Private Call option switch and
placing the microphone back on-hook.

Receiving a Unit-To-Unit Call

I. When a unit-to-unit call is received, “CALL” is

displayed and a recurring call tone sounds.

. To answer the call, press the Private Call option
switch and then the PTT switch and begin speaking.
The unit ID of the calling mobile is displayed. More
information follows:

If the PTT switch is pressed before the Private Cali
option switch, the call is transmitted as a group
call.

If unit-to-unit calls are not permitted (the Private
Call option switch is not programmed), press the
Call Response option switch to answer the call.

The call must be answered within 20 seconds or it
is automatically terminated.

If the system is busy when a response is made,
“BUSY” is displayed and the busy tone sounds.

3.6.6 TELEPHONE CALLS

The telephone call feature allows telephone calls
to be placed and received over the public telephone
system using your transceiver. The type of call
(secure/clear) is determined by the mode selected by
the Clear/Secure option switch. Telephone calling is
programmed to operate in one of the following modes:

® Disabled

® Answer-only capability

* Telephone numbers can be recalled from memory
only

Placing a Telephone Call by Recalling a Number From

Memory

1. With a SmartNet/SmartZone channel selected,
momentarily press the Phone option switch. The
alias of the last called telephone number is

displayed.
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2. If required, rotate the Select switch to display the 2. To answer the call, press the Phone option switch
desired number. The alias of each number is and press the PTT switch to talk and release it to
displayed. listen (since the transceiver operates half duplex, it

is not possible to talk and listen at the same time).
3. Pressandrelease the PTT switch and “DIALING” is

displayed. Events that may occur are as follows: 3. When the call is finished, end it by pressing the
PHONE option switch and placing the microphone
® If the access is successful, a dial tone sounds and back on-hook.
the dialed number is displayed and sent. Either
ringing or a busy signal is then heard as with a 3.6.7 CALL ALERT
standard telephone call. When the called party
answers, press the PTT switch to talk and release The call alert feature allows pages to be sent and
it to listen (since the transceiver is half-duplex, it received. Your transceiver may be programmed to
is not possible to talk and listen at the same time). answer pages in the Private Conversation 1™ or
Each time the PTT switch is released, a go-ahead Enhanced Private Conversation™ modes. The opera-
tone is sent to the landside party to indicate when tion differences are noted in the procedure which
they can respond. To dial a number after the follows.

connection is made, press the PTT switch and dial
the number using the microphone keypad.
Answering a Page

*® If the selected telephone number is not valid,
“INVALID” is displayed and an alert tone sounds. 1. When a page is received, four beeps sound and
Select a valid number. “PAGE” is displayed. The ID of the mobile paging
you is stored as the last ID received.
*® Ifthe system is busy, “BUSY” is displayed and the
busy tone sounds. The call will automatically 2. Toclear or ignore the page, press any option switch.
proceed when the system becomes avatlable. If the PTT switch is pressed, a group call is placed
on the selected channel.

® If you are out-of-range or the radio cannot be

accessed for some reason, “NO PHONE” is 3. To answer the page as a unit-to-unit call (sece
displayed and an alert tone sounds. page 15), press the Private Call option switch and
the alias of the mobile paging you is displayed.
® If the interconnect call you are making or the Press the PTT switch and respond. One of the condi-
selected secure mode is not authorized, “REJECT” tions that follow may also occur:

is displayed and an alert tone sounds.
Private Conversation 11 Mode

® [f your transceiver does not have the proper
encryption key, “KEYFAIL” is displayed and the ® [fthe mobile being called is not on the air or does
call must be made in the clear mode (press the not answer, you will simply not hear a response.

Clear/Secure option switch).
Enhanced Private Conversation

4. When the telephone call is finished or if it could not

be completed for some reason, end it by pressing the ® If the mobile being called is on the air, ringing is
Phone option switch and placing the microphone heard until the catled party answers or for 20
back on-hook. seconds, whichever occurs first. If no answer
occurs within 20 seconds, “NO ANS” is displayed.
Answering a Telephone Call ¢ [f the mobile being called is not on the air, no

ringing is heard and “NO ACK” is displayed.
1. When a telephone call is received, “ringing” similar

to a standard telephone is heard and “PHONE” is 4. When the call is finished or it could not be
displayed. completed for some reason, end it by pressing the
April 1999
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Private Call option switch and placing the micro-
phone back on-hook.

Initiating a Page

1. With a SmartNet/SmartZone channel selected,
momentarily press the Call Alert option switch. The
alias of the last ID called is displayed.

2. If required, rotate the Select switch to display the
desired mobile. The alias of each number is
displayed.

3. Press the PTT switch and one of the following
oceur:

® If a continuous tone sounds, the system received
the page but the called mobile is not on the air. Try
again later or cancel the page by pressing the Call
Alert switch again.

® If the called mobile does not answer within 6
seconds, a continuous tone sounds and “NO ACK”
is displayed. Try again later or cancel the page by
pressing the Call Alert switch again.

® If five beeps sound, the system received the page
and the paged mobile is on the air and received it.
The page mode is automatically exited.

3.6.8 MESSAGING

The messaging feature allows preprogrammed
messages to be sent to a dispatcher. Up to 16 messages
can be preprogrammed, and they are identified by an
alias. If a Message option switch is programmed,
messages are sent as follows:

1. Momentarily press the Message option switch. The
alias of the last message sent is displayed.

2. If required, rotate the Select switch to display the
desired message. Then send the message by
momentarily pressing the PTT switch. One of the
following events then occurs:

® [f five beeps sound, the message was received and
acknowledged by the dispatcher.
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® If after 6 seconds, the message is not acknowl-
edged, a tone sounds and “NO ACK” is displayed.
Press and release the PTT switch to send it again
or press the Message option switch to exit the
messaging mode.

3.6.9 SENDING STATUS CONDITIONS

The status feature allows you to manually or
automatically send your current status to your
dispatcher. Up to eight status conditions can be
preprogrammed, and they are identified by an alias. If
the Status option switch is programmed, status condi-
tions are sent as follows:

1. Momentarily press the Status option switch. The
alias of the current status condition is displayed.

2. Tochange the current status, rotate the Select switch
until the desired status is displayed. Then press the
Select switch to accept that status.

3. You can wait to send the current status until polled
by the dispatcher or it can be sent immediately by
briefly pressing the PTT switch. One of the
following events then occurs:

® If five beeps sound, the status was received and
acknowledged by the dispatcher

® [f after 6 seconds, the message is not acknowl-
edged, a tone sounds and “NO ACK” is displayed.
Press and release the PTT switch to send it again
or press the Status option switch to exit this mode
and return to normal operation.

3.6.10 EMERGENCY ALARM/CALL

An emergency alarm is a special data transmis-
sion to alert the dispatcher of an emergency situation.
An emergency call is an urgent request for access to a
voice channel. It is placed if the PTT switch is pressed
during an emergency alarm condition. The Emer-
gency option switch must be programmed to have
these features. Proceed as follows:

1. With a SmartNet/SmartZone channel selected, press

and hold the Emergency option switch for at least 2
seconds.
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. The emergency mode is then indicated by a red front
panel LED and “EMERGENCY™ in the display.
The emergency alarm is transmitted on the prepro-
grammed emergency talk group or announcement
group (which can be different for each channel).

NOTE: The transceiver may be programmed for
silent emergency. If this is the case, no audio and
visual emergency indications occur such as those
just described.

. When the emergency alarm is acknowledged, four
beeps sound (unless silent emergency is
programmed) and normal operation resumes. To
cancel the emergency alarm before this occurs,
press the Select switch.

. To transmit and emergency call, simply press the
PTT switch after pressing the Emergency option
switch (but before the acknowledgment is received).

3.6.11 FAILSOFT OPERATION

If a failure occurs in the SmartNet/SmartZone
system so that it cannot be used, the transceiver auto-
matically enters the failsoft mode. When in this mode,
“FAILSOFT” and the alias of the selected channel are
alternately displayed.

When in the failsoft mode, operation is in the
conventional mode on the preprogrammed failsoft
channel (a different failsoft channel can be
programmed on each talk group). If a transmission is
attempted before a failsoft channel is located, a contin-
uous tones sounds until the PTT switch is released.
When the radio system returns to normal operation,
this is automatically detected and normal operation
resumes. The secure mode is controlled by the
Clear/Secure option switch and indicated by @) in the
display. Secure calls are always automatically
detected.

3.6.12 SMARTNET/SMARTZONE SCANNING
General

Scanning on a SmartNet/Smartzone system is
similar to the standard scanning described in Section

3-19

3.4.6. Each SmartNet/SmartZone system can be
programmed with up to three scan lists with each
including up to 15 channels plus a priority channel.
One of these lists can then be selected for each
SmartNet channel. In addition, autoscanning can be
selected on each channel. Scanning then automati-
cally begins on that channel when it is selected. It is
not necessary to press the Scan option switch.

Messages on the priority channel are received
while listening to lower priority messages. However,
unit-to-unit and telephone calls are not interrupted by
priority messages. Pages, unit-to-unit calls, and tele-
phone calls are received while scanning.

Nuisance Channel Delete

If messages on a talk group become annoying,
that talk group can be temporarily removed from the
scan list by pressing the Nuisance Delete option
switch. The deleted talk group is added back into the
scan list when power 1s cycled, scanning is turned off,
or another channel is selected (see Section 3.4.6). With
radio-wide scanning, the RWD option switch is used
to delete channels as described in Section 3.4.6.

3.6.13 DYNAMIC REGROUPING

The dynamic regrouping feature allows a
dispatcher to switch mobiles to a predefined
regrouping channel to receive an important message.
Dynamic regrouping operates as follows:

1. When this command is received, alternating tones
sound for 5 seconds and the transceiver automati-
cally changes to the regrouping channel and the
display indicates the alias of the channel.

. Manually select the channe! corresponding to that
alias. If this is not done, transmission still occurs on
the new channel, but the alternating tones sound
each time the PTT switch is pressed.

. Talk and listen as usual. The dispatcher will cancel
dynamic regrouping. If a standard channetl is not
selected after this occurs, an error tone periodically
sounds.
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3.6.14 SMARTZONE FEATURES
Introduction

As described in Section 3.3.7, the SmartZone
mode provides wide area coverage by allowing
roaming between SmartNet and conventional sites.
SmartZone operation is the same as SmartNet with the
following additional features:

Busy Override

The busy override feature allows a call to be
placed even if not all sites you are calling have a free
traffic channel. The only sites guaranteed to be
included are the Critical Sites and the sites where a
Critical User is located. This feature is enabled and
disabled by the system manager, and it operates as
follows:

1. Assume that you have attempted to place a call and
the system was busy (“BUSY” displayed and busy
tone sounded).

2. Release the PTT switch and then press it for 5
seconds or more. If a chirp tone sounds with the PTT
switch pressed, busy override is occurring,.

NOTE: Remember that not all members of the talk
group are receiving your message. Missing
members will start receiving your message as
channels become available.

Site Trunking

Site trunking occurs when a site can no longer
participate in wide area trunking. When site trunking
is occurring, the radio searches for other sites that may
provide wide area coverage. Site trunking ends when a
wide area coverage site is located, the current site is
operating again as a wide area coverage site, an
out-of-range condition occurs, or the failsoft mode is
entered.

Determining Current Site

To determine the current radio site, momentarily
press the Search option switch. If currently registered
on a site, “SITE xx” is displayed. If the site is locked
(see following), “LOCK xx” is displayed.
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Searching For a New Site

To search for a new site, press and hold the
Search option switch of 2 seconds or more. The
display indicates “SEARCH” until a new site is found.
The display then indicates “SITE xx”. Press the Search
option switch to return to the normal display.

Locking/Unlocking a Site

It is sometimes desirable to stay on a site. To
prevent the transceiver from searching for a new site,
it can be locked on the current site. To lock on the
current site, press the LOCK option switch. The
display indicates the first site in the list of SmartZone
sites. Even when locked on a site, searching for a new
site can be forced as described in the preceding para-
graph.

3.6.15 SMARTNET/SMARTZONE SECURE
COMMUNICATION

On analog SmartNet/SmartZone channels, either
the SecureNet or 460 protocols can be selected. Opera-
tion is similar to conventional channel secure commu-
nication described in Section 3.5.15.

On digital SmartNet/SmartZone channels, only
the DES-OFB protocol is available. Talk groups can
be strapped to Clear, Coded, or Switch selectable, and
clear and secure messages are always autodetected.

The following calls require their own encryption
key selection: emergency, failsoft, patch, telephone,
unit-to-unit, and system-wide.

3.7 SUPERVISORY TONES

Single Beep (Alert Tone)

® Power was turned on and a successful power-up
sequence occurred (Section 3.3.1).

¢ The time-out timer is about to expire or the penalty
timer has expired (Section 3.4.2),

¢ The conversation timer is about to expire (Section
3.5.7)

® The system received your page but the paged mobile
is not on the air (Section 3.6.7).
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® Telephone interconnect is not operational (Section

3.6.6).

Continuous Tone (Invalid Condition)

® A transmission 1s being attempted on a conventional
channel programmed as receive-only.

® The transmitter is disabled by the busy channel
lockout feature (Section 3.5.4).

® The transmitter has been disabled by the time-out
timer feature (Section 3.4.2).

¢ The transmitter has been disabled by the conversa-
tion timer (Section 3.5.7).

®* An out-of-range condition exists (SmartNet/Smart-
Zone only).

® A transmission is being attempted before the penalty
timer has expired (Section 3.5.6).

® Dynamic regrouping has been exited but the
dynamic regrouping channel is still selected
(Section 3.6.13).

Single Short Medium-Pitch Tone

* A valid key has been pressed.

Single Short Low-Pitch Tone

* An invalid key has been pressed.

Medium Tone (No Acknowledge)

® The paged mobile did not acknowledge the page
(Section 3.6.7).

®* The message that was sent has not been acknowl-
edged (Section 3.6.8).

® The status condition that was sent has not been
acknowledged (Section 3.6.9).

Five Beeps (Recurring)

* The page was received (Section 3.6.7).

Two Short Tones

® A unit-to-unit call was received (Section 3.6.5).

Five Beeps

* The paged mobile received the page and acknowl-
edged it (Section 3.6.7).

¢ The message that was sent has been received and
acknowledged (Section 3.6.8).

® The status condition that was sent has been received
and acknowledged (Section 3.6.9).

Four Beeps

® The emergency alarm condition was acknowledged
(Section 3.6.10).

Alternating Tone

® Dynamic regrouping has occurred (Section 3.6.13).
* Dynamic regrouping has occurred but the
regrouping channe! is not selected (Section 3.6.13}.

Busy Signal

® The radio system is busy or a busy condition exists
when making a telephone call.

Three Medium Pitch Tones

* A channel is available after a busy condition
occurred (SmartNet/SmartZone only).
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TRANSCEIVER PROGRAMMING

SECTION 4 TRANSCEIVER PROGRAMMING

Remote Programming Interface (RPl)  023-9750-005

Part No.

To
Battery

o
. . éfﬁfb To

Antenna

Figure 4-1 Programming Setup

4.1 GENERAL
4,1.1 PROGRAMMING SETUP

The following items are required to program the
transceiver and contro} unit. The part numbers of this
equipment are shown in Table 1-2 in Section 1. The
programming set-up is shown above.

* [BM® PC or compatible personal computer

¢ Remote Prog. Interface (RPI) P.N. 023-5300-000

* (ables from the RPI to the computer and
transceiver or control unit

¢ EFJohnson PCTrunk programming software.

4.1.2 COMPUTER DESCRIPTION

The computer used to run this program should
meet the following minimum requirements:

Windows® 3.1, 95/98, or NT 3.51

Intel® 486 processor or equivalent

At least 4 MB of RAM

A hard disk drive with at least 5 MB of free space

An available serial port

¢ & & 9 O

NOTE: With the descriptions which follow, it is
assumed that you have a basic understanding of how
to use your Windows-based operating system. If you
are not familiar with some of the Windows functions
described, refer 1o your Help Screens and manuals
included with your Windows software.

4.1.3 PCTRUNK SOFTWARE INSTALLATION

The PCTrunk software is supplied on two 3-1/2”
diskettes. Install this software as follows:

1. Make sure that there are no other Windows applica-
tions open during this installation procedure. Also,
make sure that the computer meets the minimum
requirements listed in the preceding section.

2. Insert PCTrunk Disk 1 in the disk drive of your
computer.

3. Windows 3.1 or NT - In the Program Manager,
double click the SETUP.EXE file on PCTrunk Disk
1 or click this file name and select File > Run.

Windows 95/98 - Select Start > Settings > Control
Panel and double click “Add/Remove Programs™.
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Then click Install and Next. When SETUP.EXE is
automatically located on the floppy drive, click
Next, select the location for the start-up icon, and
enter the name you want to call the program.

4. Follow the instructions displayed by the setup
program. The default directory for the program is
\Program Files\PCTrunk. If you wish to use some
other directory, click Browse and select it or type
the name.

4.1.4 CONNECTING RPI TO COMPUTER AND
TRANSCEIVER

NOTE: A new RPI Part No. 023-3300-000, is
required to program this transceiver. Earlier RPIs
such as 023-9800-000 and 023-9750-000 cannot be
used.

The cables from the RPI to the computer and
transceiver are not included with the RPI. The -5300-
RP1 has a female DB9 connector for the computer
connection. Since most computer serial ports have a
male DB9 or DB25 connector, 4 male DB9 to female
DB9 or DB25 is usually required. This is a standard
cable available at most computer supply stores. Suit-
able cables are also listed in Table 1-1.

The cable from the RPI to the transceiver or
contro! unit has a connector which plugs into the
microphone jack. The cable for this application is also
listed in Table 1-1.

The RPI provides the required interface between
the computer and transceiver. It converts the RS-232
logic levels from the computer to the RS-485 logic
levels required by the transceiver microprocessor and
vice versa.

4.1.5 STARTING AND EXITING

To Start PCTrunk From Windows 3.1

In the Program Manager, open the PCTrunk
group window. Then double-click the PCTrunk icon.

To Start PCTrunk From Windows 95/98

Click the Start button and select the PCTrunk
group. Then double-click the PCTrunk icon.
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To Exit PCTrunk:

Select File > Exit or press ALT + F4.

4.1.6 PROGRAMMING FILE TYPES

Programming data is stored in two disk files that
can be saved, read, copied, and deleted (see Section
4.3.1). The two types that are stored for each program-
ming session have the same name but different exten-
sions as follows:

Programming File (DAT) - Contains all program-
ming information except what is in the following .460
file.

Scrambling File (.460) - Contains all information
relating to the Transcrypt 460 scrambler. This file is
saved only if 460 scrambling is used.

4.1.7 HELP FILES

To display help information on the current screen,
click Help in the menu bar or press F1.

4.1.8 SCREEN TYPES
The following types of screens are displayed:

Radio-Wide - These screens program parameters that
are the same for all systems and channels. Separate
screens are displayed for General, Conventional,
SmartNet/SmartZone, and Mobile Options parameters.
Refer to Section 4.4 for more information on these
screens.

System - These screens program the parameters that
are unique to the displayed Conventional, SmartNet,
or SmartZone system. The system to be edited is
selected as described in Section 4.1.10.

Channel - This screen programs unique channel
parameters and assigns channels to each zone. The
specific parameters indicated in this screen are deter-
mined by the type of system selected in the “Type”
box (Conventional Analog, Conventional Project 23,
SmartNet).

The preceding screens are displayed in cascade
style or they can be minimized like any Windows
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screen. To cascade the active screens, select Window
> Cascade from the menu bar (see Section 4.3.6).

To pop a screen to the front, click the applicable
button shown below. For example, if the Channel
screen is displayed and you want to quickly pop the
Radio-Wide screen to the front, click the Radio-Wide
button. These buttons can be displayed or hidden by
clicking Window > Toolbar. A window can also be
displayed by selecting it in the Window Menu.

nE  naulu 1ypc

Screen Pop-Up Buttons and File Size Indicator
4.1.9 FILE SIZE INDICATION

The maximum number of channels that can be
programmed may be limited by the available memory
space in the radio (see Section 1.2.4}. A running indi-
cation of the amount of memory used by the current
data if it was downloaded to the radio is displayed by a
bar graph in the toolbar as shown above. When the bar
reaches the right end, the available memory is full and
some channels may need to be deleted if more infor-
mation remains to be programmed,

4.1.10 CREATING AND DISPLAYING SYSTEMS

To create a new SmartNet or SmartZone system,
select Systems > Add Systems and then the desired
system type from the menu bar (see Section 4.3.6).
This menu is also used to delete a system.

NOTE: Only one conventional system can be set up,
and it is automatically created when a programming
file is opened as described in Section 4.1.6. Therefore,
there is no option to add a conventional system as just
described.

Only one system can be displayed at a time.
Therefore, to edit information in one of the systems,
display that system by selecting Window in the menu
bar and then the system to be edited. Systems are iden-
tified by number and type. Channels or talk groups
from any programmed system can be set up in the

Channels screen. Therefore, any system can be
selected when programming channel information.

4.2 PROGRAMMING PROCEDURE

The following is a general procedure you can use
to program a transceiver.

4.2.1 PRELIMINARY
1. Select a programming file as follows:

Create a New File - To start with a new file
containing default parameters, select File > New
and then the frequency band of the radio
(VHF/UHF/ 800 MHz).

Open An Existing File - To open an existing file
stored on disk, select File > Open and then the file
to be opened.

Upload a File From a Radio - To transfer a file
from a radio to the computer to edit or use as a
basis to program another radio, connect the radio to
the computer as described in Section 4.1.4. Then
turn the radio on and select Upload from the menu
bar. Only the .DAT programming file is uploaded.
The .460 scrambling file cannot be uploaded for
security reasons.

2. Before or after creating the programming file, be
sure the correct type (portable or mobile) is selected
by the Radio Type menu (see Section 4.3.2).

3. A conventional system ts automatically set up when
a new programming file is created. If SmartNet or
SmartZone systems are also to be programmed, set
up at least one of each type as described in Section
4.1.10.

422 PROGRAMMING RADIO WIDE
PARAMETERS

1. To display the Radio Wide screens, click the Radio
Wide button or select Window > Radio Wide
Parameters in the menu bar (see Section 4.1.8).

2. Program the applicable information in these screens
as described in Section 4.4.
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4.2.3 PROGRAMMING CONVENTIONAL
CHANNELS

NOTE: If no conventional channels are to be
programmed, skip this section.

1. Make sure the conventional system is displayed by
selecting Window > Conventional in the menu bar.

2. Ifrequired, display the Conventional System
programming screens by clicking the System button
or selecting Window > Conventional System (see
Section 4.1.8).

3. Program the conventional systems and channels as
described in Section 4.5.

4.2 4 PROGRAMMING SMARTNET AND
SMARTZONE SYSTEMS

NOTE: If no SmartNet or SmartZone systems are to be
programmed, skip this section.

1. Make sure the desired SmartNet or SmartZone
system is displayed by selecting Window > Conven-
tional in the menu bar.

2. If required, display the programming screens for
that system by clicking the System button or
selecting Window > SmartNet/SmartZone System
(see Section 4.1.8).

3. Program the SmartNet/SmartZone system and talk
groups as described in Section 4.6.

4. To program additional SmartNet/SmartZone
systems, add a new system as described in Section
4.1.10 and repeat Section 4.6.

4.2.5 PROGRAMMING RADIO
(DOWNLOADING FILE)

When all the required programming information
has been entered in the various programming screens,
the information can be programmed (downloaded) into
the radio. When downloading a file, be sure that all
connections between the computer and radio are
secure, the radio is turned on, and the proper serial
port is selected (see Section 4.3.1). Then proceed as
follows:
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1. Select Download from the menu bar and then the
file type to be transferred (programming or
scrambling).

® [fno file is currently loaded, a dialog box appears
to select the desired file.

® [f a file is already loaded when Download is
selected, the current file is transferred to the radio.

2. Repeat for the other file type (if required).

NOTE: The information which follows (Sections 4.3-
4.6) provides detailed descriptions of the parameters
in the various screens that are displayed by the
PCTrunk program.

4.3 MENU COMMANDS

Menu Bar

4.3.1 FILE MENU

New - Creates a programming file with default param-
eters for the selected frequency range.

Open - Opens a programming file that was previously
saved to disk. If a modified file is currently open, you
are asked if that file should be saved before the new
file is opened.

Close - Closes the current file. If the file has been
modified and the changes have not been saved, you are
asked if the changes should be saved before closing.

Save - Saves the current file to disk using the current
file name.
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Save As - Same as “Save” except you are prompted to
enter a new file name if desired.

Print - Prints the information in the current file.

Select Communications Port - Displays the Commu-
nications Port dialog box which is used to select the
serial port that is used to connect the transceiver to the
computer (see Section 4.1.4).

Exit - Closes the PCTrunk program. Ef the current file
has been modified and the changes have not been
saved, you are asked if the changes should be saved
before closing.

4.3.2 RADIO TYPE MENU

Radio Type
Portable Radio
+ Mobile Radio

The Radio Type menu show above selects the
radio type (Portable or Mobile) being programmed.

4.3.3 DOWNLOAD MENU

Mobile Radio Parameters
Mobile Scrambling Parameters

Mobile Radio Parameters - Transfers the current
programming file to the radio connected to the
computer.

Mobile Scrambling Parameters - Transfers the
selected scrambling parameters file to the radio
connected to the computer.

4.3.4 UPLOAD MENU

|

The Upload Menu is displayed only in the
opening screen before a programming file is created.
The following options are displayed:

Radio Parameters - Transfers the programming data
from a radio to the PCTrunk program. This data can
then be viewed, edited, or saved to a disk file as
desired. Scrambling parameters cannot be transferred
out of a radio for security purposes.

Version Information - Displays the software version
number and serial number of the connected radio.

435 SYSTEMS MENU

Add System

The Systems Menu is used to create new
SmartNet and SmartZone systems. It is also used to
delete current systems. Conventional systems cannot
be added because only one can be created. Refer to
Section 4.1.8 for more information.

4.3.6 WINDOW MENU

The Window Menu is used to select the system to
be edited. It can also be used to pop one of the screens
to the front. See Section 4.1.8 for more information.

4.3.7 HELP MENU

Contents - Displays the help system table of contents.

Search For Help On - Displays the search dialog box
that allows searching for a help topic by keyword.
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About PCTrunk - Displays the software version
number of PCTrunk and the address of EFJohnson.

4.4 RADIO-WIDE PARAMETER SCREENS
4.4.1 INTRODUCTION

The radio-wide screens program the parameters
that are the same for all systems, channels, and zones.
Separate screens are used for General, Conventional,
SmartNet/SmartZone, and Mobile Options parameters.
Refer to the information which follows.

4.4.2 RADIO-WIDE GENERAL SCREEN
Band
Displays the operating band selected by the Radio

Type Menu (see Section 4.3.2). The selected operating
band must match that of the radio being programmed.

Wide Param

Radio-Wide General Screen

Zones

Total Zones - The total number of zones currently set
up. The maximum number allowed is 16. Zones are
added by clicking the Zone button (see following).

Current Zone - Indicates the currently selected zone.
To select another zone, click the up/down arrows.
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Zone Alias - Edits the unique alpha identification for
the displayed zone. Up to 10 characters can be
entered. The zone alias is briefly displayed whenever
a new zone is selected. Refer to Section 1.2.4 for
morte information on zones.

Add (Zones) Button - Adds another zone.

Delete (Zones) Button - Deletes the last zone added.

Defaults

Home Zone - Selects the zone that is selected by the
Home Zone option switch if programmed.

Options

Power-Up On Home Zone - If checked, the home
zone is always selected at power-up.

Beeps - If checked, enables all tones. Otherwise, no
tones sound (see Section 3.7).

Radio Wide Scan List

NOTE: The radio-wide scan list cannot be pro-
grammed until all channels to be included have been
set up as described in the Conventional and Smart-
Net/SmartZone sections (4.5 and 4.6, respectively).

Radic Wide Scan List

MINNESQT
MINNESOT
MINNESQT
MINNESQT
MINNESOT
MINNESOT

AMNALDG (1)
ANALQG {1}
DIGITAL (1)
CIGITAL (1)
SMNET (4]
SMNET (4)

Radio-Wide Scan List Screen

Clicking the Radio Wide Scan List button in the
General screen displays the above screen which
programs the radio-wide scan list described in Section
3.4.6. The buttons and other parameters in this screen
are as follows:
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Button - Displays the following
screen that selects the channels in each Zone and
System that are in this scan list. Select each Zone and
then the channels to be included from that zone.

Delete Entry - Deletes the selected channel from the
scan list.

Scan Hold Time - This programs the delay that
occurs before radio-wide scanning resumes after a
message is no longer being received. Times of 0- 7.5
seconds can be programmed (see Section 3.4.6).

Assign Function Buttons

Clicking the “Assign Functions Buttons” Button
in the General screen displays the following screen
which is used to program the six front panel option
switches. The option switches can be programmed
with a different set of functions for each operating
mode (conventional, SmartNet/SmartZone). For
example, selecting a conventional channel enables the
conventional functions and selecting a SmartNet
channel selects the SmartNet functions. The functions
that can be programmed for each mode are listed in
Section 3.4.1.

Program the option switches as follows:

1. Select the button to be programmed by clicking it in
the left column. The F1 key is to the left of the
display and the other keys are numbered consecu-
tively from left to right (F2-F6).

4-7

Assign Functi

ER@EEm

LR shniond. |

Assign Function Buttons Screen

2. Click the function to be assigned to that button by
clicking it in the right column. Then click the
“Assign Function” button.

3. Repeat for each button and operating mode (click
the tab on top to display a different screen).

If 460 Scrambling is used (see Section 3.4.7),
click the Scrambling Parameters button in the General
screen to display the following screen. This screen
programs scrambling and other signaling options, and
the Codes screen modifies the list of scrambling codes
which are stored in the radio. The buttons and other
parameters in these screens operate as follows:

i w AR s it
460 Scrambler Settings Screen
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Settings Screen

Unit ID - Uniquely identifies the radio for Flashcall
signaling.

Download ID - This ID must be received by the radio
for it to accept a download of its scrambling
parameters.

Kill ID - This ID must be received by the radio for the
kill operation to occur.

Master Code - Displays the master code used by the
scrambler. Two scramblers must be programmed
with the same master code to communicate. The field
is an 8-digit hexadecimal number (0-9, A-F).

Radio Group - Sets the group number of the scram-
bler from 00-99.

Sync Code - Scrambling sync code from 0-15. Two
scramblers must have the same sync code to
communicate.

Fleet Number - Number from 0-15 used when
multiple fleets of scramblers are used.

Auto Turnaround Time - Time from 0-7 seconds after
receiving a coded message that the scrambler ignores
the clear code switch setting and forces the coded
mode.

Acknowledgment Delay - Delay time from 50-1550
ms before the scrambler responds to information
received from a controller.

System Delay - Delay time from 50-1550 ms
between when the PTT switch is pressed and the
scrambler transmits data over the air.

Emergency Delay - The amount of time the scram-
bler waits to send the emergency signal after the
emergency switch is pressed. No delay or a 0.5 sec
delay can be selected.

Tx Turnaround - If selected, inserts a delay between
when scrambled information is received and then

transmitted. This delay allows scramblers in the
system to prepare for the new data.

ANI at Beginning of Tx - If selected, sends a Flash-
call ANT at the beginning of every clear mode
transmission.

ANI at End of Tx - [f selected, sends a Flashcall ANI
at the end of every clear mode transmission.

Unit-to-Unit Paging - If selected, enables a single
unit page.

Mute at Power On - If selected, mutes the audio when
powered up until the radio transmits, receives a
Flashcall selective call, or OTAR reprogramming of
scrambling parameters.

Auto Location Update - If selected, causes the scram-
bler to automatically send the user location every
time it changes.

Auto Status Update - If selected, causes the scram-
bler to automatically send the user status each time it
changes.

Data Operated Squelch - If selected, causes the
scrambler to mute audio when incoming Flashcall
data is received.

Mute After Emergency - If selected, causes the
scrambler to mute the audio after sending an
emergency signal until the unit transmits.

Silent Signaling - If selected, causes the scrambler to
send a tone ahead of data packets that forces the
receiving unit to mute its audio before the data burst
is heard.

Quiet Delay - If selected, adds an extra 100 ms
lead-in delay at the beginning of the silent signaling
tone (if enabled).

Clear Warning Tone - If selected, sends a tone burst
at 5-second intervals during clear mode transmis-
sions. This alerts the listener that the conversation is
not secure.
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Codes Screen

460 S(:r:?mhli@ Parameters

460 Scrambler Codes Screen
Default Code - Code space to use in the radio.
Codes 0 - 15 - Edit the box to enter a code. All codes
must begin with A0. The last six digits can be pro-

grammed for any value using hex digits 0-9, A-F.

§ Change Password Button

The function is not used with mobile transceivers.

4.4.3 RADIO-WIDE CONVENTIONAL SCREEN

Radio Wide Parameters

The radio-wide conventional screen is shown
above, and is used to program the following
parameters:

DTMEF PTT ID - The PTT ID is used on a channel
programmed for pre- or post-transmit ANI. This ID
consists of eight digits from 0-9.

Digital Unit 1D - When operating on a Project 25
(digital) channel, this number identifies the radio.
Each radio must have a different ID, and it must be
between 1 and 16777216,

Project 25 Display Options

These functions select what is displayed when
individual calls are received. If neither function is
selected, the selected talk group alias or channel
number is displayed (see “Indivual Calls” in Section
3.5.14). With group calls, the talk group or channel
number is always displayed.

Talk Group on Rx - The alias of the talk group on
which the call is being received is displayed.

PTT ID - The D of the mobile placing the call is
displayed.

4.4.4 RADIO-WIDE SMARTNET/SMARTZONE
SCREEN

Radio Wide Parameters

The radio-wide SmartNet/SmartZone screen is
shown above, and is used to program the following
parameters:

Full Spectrum CC Scan

In a SmartZone system, if all potential control
channel frequencies have been searched, the radio
enters a channel-by-channel search across the full
spectrum that the radio covers. The timer sets the time
it performs this scan before it checks the expected
frequencies again. After it checks these frequencies, it
returns to full spectrum scanning. This cycle repeats
until a control channel is found.
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On-Off - Enables or disables full spectrum scan.

Timer - Sets the time that full spectrum scanning
occurs as just described.

Hot DTMF

Enable/Disable - When enabled, allows the user to
send DTMF tones while transmitting. When dis-
abled, pressing numeric keys (0-9, *, #) while trans-
mitting has no affect. This option is not functional
with SecureNet operation.

Project 25 Display Options
See description in Section 4.4.3.
Voice On Control

With SmartZone operation, some remote sites are
designated Voice On Control sites. In these sites, if all
available traffic channels are occupied, control chan-
nels become traffic channels when additional traffic
channels are requested. The Voice On Control param-
eters determine how the radio reacts to various situa-
tions that may occur. For example, when a conversa-
tion is complete, the radio may look for a control
channel that has become a traffic channel.

Enable/Disable - Determines if the voice on control
parameters are active.

Site Lock Time - This is the amount of time a radio
remains on the Voice On Control site before looking
for another site.

Activation Time - This is the amount of time the
radio waits when the control channel comes back
from Voice On Control before it transmits any pend-
ing ISWs. This prevents all radios on a Voice On
Control site from submitting ISWs at the same time.

Pending Emergency Time - This is the amount of
time the radio waits to submit an Emergency ISW
after the control channel returns from the Voice On
Control mode.

Adjustable Parameters

Busy Override Delay - With SmartZone operation,
this is the amount of time a user must press the PTT
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switch to override a SmartZone busy that occurs
because some member of the talk group is present at
a site where there are no traffic channels available.

Affiliate Hold Off - With SmartZone operation, this
is the delay time that occurs after acquiring the con-
trol channel before it sends an affiliation ISW. This
prevents all radios on the system from sending affil-
iation ISWs at the same time.

Failsoft Inactivity - Programs failsoft operation (see
Section 3.6.11). If the radio remains inactive (no
receive or transmit activity on channel) while operat-
ing in the failsoft mode for the programmed time, the
radio momentarily leaves the failsoft mode and
attempts to find a control channel. If 0™ is pro-
grammed, the radio does not leave the failsoft mode.

4.4.5 RADIO-WIDE MOBILE OPTIONS SCREEN

Radio Wide P_qrameters

The radio-wide Mobile Options screen is shown
above, and is nsed to program the following
parameters:

Cursor Position - Selects if the Zone or Channel
select mode is enabled when power is turned on or
after a change is made (see next parameter). Refer to
Section 3.3.5 for more information.

Backlight Level - Selects the default backlight level
whenever power is on. This setting can be overridden
by the backlight option switch if it is programmed.

Hang-Up Box Monitor - Selecting “Off” disables
microphone off-hook detection. Taking the micro-
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phone off-hook then does not enable the monitor
mode or disable scanning. Selecting “On” enables
microphone off-hook detection.

Ignition Power Down Time - When the ignition
switch controls transceiver power, this sets the delay
that occurs between when the ignition switch is
turned off and when transceiver power actually turns
off. Times of 0-254 minutes can be programmed or
an infinite time (no turn-off) can be selected (Section
3.4.4),

Minimum Volume - Sets the minimum volume level
that can be selected by the volume control. This can
be used to prevent missed messages caused by inad-
vertently turmning the volume down too far. Relative
levels of 0-255 can be set (“0” sets the lowest mini-
mum volume).

Cursor Time-Out - Programs the time delay that
occurs before the cursor returns to the default posi-
tion programmed in the preceding parameter. Times
of 0-255 seconds can be programmed (“0” selects no
return).

4.5 PROGRAMMING CONVENTIONAL
SYSTEMS AND CHANNELS

4.5.1 INTRODUCTION

The fotlowing information describes how to
program conventional channels (both analog and
Project 25). Only one conventional system can be
programmed, and it is automatically set up when the
programming file is selected as described in Section
4.1.6. Up to 256 conventional channels can be
programmed (if no SmartNet/SmartZone systems are
programmed). Refer to Section 1.2.4 for more infor-
mation on systems and channels.

The following is the recommended procedure for
programming conventicnal channels:

1. Program the radio-wide information as described in
Section 4.4.

2. If other types of systems are programmed, make
sure the conventional system is selected by selecting
Window > Conventional in the menu bar.

3. Program the conventional system information and
then the channel information as follows (both
analog and Project 25 digital channels).

4.5.2 CONVENTIONAL SYSTEM GENERAL
SCREEN

Conventional System

The conventional system General screen is shown
above, and it programs the following parameters:

Timers
Tx Time-Out Timer - This timer limits the length of

transmissions (Section 3.4.2). Times up to 3 minutes,
45 seconds in 15-second steps can be programmed.

Penalty Timer - This timer disables transmitting after
the time-out timer expires (Section 3.5.6). Times up
to 3 minutes, 45 seconds in 15-second steps can be
programmed.

Conversation Timer - This timer limits the total
length of a conversation (Section 3.5.7). Times up to
7.5 minutes in 0.5-minute steps can be programmed.

Scan List Button

Clicking the Scan List button displays the
following screen which is used to program the conven-
tional scan lists described in Section 3.5.12. If the
Scan List option switch is not programmed, only one
scan list can be programmed.

NOTE: The conventional scan lists cannot be
programmed until all the conventional channels are
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programmed. Therefore, first program the channels as
described in Sections 4.5.5, 4.5.6, and 4.5.7.

Conventional Sstem can

To modify a list, click
screen which follows is displayed. Select the desired
scan list in the box on the top and then select the zone
and the channels from that zone to be included. Repeat
for each zone. Do this for each list programmed. To
select the priority channel for each scan list (if appli-
cable), click the desired zone/channel and then the
i button. The button deletes
the selected channel(s) from the scan list.

Maodify Non-Trunk Scan List

Conventional System Modify Scan List Screen
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The following parameters are programmed in the
preceding Conventional System Scan List Screen.

Priority Channel

The priority channel used for priority channel
sampling (see Section 3.5.12) can be selected for each
scan list as just described. The selected Scan Mode
(see following) determines if this channel is sampled.

Keypad Editing

This function does not apply to mobile trans-
ceivers. It enables or disables scan list editing using an
option switch programmed for that function.

Scan Mode

Sets the channel on which transmissions occur
when the PTT switch is pressed while scanning. A
different mode can be programmed for each scan list.
The scan list to be programmed is selected by clicking
it. The following modes are available:

No Priority - Priority sampling does not occur (all
channels are scanned in sequence). The radio trans-
mits on the selected channel.

Priority/Tx Priority - Priority sampling occurs
and the priority channel is the one programmed in
the selected scan list. The radio transmits on the
priority channel.

Priority/Tx Selected - Priority sampling occurs
and the priority channel is the one programmed in
the selected scan list. The radio transmits on the
selected channel.

Priority on Sel Chan - The priority channel is
always the selected channel (even if the scan list is
programmed with a priority channel). The radio

transmits on the selected channel.

Talkback - No priority sampling occurs. The radio
transmits on the channel of a call while scanning is
halted. Then when scanning resumes, it transmits
on the selected channel.
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Scan Timers

Scan Hold Time - Sets the delay that occurs before
scanning resumes after a signal is no longer
received (see Section 3.4.6).

Lookback Time A - This time determines how
often the priority channel is checked for activity.
Times of 0.25-4.00 seconds in 0.25-second steps
can be programmed.

Lookback Time B - This time determines how
often the priority channel is checked once an incor-
rect Call Guard (CTCSS/DCS) or NAC code is
detected. Since it takes much longer to detect an
incorrect Call Guard signal than a carrier, this time
should be relatively long to prevent the interrup-
tions from making a message difficult to under-
stand. Times of 0.5-8.0 seconds can be
programmed in 0.5-second steps.

4.5.3 CONVENTIONAL SYSTEM INDIVIDUAL
CALL LIST SCREEN

NOTE: This screen can be left unprogrammed if no
conventional Project 25 digital channel are
programmed or individual calling is not used.

Individual calls can be placed on Project 25
digital channels as described in Section 3.5.14. The
IDs that can be called are programmed in the Indi-
vidual Call List programmed by the Individual Cali
List screen. This screen and the parameters it
programs are as follows:

Modify List Button - Clicking this
button displays the screen that programs the alias
(tag) and individual ID for each call. An alias can
have up to 10 characters, and the individual IDs can
be 1-16777216.

Delete Entry Button - Clicking this
button deletes the selected entry.

Call Encryption PID - Indicates which DES-OFB

encryption key should be used for secure private
calls.

4-13

Conventional System Individual Call List
Screen

Call Timer - Sets the maximum time that the radio
remains in the individual call mode afteran individ-
ual call is received. A response must be made before-
this timer expires.

4.5.4 CONVENTIONAL SYSTEM TALK GROUP
SCREEN

The conventional system Talk Group screen
which follows is used to set up Project 25 talk groups
(it is not used with analog channels). These talk groups
are assigned to channels on the Channel screen (see
Section 4.5.7). The parameters in this screen are as
follows:

Talk Group - Displays the talk group to be edited. To
select another, click the scroll button to the right of
the box.

- Displays the screen used to change
the alias of the selected talk group.

- Displays the following screen that is
used to add a new Project 25 talk group. The alias

and 1D of the talk group are specified in this screen.
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Group IDs from 1-65535 can be programmed with
Project 25 operation.

Conventional System Talk Group Screen

- Deletes the selected talk group.

Strapping Mode - Selects if secure communication is
not used, always selected, or is switch selectable on
that talk group (see Section 3.5.15).

Secure Code - If secure communication is enabled,
selects the secure code key used on that talk group.

4.5.5 SETTING UP CONVENTIONAL
CHANNELS

The conventional Channel screen shown in
Figure 4-2 is displayed when a conventional analog
channel is selected, and the screen shown in Figure 4-3
is displayed when a conventional Project 25 (digital)
channel is selected. These screens program unique
channel parameters and also assign channels to the
selectable zones displayed by the transceiver.

The general procedure for setting up a conven-
tional channel is as follows. Refer to the descriptions
which follow this procedure for information on the
parameters in the channel screens.

1. Make sure that the desired zone is selected in the
Zone box.

Channe}l Parameters

EAEINREy|
- ANALDG 2
: PROJ 251
: PROJ 252
: SMART 1

1. Conventional

Figure 4-2 Conventional Analog Channel Screen
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2. Select the channel number in the Channels Index
box which is to be programmed with the channel
(this will be the number displayed when the channel
is selected).

3. To assign a conventional channel, select “Conven-
tional” as the channel type. Then select “Analog” if
it is an analog channel or “Project 25" if itis a
Project 25 channel.

4, Click the Modify button to display the screen which
enables that channel and programs the alias (tag)
and transmit and receive frequencies. Then program
the other parameters in the main part of the screen.
Refer to the next section or Section 4.5.7 for more
information, which is applicable.

4.5.6 CONVENTIONAL ANALOG CHANNEL
SCREEN PARAMETERS

The following parameters are programmed in the
conventional analog channel screen shown in Figure
4-2.

Selected Channel
Zone Box - Clicking the arrow to the right of this box
displays the available zones. Click on a zone to select
it. Zones and zone aliases are set up on the Radio-

Wide General screen described in Section 4.4.2.

Channel Index Box - Displays the available channels

in the selected zone. The channel type is selected by
the Channel Type box below it.

follows which enables the channel {(makes it select-
able) and programs the alias (tag) and transmit and
receive frequencies.

The parameters in this screen are as follows:

Channel - Selects the channel to be edited.

Alias - Programs the identification that is displayed
when the channel is selected. Up to 10
characters can be programmed.

Transmit - Programs the transmit frequency of the
channel. If a transmit frequency of “0” is
programmed, the channel is receive only.

Receive - Programs the receive frequency of the
channel.

Enable This Channel - The box must be checked for
the channel to be selectable.

Copy Parameters From Channel - If another channel
is selected, the parameters from that chan-
nel are copied to the new channel.

NOTE: Channel numbers not assigned nust be
programmed for conventional operation and then not
enabled in the above screen because SmartNet/Smart-
Zone channels cannot be disabled.

Channel Type

Channel Type Box - Selects the specific system from
which the channel is selected. All programmed sys-
temns are displayed by number and type (conven-
tional, SmartNet, SmartZone). In addition, with
conventional channels, either analog or Project 25 is
selected. When a different channel type is selected,
the screen for that type of channel is automatically
displayed.

Svstem Specific Information - With conventional
systems, indicates the frequency of the selected
channel without having to select the Modify box.

Transmit Power

Fixes the transmit power on the channel for the
high or low level or allows it to be switch selectable
(the Hi/Lo Power option switch is then required).
Refer to Section 3.5.9 for more information.

Tx Time-Out
Enables or disables the time-out timer on the

channel. The time-out timer time is programmed in the
conventional system General screen (Section 4.5.2).
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Busy Channel Lockout

Off = disabled, Noise = transmit disallowed if
carrier is detected, Tone = transmit allowed only if
correct Call Guard code is detected, Tone w/Lockout =
same as “Tone” except transmit allowed if “Normal”
is selected by Normal/Selective option switch (Section
3.5.4).

Coded Squelch

This sets the transmit and receive Call Guard
(CTCSS/DCS) coding, if any, used on the channel. If
“None” is selected, no code is transmitted and carrier-
controlled squelch is used when receiving (Section
3.5.5). The standard Call Guard tones and codes are
listed in Table 4-1 located on page 4-27.

Signaling
Off - No ANI signaling is used.
Leading ANI - A DTMF-coded ID is sent at the
beginning of each transmission. This ID is set in the

radio-wide conventional screen (Section 4.4.3).

Trailing ANT - A DTMF-coded ID is sent at the end
of each transmission.

Channel Modulation

This selects if the channel modulation is wide-
band (5 kHz), narrowband (2.5 kHz), or NPSPAC (4
kHz). NPSPAC (public safety) modulation applies to
800 MHz models only.

Strapping Mode
NOTE: See Section 3.5.15 for more information.

Clear - All transmissions on the channel occur in the
clear (unscrambled) mode.

Coded - All transmissions on the channel occur in the
secure mode (scrambled) mode selected by Coded
Options.

Switched - The clear or secure status of the channel
is selected by the Clear/Secure option switch.

Coded Options
NOTE: See Section 3.5.15 for more information.
These options select either the 460 or DES type

of secure communication when either the coded or
switched strapping mode is selected.

annel Parameters

A s

Figure 4-3 Conventional Project 25 Digital Channel Screen
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Scrambling - Selects the Transcrypt 460 or 460+
(Phoenix) scrambling protocol.

SecureNet - Selects the DES-XL encryption
protocol.

Rx AutoDetect - With the SecureNet protocol,
selecting “Secure” enables automatic detection of
encrypted receive signals. This may increase the
response time of the radio to an incoming signal.
Selecting “Proper Key™ causes the radio to search the
available SecureNet keys until it finds a match for the
current transmission.

Encryption Key - Selects the encryption key from
0-15 that is used on the channel. This refers to the
hardware location in the radio of the real key.

4.5.7 CONVENTIONAL PROJECT 25 (DIGITAL)
CHANNEL SCREEN PARAMETERS

The following parameters are programmed in the
conventional Project 25 digital channel screen shown
in Figure 4-3. Refer to Section 3.5.14 for more infor-
mation on Project 25 operation.

Selected Channel - Same as with analog channels
described in preceding section.

Channel Type - Same as with analog channels
described in preceding section.

Transmit Power - Same as with analog channels
described in preceding section.

Transmit Time-Out - Same as with analog channels
described in preceding section.

Talk Groups

This selects the Project 25 talk group that is
assigned to the channel. The talk group programs the
talk group ID, strapping mode, and encryption key
address. Talk groups for Project 25 channels are
programmed in the Conventional System Talk Group

screen described in Section 4.5 4.

Strapped to Selected Group - If this parameter is
selected, the talk group on that channel is always the
selected talk group and cannot be changed.

4-17

Radio List Selectable - If this parameter is selected,
the talk group may be changed by the radio operater
using the "Digital TG Select” function button.

Busy Channel Lockout

Off = disabled, Noise = transmit disallowed if
carrier is detected, NAC = transmit allowed only if
correct NAC is detected, NAC w/Lockout = same as
“NAC” except transmit allowed if “Normal” is
selected by Normal/Selective option switch (Section
3.5.4).

Access Codes

Programs the transmit and receive NAC
(Network Access Code). These codes can be 0-4095.
Refer to Section 3.5.14 for more information.

4.6 PROGRAMMING SMARTNET/SMARTZONE
SYSTEMS AND CHANNELS

4.6.1 INTRODUCTION

To program SmartNet and SmartZone systems
and channels, proceed as follows:

1. Program the SmartNet/SmartZone radio-wide infor-

mation as described in Section 4.4.

To create a new SmartNet/SmartZone system, select
the Systems > Add Systems in the menu bar (see
Section 4.1.10). Up to sixteen systems of any type
can be programmed as described in Section 1.2.4.

Program the SmartNet/SmartZone system informa-
tion as described starting in the next section. Make
sure the desired SmartNet or SmartZone system is
displayed by selecting it in the Window menu in the
menu bar. Then program the channels as described
starting in Section 4.6.8.

April 1999
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4.6.2 SMARTNET/SMARTZONE SYSTEM
GENERAL SCREEN

The SmartNet/SmartZone System General screen
is shown above, and it programs the following
parameters:

Restricted Access

Change System ID Button - Displays the Change
System 1D screen which is used to enter the system
ID of the system. This ID is entered as a hexadecimal
number from 0-9 and A-F. Valid numbers are from
0001-FFFF. The system ID corresponding to the
desired ID must also be located in the “key” subdi-
rectory of the program file.

System ID - Read-only field which shows the ID of
the system currently being edited.

Splinter Channels

When splinter channels are enabled, the receive
and transmit frequencies are 12.5 kHz lower than the
normal frequencies. Splinter channels are used only as
required in the Mexico and Canada border areas for
frequencies between 806 and 820.975 MHz.

April 1999
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Channel Modulation

When “Wideband” is enabled, the radio operates
with a 4 kHz maximum deviation between 821.000
and 824.975 MHz and 5 kHz maximum deviation for
all other frequencies. When it is disabled, deviation is
5 kHz with all frequencies.

System Lists Button

This button displays the screens used to program
the various per system lists. Refer to Section 4.6.7 for
more information on these lists.

Dynamic Regrouping

Enable For This System - When this box is checked,
a dynamic regrouping channel is enabled. This is a
SmartNet channel which has the corresponding talk
group dynamically set by the dispatcher.

Zone - The physical zone containing the dynamic
regrouping channel. The value is selected on the
Channel Parameters screen.

Channel - The physical channel used for dynamic
regrouping. The value is selected on the Channel
Parameters screen.

Affiliation Type

Automatic - The radio immediately affiliates with the
central controller as soon as it is turned on and auto-
matically re-affiliates each time the talk group is
changed.

On PTT - The radio affiliates with the central control-
ler only when the PTT switch is pressed.

Time-Out Timer
Programs the time-out timer setting for the

system. It can be programmed for 0 min, 15 sec up to
3 min, 45 sec or it can be disabled (see Section 3.4.2).
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4.6.3 SMARTNET/SMARTZONE SYSTEM Dynamic Talk Group - Key used for the dynamic
OTHER ID’'S SCREEN regrouping talk group when it is a standard talk
group.

Dynamic Ann. Group - Key used for the dynamic
regrouping talk group when it is an announcement

group.

4.6.4 SMARTNET/SMARTZONE SYSTEM
PHONE INTERCONNECT SCREEN

The SmartNet/SmartZone Other 1D’s screen is
shown above, and it programs the following
parameters.

Individual ID - Uniquely identifies the radio on a par-
ticular system. Each radio must have a different Unit
ID. Valid Unit IDs are from 1-49152.

Connect Tone - The tone expected by the controller The SmartNet/SmartZone Phone Interconnect
on the traffic channel to verify that a subscriber trans- screen is shown above, and it programs the following
mission is occurring. This tone should be set the parameters.

same as it is in the controiler.

Encryption Key IDs Phone Interconnect
Programs SecureNet Encryption 1D selection that Refer to Section 3.6.6 for more information on
is used in all except group calls. telephone calls.
System Wide - Key used for system-wide calls Disabled - Telephone calls cannot be placed or
(typically originated by the dispatcher). received.
Failsoft - Key used in failsoft conditions (see Section Answer Only - Telephone calls can be received but
3.6.11). not placed.
Patch Key Select - Key used in patch calls. List Only - Telephone calls can be placed and
received, and numbers can be recalled from memory
Unit To Unit - Key used for unit-to-unit (private) only.
calls.
Unlimited - Telephone calls can be placed and
Interconnect - Key used for telephone interconnect received, and numbers can be recalled from memory
calls. or dialed using a microphone keypad.
April 1999
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Private Call

Same as above, but for private (unit-to-unit) calls.
Refer to Section 3.6.5 for more information.

Private Call 11

Programs either standard or enhanced private
calls as follows:

Standard - The user does not receive any feedback
when the called radio is not active in the system.
Only a “No Answer” is received if the called radio
does not answer.

Enhanced - When a call is placed, the system tells the
user if the called radio is currently active in the sys-
tem and within range. The calling radio displays “No
Ack” if the called radio is not active in the system

and “No Answer” if it is active but does not answer,

Phone DTMF Timing

Initial Delay - Delay from 50-500 milliseconds from

when a traffic channel is granted for phone intercon-

nect to the start of the dialing out of the phone
number.

Digit Duration - Duration from 50-300 milliseconds
of each phone number digit.

Inter-Digit Delay - Delay from 50-500 milliseconds
between each digit of a phone number.

4.6.,5 SMARTNET/SMARTZONE SYSTEM
TALK GROUPS SCREEN

The SmartNet/SmartZone Talk Groups screen
which follows is used to set up SmartNet/SmartZone
talk groups and program unique talk group informa-
tion. The parameters programmed in this screen are as

follows:

Talk Group - Selects the talk group to program. This
is the actual ID of the talk group. Talk groups are
added or deleted by clicking the Add TG or Delete
TG button (see following). Talk groups are assigned

to channels on the channel screen (see Section 4.6.9).
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| SmartNet/SmartZone System Talk Groups

Screen

Clicking this button displays a dialog
box that adds a new talk group. The alias (alphatag)
of up to ten characters is entered, and the new group
is then added after the others that are already set up.
Each SmartNet/SmartZone system can be pro-
grammed with up to 256 talk groups.

ek il - Clicking this button deletes the cur-
rently selected talk group (the one displayed in the
“Talk Group” box).

Failsoft Channel

Enable - Enables a failsoft channel on the talk group
if a controller failure occurs (see Section 3.6.11).

Disable - The failsoft mode is not entered if the con-
troller fails.

Tx/Rx Frequency - Programs the failsoft channel
frequency if “Enabled™ is checked.

Strapping Parameters

The Strapping Parameters program the channel

type (analog or Project 25 digital) and encryption on
the talk group as follows:

Type - Selects the type of SmartNet/SmartZone
channel as analog or Project 25 (digital).
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Clear Mode - All transmissions on the talk group
occur in the clear (unscrambled) mode.

Coded Mode - All transmissions on the talk group
occur in the secure (scrambled) mode selected as
follows.

Switched Mode - The clear or secure status of the
talk group is selected by the Clear/Secure option
switch.

NOTE: Refer to Section 3.6.15 for more SmartNet/
SmartZone encryption information.

Scrambling/SecureNet Mode - These options select
either the 460 or DES type of secure communication
when either the coded or switched strapping mode is
selected.

Rx Secure Autodetect - If this option is checked, a
DES/DES-XL encrypted signal is automatically
detected and received. This option may increase the
response time 1o incoming signals. If it is not
checked, those signals are detected only if they are
coded like the transmit signals.

Rx Proper Key Detect - If this option is checked, the
radio will search the available SecureNet keys until
it finds a match for the current transmission.

Encryption Key - Selects the encryption key used on
the tatk group. This is a number from 0-15 that refers
to a hardware location in the radio that contains the
real key.

4.6.6 SMARTNET/SMARTZONE SYSTEM
EMERGENCY SETTINGS SCREEN

The SmartNet/SmartZone Emergency Settings
screen and the parameters programmed in this screen
follow:

Emergency Call
Enable - When the Emergency option switch and
then the PTT switch are pressed, an emergency group

call is transmitted.

Disable - An emergency group call is not authorized.

4-21

SmartNet/SmartZone System Emergency
Settings Screen

Emergency Hot Mic

Enable - When an emergency alarm is generated and
the emergency alarm acknowledgment received, the
emergency mode is automatically entered and trans-
mitting begins for the time specified by the Tx Period
parameter (see following).

Disable - Automatic transmissions do not occur.

Tx Period - Defines the period during which trans-
missions occur with the microphone audio unmuted
(without user intervention). Times of 10-120 seconds
in 10-second steps can be selected.

Emergency Alarm

Disabled - No emergency signal is sent when the user
presses the Emergency option switch.

Normal - When the user presses the Emergency
option switch, an emergency signal is sent to the dis-
patcher. Audio and visual feedback is provided by
the radio.

Silent - Same as “Normal” except no audio or visual
feedback is provided.

Retry Counter - When “Unlimited” is selected, an
emergency call is repeated until acknowledged or
canceled. When “Limited” is checked, calls are
attempted only the specified number of times.

April 1999
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4.6.7 SMARTNET/SMARTZONE SYSTEM
LISTS SCREENS

Clicking the button in the General
screen described in Section 4.6.2 displays the screens
used to program the various lists that are unique for
each SmartNet/SmartZone system. These screens are
as follows:

Trunking Phone List Screen

This screen programs the phone number list if
used (see Section 3.6.6). To edit this list, click the
Trunking Phone List tab and then the “Modify List”
button on the right side of the screen. The following
information is then programmed in the dialog box that
is displayed:

Entry Number - This box selects the entry to be
edited. The scroll bars to the right of this box select
the desired entry. A phone list can contain up to 16
entries. Selecting a new entry number automatically
validates and stores the current entry. If the current
entry contains an invalid field (for example, too
many digits in the phone number), the entry number
does not change and the invalid field is highlighted.

Entry Alias - Up to ten characters can be entered to
identify the phone number. This identification is dis-
played when phone numbers are selected by the user
from the list. Only uppercase letters can be entered,
so lowercase letters are automatically converted to
uppercase by the program.
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Phone Number - This is the number dialed when the
location is selected. Characters that can be entered
include 0-9, #, (,), and P (a “P” programs a pause).
The maximum number of digits excluding (,) and
spaces is 16, and the maximum including {,) and
spaces is 24.

Close - Clicking this button verifies the current entry,
stores it, and then closes the dialog box. If the current
entry contains an invalid field, the dialog box does
not close and the invalid field is highlighted.

Help - Accesses the Help screen. Help can also be
selected at any time by pressing the F1 key.

Message Aliasing Screen

This screen associates an alias (name) with each

message number (see Section 3.6.8). To edit this list,
click the Message Aliasing tab and then the “Modity
List” button on the right side. The following informa-
tion is then programmed in the dialog box that is
displayed:

Message Number - This box selects the message to
be edited. The scroll bars to the right of this box
select the desired message number.

Message Alias - Programs the alias which can be up
to any ten alphanumeric characters.

Close Button - Validates the entry and closes the dia-
log box. The entry is also validated when another
message number is selected.
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Announcement Groups Screen

SmartNet/SmartZone Announcement Groups
Screen

This screen programs the announcement groups
that are used to communicate with several talk groups
simultaneously. There can be up to 3 announcement
groups per system, and each announcement group can
have up to 15 talk groups.

To edit this list, click the Announcement Groups
tab and then the “Modify List” button on the right
side. The following information is then programmed
in the dialog box that is displayed:

Announcement Group

List Number - Selects the announcement group to be

programmed (1, 2, or 3).

Group ID - Programs the group 1D of that announce-

ment group.

Add Talk Group

Assigned Index - Use the scroll bars to select the talk

group to be moditied.

Talk Group - Programs the group ID of the selected
talk group.

Main Screen Parameters

Talk Group - Read-only list of all talk groups cur-
rently in the announcement group.
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AG Type - Programs the type of communication

associated with the announcement group. Either ana-

log or digital (Project 25) communication can be
selected.

Strapping Mode - Defines the type of secure commu-

nication used, if any, for the announcement group.
Clear, Coded, or Switched can be selected the same
as on the Talk Group screen (see Section 4.6.5).

Control Channels Screen

This screen allows the system manager to view
and edit the control channels. Each SmartNet system
can have up to four control channels, and each Smart-
Zone system can have up to 32 control channels. Only
one control channel is active at a time.

To edit this list, click the Control Channels tab
and then the “Modify List” button on the right side.
The following information is then programmed in the
dialog box that is displayed:

Control Channel - Selects the control channel to be
edited. To add a new channel, click the “New Entry”
button.

Frequency - The transmit and receive frequency of
the control channel. These are the mobile frequen-

cies, not the repeater frequencies. Only multiples of

5 kHz and 6.25 kHz are valid. With 800 MHz fre-
quencies, a receive frequency 45 MHz above the
transmit frequency is automatically entered.

New Entry Button - Click this button to display the
dialog box used to add another control channel.
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Trunking Call List Screen

This screen is shown above, and it allows the list
of IDs used for private calls to be programmed. A
maximum of 16 IDs can be programmed (see Section

3.6.5).

To edit this list, click the Trunking Call List tab
and then the “Modify List” button on the right side.
This following information is then programmed in the
dialog box that is displayed:

Entry Number - This box selects the entry tc be
edited. The scroll bars to the right of this box select
the desired entry. A phone list can contain up to 16
entries. Selecting a new entry number automatically
validates and stores the current entry. If the current
entry contains an invalid field, the entry number does
not change and the invalid field 1s highlighted.

Entry Alias - Up to ten characters can be entered to
identify the user being calted. This identification is

displayed when the mobile to be called is selected by
the user from the list. Only uppercase letters can be
entered, so lowercase letters are automatically con-

verted to uppercase by the program.

Call ID - This is the 1D of the radio being called.
Valid entries are 1-49152. A *“0” is detected as no

entry.

Close Button - Verifies the current entry, stores it,
and then closes the dialog box. If the current entry
contains an invalid field, the dialog box does not
close and the invalid field is highlighted.
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Priority Monitor Scan Screen

SMARTNET3

This screen programs up to three Priority Monitor
scan lists that are allowed. Each scan list can contain
up to 15 channels plus a priority channel (see Section
3.6.12). These channels must be from the same
SmartNet/SmartZone system. Channels set up for
other systems are not allowed.

To edit a list, click the Priority Monitor Scan tab
and then click the “Modify List” button on the right
side. A screen similar to the top screen shown above is
then displayed to select the channels to be included in
that scan list. Select channels as follows:

1. Select the scan list to be edited using the scroll bars
next to the “Scan List To Modify” box.

2. Select the first zone with channels to be included
and select the desired channels. Repeat for the other
zones.
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3. To select the priority channel, click the Set Priority
button. Then select the desired Zone/Channel or
“None” if no priority channel is to be scanned.

4. Repeat the preceding steps for the other scan lists if
applicable.

Status Aliasing Screen

This screen is shown above, and it programs the
alias for each of up to eight status conditions that can
be sent. The meaning of each status number is defined
by the system manager. Refer to Section 3.6.9 for
more information.

To edit this list, click the Status Aliasing tab and
then the “Modify List” button on the right side. The
following information is then programmed in the
dialog box that is displayed:

Status Number - The scroll bars to the right of this
box select the status number that is to be edited.

Status Alias - Programs up to 10 characters that iden-
tify the status. This identification is displayed when
the user selects a status condition.

4.6.8 SETTING UP SMARTNET/SMART-
ZONE CHANNELS

The SmartNet/SmartZone Channel screen shown
in Figure 4-4 is displayed when the SmartiNet or
SmartZone channel type is selected. The channel
screen programs unique channel parameters and also
assigns channels to the selectable zones displayed by
the transceiver.

The general procedure for setting up a
SmartNet/SmartZone channel is as follows. Refer to
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the descriptions which follow this procedure for infor-
mation on SmartNet/SmartZone Channel screen
parameters.

Make sure that the desired zone is selected in the
Zone box.

1.

Select the channel number in the Channels Index
box which is to be programmed with the channel.
This will be the number displayed when the channel
is selected.

. To set up a SmartNet channel, select “SmartNet” as
the channel type, and to set up a SmartZone channel,
select “SmartZone”.

Click the Modify button to display the dialog box
shown in the lower part of Figure 4-4. This box
programs the alias (tag) that is displayed when it is
selected.

Program the other parameters in the main part of the
screen (see information which follows).

4.6.9 SMARTNET/SMARTZONE CHANNEL
SCREEN PARAMETERS

The following parameters are programmed in the
SmartNet/SmartZone channel screen shown in Figure
4-4.

Selected Channel

Zone Box - Clicking the arrow to the right of this box
displays the available zones. Click on a zone to select
it. Zones and zone aliases are set up on the Radio-
Wide General screen described in Section 4.4.2.

Channei Index Box - Displays the channels in the
selected zone. The channel type is selected by the
Channel Type box below it.

: - Displays the screen shown in the lower
part of Figure 4-4. The parameters programmed in
this screen are as follows:

Channel - Selects the channel to be edited.

Alias - Programs the identification that is displayed
when the channel is selected. Up to 10
characters can be programmed.
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File Radio Type Download Systems

Window Help

Channel Parameters

1: MINNESOTA

Transmit - Not programmable because the transmit
frequency is dynamically assigned over the
air (*Trunked” is always displayed).

Receive - Dynamically assigned like the preceding
transmit frequency.

Enable This Channel - Not used because SmartNet/
SmartZone channels are always enabled if
set up. To disable a channel so that it is not
selectable, choose the conventional type
and do not check this box.

Copy Parameters From Channel - [f another channel
is selected in the box, the parameters from

that channel are copied to the new channel.

Channel Type

Channel Type Box - Selects the specific system from
which the channel! is selected. All programmed
systems are displayed by number and type (conven-

Figure 4-4 SmartNet/SmartZone Channel Screen

tional, SmartNet, SmartZone). When a different
channel type is selected, the screen for that type of
channel is automatically displayed.

Other Screen Parameters

Systemn Specific Information - With Smart-
Net/SmartZone systems, indicates the system ID
programmed on the system General screen (see
Section 4.6.2).

Talk Group - Selects the talk group selected by that
channel. Talk groups are programmed in the Talk
Group screen described in Section 4.6.5.

Announcement Group - Selects one of up to three
announcement groups selected by the channel. Refer
to “Announcement Group Screen” in Section 4.6.7
for more information.
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Emergency Group - Selects the talk group used for
emergency calls.

Talk Permit Tone - When enabled, a short tone
sounds after a request for a group call has been
approved by the main controller. This indicates that
speaking can begin, When disabled, no audio feed-
back is used to indicate when speaking can begin.

System Scan - Selects the Priority Monitor Scan list
selected by the channel (see “Priority Monitor Scan

Screen” description in Section 4.6.7). If “No Scan
List” is programmed, scanning is not selectable on
that channel,

Auto Scan - When enabled and a channel is selected,
the radio automatically begins scanning the scan list
associated with that channel. When disabled, scan-
ning can only be started manually by the Scan option
switch.

Table 4-1 Call Guard (CTCSS/DCS) Codes and Tones

Recommended Tone Call Guard Codes

Code Freq Code Freq Code
00 00.0 09 91.5 18
01 67.0 10 4.8 19
02 719 11%* 97.4 20
03 74.4 12 100.0 21
04 77.0 13 103.5 22
05 79.7 14 107.2 23
06 82.5 15 110.9 24
07 854 16 114.8 25
08 88.5 17 118.8 26

Freq Code Freq Code Freq
123.0 27 167.9 37* 241.8
127.3 28 173.8 38* 250.3
131.8 29 1799 J0%* 69.3
136.5 30 186.2 40 * 206.5
141.3 31 192.8 41%** 2291
146.2 32 203.5 42%* 254.1
151.4 33 2107
156.7 34* 218.1
162.2 35% 2257

* These tones normally are not used because of their close proximity to the voice frequencies
** This tone is normally not used because it may cause interference with adjacent tones.

Recommended Digital Call Guard Codes

023 065 131 172 261 346 431 532 654 743
025 071 132 174 263 351 432 546 662 754
026 072 134 205 265 364 445 565 664
031 073 143 223 271 365 464 606 703
032 074 152 226 306 371 465 612 712
043 114 155 243 311 411 466 624 723
047 115 156 244 315 412 503 627 731
051 116 162 245 331 413 506 631 732
054 125 165 251 343 423 516 632 734
April 1999
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800 MHz Channels
FCC Chan.| Mobile Rx} Mobile Tx FCC Chan.; Mobile Rx! Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. F req_l No. Freq. Freq No. Freq Freq
1 851.0125 806.0125 49 852.2125 807.2125 97 8534125 B08.4125
2 851.0375  806.0375 50 852.2375 807.2375 98 8534375  808.4375
3 851.0625 806.0625 51 852.2625 807.2625 99 853.4625 808.4625
4 851.0875  806.0875 52 852.2875 807.2875 100 853.4875 808.4875
5 851.1125  806.1125 53 8§52.3125 807.3125 101 853.5125  808.5125
6 851.1375 806.1375 54 852.3375  807.3375 102 853.5375  808.5375
7 851.1625  806.1625 55 852.3625 807.3625 103 853.5625  B08.5625
8 851.1875 806.1875 56 852.3875  807.3875 104 853.5875 B0R.5875
9 851.2125 806.2125 57 852.4125 807.4125 105 853.6125 808.6125
10 851.2375 806,2375 58 852.4375 807.4375 106 853.6375 B08.6375
11 851.2625  806.2625 59 852.4625 807.4625 107 853.6625 808.6625
12 851.2875 806.2875 60 852.4875 807.4875 108 853.6875 808.6875
13 8513125 806.3125 61 852.5125  807.5125 109 853.7125  808.7125
14 851.3375 806.3375 62 852.5375  807.5375 110 853.7375  808.7375
15 851.3625  806.3625 63 852.5625  807.5625 111 853.7625  808.7625
16 851.3875 806.3875 64 852.5875  807.5875 112 853.7875  808.7875
17 8514125 8064125 65 852.6125 807.6125 113 853.8125 808.8125
i8 851.4375 8064375 66 852.6375  807.6375 114 8538375 808.8375
19 851.4625 B06.4625 67 8§52.6625 807.6625 115 853.8625  808.8625
20 8514875  806.4875 68 852.6875 807.6875 16 853.8875  808.8875
21 851.5125 806.5125 69 852.7125  807.7125 117 8539125 808.9125
22 851.5375 806.5375 70 852.7375  807.7375 118 8539375  808.9375
23 851.5625 806.5625 71 852.7625  807.7625 119 853.9625 808.9625
24 851.5875 806.5875 72 852.7875  807.7875 120 8539875 B08.9875
25 851.6125  806.6125 73 852.8125 807.8125 121 854.0125  809.0125
26 851.6375  806.6375 74 §52.8375  807.8375 122 854.0375  809.0375
27 851.6625  806.6625 75 852.8625  807.8625 123 854.0625  809.0625
28 851.6875  B806.6875 76 852.8875  B07.8875 124 854.0875  8(09.0875
29 851.7125  806.7125 77 8529125 807.9125 125 854.1125 809.1125
30 8517375  806.7375 78 8529375 807.9375 126 854.1375 809.1375
31 851.7625  806.7625 79 852.9625 807.9625 127 854.1625  809.1625
32 851.7875  806.7875 80 852.9875  B07.9875 128 854.1875 809.1875
33 851.8125 806.8125 81 853.0125 808.0125 129 8542125  809.2125
34 851.8375 806.8375 82 853.0375  808.0375 130 854.2375  809.2375
35 851.8625  806.8625 83 853.0625  808.0625 131 854.2625  809.2625
36 851.8875 B806.8875 84 853.0875  808.0875 132 854.2875 8092875
37 8519125 806.9125 85 853.1125  808.1125 133 8543125  809.3125
38 851.9375 806.9375 86 853.1375 808.1375 134 854.3375  809.3375
39 8519625  806.9625 87 853.1625  808.1625 135 854.3625  809.3625
40 8519875 806.9875 88 853.1875 808.1875 136 854.3875  809.3875
41 852.0125  807.0125 89 853.2125 808.2125 137 854.4125  809.4125
42 852.0375  807.0375 90 853.2375  808.2375 138 854.4375  809.4375
43 852.0625  807.0625 91 853.2625  808.2625 139 8544625  809.4625
44 852.0875  807.0875 92 853.2875  808.2875 140 854.4875  809.4875
45 852.1125  807.1125 93 853.3125 808.3125 141 854.5125 8095125
46 852.1375  807.1375 94 853.3375  808.3373 142 854.5375  809.5375
47 852.1625 807.1625 95 853.3625 808.3625 143 854.5625  809.5625
48 852.1875 807.1875 96 853.3875 808.3875 144 854.5875  809.5875
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TRANSCEIVER PROGRAMMING

800 MHz Channels
FCC Chan.! Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx
|- No. Freq. Freq No. Freq. Freq No. Freqg Freq—l
145 854.6125 800.6125 193 855.8125 810.8125 241 857.0125 812.0125
146 854.6375  809.6375 194 855.8375 810.8375 242 857.0375  812.0375
147 854.6625  809.6625 195 855.8625 810.8625 243 §57.0625  812.0625
148 854.6875 B09.6875 196 855.8875 810.8875 244 857.0875 812.0875
149 854.7125  809.7125 197 855.9125 8109125 245 857.1125 812.1125
150 854.7375 809.7375 198 855.9375 810.9375 246 857.1375  812.1375
151 854.7625 809.7625 199 855.9625 810.9625 247 857.1625  812.1625
152 854.7875 809.7875 200 855.9875 810.9875 248 857.1875  812.1875
153 8548125 809.8125 201 856.0125 811.0125 249 857.2125 812.2125
154 854 8375 809.8375 202 856.0375 811.0375 250 857.2375 812.2375
155 854.8625 809.8625 203 856.0625  811.0625 251 857.2625 812.2625
156 8§54.8875 806.8875 204 856.0875 811.0875 252 857.2875 812.2875
157 8549125 809.9125 205 856.1125 B11.1125 253 857.3125 812.3125
158 8549375  B(09.9375 206 856.1375 811.1375 254 857.3375 812.3375
159 854.9625  809.9625 207 856.1625 811.1625 255 857.3625 812.3625
160 8549875  809.9875 208 856.1875 811.1875 256 857.3875 8123875
16l 855.0125 810.0125 209 856.2125 811.2125 257 857.4125 8124125
162 855.0375 810.0375 210 856.2375 811.2375 258 857.4375  812.4375
163 855.0625 810.0625 211 856.2625 811.2625 259 857.4625  812.4625
164 855.0875  810.0875 212 856.2875 811.2875 260 857.4875 8124875
165 855.1125 810.1125 213 856.3125 811.3125 261 857.5125  812.5125
166 855.1375 810.1375 214 856.3375 811.3375 262 857.5375  812.5375
167 855.1625 810.1625 215 856.3625 811.3625 263 857.5625 812.5625
168 855.1875 810.1875 216 856.3875 811.3875 264 857.5875  BI2.5875
169 8552125  810.2125 217 856.4125 811.4125 265 857.6125 812.6125
170 8552375  810.2375 218 856.4375 811.4375 266 857.6375 812.6375
171 855.2625 810.2625 219 856.4625 811.4625 267 857.6625 812.6625
172 8552875  810.2875 220 856.4875 811.4875 268 8576875 812.6875
173 8553125 810.3125 221 856.5125 811.5125 269 857.7125  812.7125
174 8553375 810.3375 222 856.5375 811.5375 270 857.7375 812.7375
175 855.3625 810.3625 223 856.5625 811.5625 271 857.7625 812.7625
176 8553875 810.3875 224 856.5875 811.5875 272 857.7875  B12.7875
177 855.4125 810.4125 225 856.6125 811.6125 273 857.8125 812.8125
178 8554375  810.4375 226 856.6375 811.6375 274 857.8375 812.8375
179 855.4625  810.4625 227 856.6625 811.6625 275 857.8625 B12.8625
180 8554875 810.4875 228 856.6875 811.6875 276 857.8875 B12.8R875
181 855.5125  810.5125 229 856.7125 811.7125 277 8579125 8129125
182 855.5375  B10.5375 230 856.7375 811.7375 278 857.9375 8129375
183 8555625  810.5625 231 856.7625 811.7625 279 857.9625 812.9625
184 8555875 810.5875 232 856.7875 811.7875 280 8579875 8129875
185 8556125 810.6125 233 856.8125 811.8125 281 858.0125  B13.0125
186 855.6375 810.6375 234 856.8375 811.8375 282 858.0375  813.0375
187 855.6625 810.6625 235 856.8625 8§11.8625 283 858.0625  813.0625
188 855.6875  810.6875 236 856.8875 811.8875 284 858.0875 813.0875
189 8557125  810.7125 237 856.9125 811.9125 285 858.1125  813.1125
190 855.7375  810.7375 238 856.9375 811.9375 286 858.1375  813.1375
191 855.7625  810.7625 239 856.9625 811.9625 287 858.1625  813.1625
192 855.7875 810.7875 240 856.9875 811.9875 288 858.1875 813.1875
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800 MHz Channels
FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.] Mobile Rx| Mobile Tx
No. Freq. Freq I_- No. Freq. Freq No. Freq Freq_l

289 858.2125 8132125 337 859.4125 814.4125 385 860.6125 815.6125
290 858.2375  813.2375 338 8594375 814.4375 386 860.6375 B815.6375
291 858.2625 813.2625 339 859.4625 814.4625 387 860.6625 815.6625
292 858.2875  813.2875 340 859.4875 814.4875 388 860.6875 815.6875
293 858.3125 813.3125 341 859.5125 814.5125 389 860.7125 815.7125
294 858.3375 813.3375 342 859.5375 814.5375 390 860.7375 815.7375
295 858.3625 813.3625 343 859.5625 814.5625 391 860.7625 815.7625
296 858.3875 813.3875 344 859.5875 814.5875 392 860.7875 815.7875
297 8§58.4125 8134125 345 859.6125 8l14.6125 393 360.8125 815.8125
298 858.4375 813.4375 346 $59.6375 814.6375 394 860.8375 815.8375
299 858.4625 813.4625 347 859.6625 814.6625 395 860.8625 8§15.8625
300 858.4875 813.4875 348 8596875 814.6875 396 860.8875 815.8875
301 858.5125 813.5125 349 859.7125  814.7125 397 8609125 8159125
302 858.5375 813.5375 350 859.7375 814.7375 398 860.9375 8159375
303 858.5625 813.5625 351 859.7625 814.7625 399 860.9625 8159625
304 858.5875 813.5875 352 859.7875 814.7875 400 860.9875 815.9875
305 858.6125 813.6125 353 859.8125 814.8125 401 861.0125 816.0125
306 858.6375 813.6375 354 859.8375 814.8375 402 861.0375 816.0375
307 858.6625 813.6625 355 859.8625 814.8625 403 861.0625 816.0625
308 858.6875 813.6875 356 859.8875 814.8875 404 861.0875 816.0875
309 858.7125 813.7125 357 859.9125 8149125 405 861.1125 816.1125
310 858.7375 813.7375 358 859.9375 8149375 406 861.1375 816.1375
311 858.7625 813.7625 359 859.9625 814.9625 407 861.1625 816.1625
312 858.7875 813.7875 360 859.9875 814.9875 408 861.1875 816.1875
313 858.8125 813.8125 361 860.0125 815.0125 409 8612125 B816.2125
314 858.8375 813.8375 362 860.0375 815.0375 410 861.2375 816.2375
315 858.8625 813.8625 363 860.0625 815.0625 411 861.2625 816.2625
316 858.8875 813.8875 364 860.0875 815.0875 412 861.2875 816.2875
317 858.9125 813.9125 365 860.1125 815.1125 413 861.3125 816.3125
318 858.9375 813.9375 366 860.1375 815.1375 414 861.3375 816.3375
319 858.9625 813.9625 367 860.1625 815.1625 415 8613625 816.3625
320 858.9875 813.9875 368 860.1875 815.1875 416 861.3875 816.3875
321 859.0125 814.0125 369 860.2125 815.2125 417 861.4125 816.4125
322 859.0375 814.0375 370 860.2375 815.2375 418 861.4375 816.4375
323 859.0625 814.0625 3N 860.2625 815.2625 419 861.4625 816.4625
324 859.0875 814.0875 372 860.2875 815.2875 420 861.4875 816.4875
325 859.1125 814.1125 373 860.3125 8153125 421 861.5125 816.5125
326 859.1375 814.1375 374 860.3375 815.3375 422 8§61.5375 816.5375
327 839.1625 814.1625 375 860.3625 R815.3625 423 861.5625 8§16.5625
328 859.1875 814.1875 376 860.3875 815.3875 424 861.5875 816.5875
329 8592125 814.2125 377 860.4125 815.4125 425 861.6125  816.6125
330 8592375 814.2375 378 860.4375 8154375 426 861.6375 816.6375
331 8592625 814.2625 379 860.4625  815.4625 427 861.6625 816.6625
332 859.2875  814.2875 380 860.4875  815.4875 428 861.6875 816.6875
333 8593125 8143125 381 860.5125  B815.5125 429 861.7125 816.7125
334 859.3375 814.3375 382 860.5375 815.5375 430 861.7375 816.7375
335 859.3625 814.3625 383 860.5625 815.5625 431 861.7625  816.7625
336 859.3875 814.3875 384 860.5875 815.5875 432 861.7875 816.7875
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FCC Chan.| Mobile Rx | Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. Freq—l |_ No. Freq. Freq No. Freq Freq
433 861.8125 816.8125 481 863.0125 818.0125 529 864.2125 819.2125
434 861.8375 816.8375 482 863.0375 818.0375 530 864.2375  819.2375
435 861.8625 816.8625 483 863.0625 818.0625 531 864.2625 819.2625
436 861.8875 816.8875 484 863.0875 818.0875 532 864.2875 819.2875
437 861.9125 816.9125 485 863.1125 818.1125 533 8643125 8193125
438 861.9375 816.9375 486 863.1375 818.1375 534 864.3375 819.3375
439 861.9625 816.9625 487 863.1625 818.1625 535 864.3625  819.3625
440 861.9875 816.9875 488 863.1875 818.1875 536 8643875 8193875
441 862.0125 817.0125 489 863.2125 818.2125 537 864.4125 819.4125
442 862.0375 817.0375 490 863.2375 8182375 538 864.4375 8194375
443 862.0625 817.0625 491 863.2625 B818.2625 539 864.4625  819.4625
444 862.0875 817.0875 492 863.2875 818.2875 540 864.4875  819.4875
445 862.1125 817.1125 493 863.3125 818.3125 541 864.5125 819.5125
446 862.1375 817.1375 494 863.3375 818.3375 542 864.5375  819.5375
447 862.1625 817.1625 495 863.3625 818.3625 543 864.5625 819.5625
448 862.1875 817.1875 496 863.3875 818.3875 544 864.5875 819.5875
449 862.2125 817.2125 497 863.4125 818.4125 545 864.6125 819.6125
450 862.2375 817.2375 498 863.4375 818.4375 546 864.6375 819.6375
451 862.2625 817.2625 499 863.4625 818.4625 547 864.6625 819.6625
452 862.2875 817.2875 500 863.4875 818.4875 548 864.6875 819.6875
453 862.3125 817.3125 501 863.5125 818.5125 549 8647125 819.7125
454 862.3375 817.3375 502 863.5375 818.5375 550 864.7375  819.7375
455 862.3625  B17.3625 503 863.5625 818.5625 551 864.7625  819.7625
456 862.3875 817.3875 504 863.5875 818.5875 552 864.7875  819.7875
457 862.4125 817.4125 505 863.6125 818.6125 553 864.8125  B819.8125
458 862.4375 817.4375 506 863.6375 818.6375 554 864.8375 B19.8375
459 862.4625 817.4625 507 863.6625 818.6625 555 864.8625 819.8625
460 862.4875 817.4875 508 863.6875 818.6875 556 864.8875 819.8875
461 862.5125 817.5125 509 863.7125 818.7125 557 8649125 8199125
462 862.5375 817.5375 510 863.7375  818.7375 558 8649375 819.9375
463 862.5625 817.5625 511 863.7625 818.7625 559 864.9625 819.9625
464 862.5875 817.5875 512 863.7875 818.7875 560 864.9875 819.9875
465 862.6125 817.6125 513 863.8125 818.8125 561 865.0125 820.0125
466 862.6375 817.6375 514 863.8375 818.8375 562 865.0375 820.0375
467 862.6625 817.6625 515 863.8625 818.8625 563 865.0625 820.0625
468 862.6875 817.6875 516 863.8875 818.8875 564 865.0875 820.0875
469 8£62.7125 817.7125 517 863.9125 818.9125 565 865.1125  820.1125
470 862.7375 817.7375 518 863.9375 818.9375 566 865.1375 820.1375
471 862.7625 817.7625 519 863.9625 818.9625 567 865.1625 820.1625
472 862.7875 817.7875 520 863.9875 818.9875 568 865.1875  820.1875
473 862.8125 $17.8125 521 864.0125 819.0125 569 865.2125 820.2125
474 862.8375 817.8375 522 864.0375 819.0375 570 865.2375  820.2375
475 862.8625 817.8625 523 864.0625  819.0625 571 865.2625  820.2625
476 862.8875 817.8875 524 864.0875 819.0875 572 865.2875  820.2875
477 862.9125 817.9125 525 864.1125 819.1125 573 865.3125 8203125
478 862.9375  817.9375 526 864.1375 819.1375 574 8653375 8203375
479 862.9625  817.9625 527 864.1625  819.1625 575 865.3625  820.3625
480 862.9875 817.9875 528 864.1875 819.1875 576 865.3875  820.3875
i -
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FCC Chan.; Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. Freq No. Freq. F req—‘ No. Freq Freq —l
577 865.4125  820.4125 623 866.3000  821.3000 669 866.9000  821.9000
578 865.4375  820.4375 624 866.3125  821.3125 670 866.9125  821.9125
579 865.4625  820.4625 625 866.3250  821.3250 671 866.9250  821.9250
580 8654875  820.4875 626 866.3375  821.3375 672 866.9375  821.9375
581 865.5125  820.5125 627 8663500  821.3500 673 8669500  821.9500
582 865.5375  820.5375 628 8663625  B21.3625 674 866.9625  821.9625
583 865.5625  820.5625 629 866.3750  821.3750 675 866.9750  821.9750
584 865.5875  820.5875 630 866.3875  821.3875 676 866.9875  821.9875
585 8656125  820.6125 631 866.4000  821.4000 - 867.0000  822.0000
586 865.6375  820.6375 632 866.4125  R21.4125 677 867.0125  822.0125
587 865.6625  820.6625 633 866.4250  821.4250 - 867.0250  822.0250
588 865.6875  820.6875 634 866.4375  821.4375 678 867.0375  822.0375
589 865.7125  820.7125 635 866.4500  821.4500 679 867.0500  822.0500
590 865.7375  820.7375 636 866.4625  821.4625 680 867.0625  822.0625
591 865.7625  820.7625 637 866.4750  821.4750 681 867.0750  822.0750
592 865.7875  820.7875 638 866.4875  821.4875 682 867.0875  822.0875
593 865.8125  820.8125 - 866.5000  821.5000 683 867.1000  822.1000
594 865.8375  820.8375 639 806.5125  821.5125 684 867.1125  822.1125
593 865.8625  820.8625 - 866.5250  821.5250 685 867.1250  822.1250
596 865.8875  820.8875 640 866.5375  821.5375 686 867.1375 8221375
597 8659125  820.9125 641 866.5500  821.5500 687 867.1500  822.1500
598 8659375  820.9375 642 866.5625  821.5625 688 867.1625  822.1625
599 865.9625  820.9625 643 866.5750  821.5750 689 867.1750  822.1750
600 865.9875  820.9875 644 866.5875  821.3875 690 867.1875  822.1875
- 866.0000  821.0000 645 866.6000  821.6000 691 867.2000  822.2000
601 866.0125  821.0125 646 866.6125  821.6125 692 867.2125 8222125
- 866.0250  821.0250 647 866.6250  821.6250 693 867.2250  822.2250
602 866.0375  821.0375 648 866.6375  821.6375 694 867.2375  822.2375
603 866.0500  821.0500 649 866.6500  821.6500 695 867.2500  822.2500
604 866.0625  821.0625 650 866.6625  821.6625 696 867.2625  822.2625
605 866.0750  821.0750 6351 866.6750  821.6750 697 867.2750 8222750
606 866.0875  821.0875 652 866.6875  821.6875 698 867.2875  822.2875
607 866.1000  821.1000 633 866.7000  821.7000 699 867.3000  822.3000
608 866.1125  821.1125 654 866.7125  B21.7125 700 8673125  B822.3125
609 866.1250  821.1250 655 866.7250  821.7250 701 8673250  822.3250
610 866.1375  821.1375 656 866.7375  821.7375 702 867.3375  822.3375
611 866.1500  821.1500 657 866.7500  821.7500 703 867.3500  822.3500
612 866.1625  821.1625 658 866.7625  821.7625 704 8673625  822.3625
613 866.1750  821.1750 659 866.7750  821.7750 705 867.3750 8223750
614 866.1875  821.1875 660 866.7875  821.7875 706 867.3875 8223875
615 866.2000  821.2000 661 866.8000  821.8000 707 867.4000  822.4000
616 866.2125  821.2125 662 866.8125  821.8125 708 867.4125 8224125
617 866.2250  821.2250 663 866.8250  821.8250 709 867.4250  822.4250
618 8662375  821.2375 664 866.8375  821.8375 710 867.4375  822.4375
619 866.2500  821.2500 665 866.8500  821.8500 711 867.4500  822.4500
620 866.2625  821.2625 666 866.8625  821.8625 712 867.4625  822.4625
621 866.2750  821.2750 667 866.8750  821.8750 713 867.4750  822.4750
622 866.2875  821.2875 668 866.8875  821.8875 714 867.4875  822.4875
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FCC Chan.| Mobile Rx | Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. F req_l No. Freq. Freq No. Freq Freq

- 867.5000  822.5000 759 868.1000  823.1000 807 868.7000  823.7000
715 867.5125  822.5125 760 868.1125 823.1125 808 868.7125  823.7125
- 867.5250  822.5250 761 868.1250  823.1250 209 868.7250  823.7250
716 867.5375  822.5375 762 868.1375  823.1375 810 868.7375  823.7375
717 867.5500  822.5500 763 868.1500  823.1500 811 868.7500  823.7500
718 867.5625  822.5625 764 368.1625  823.1625 812 868.7625  823.7625
719 867.5750 8225750 765 8§68.1750  823.1750 813 868.7750 823.7750
720 8675875  822.5875 766 868.1875 823.1875 814 868.7875  823.7875
721 867.6000  822.6000 767 868.2000  823.2000 815 868.8000  823.8000
722 867.6125 8226125 768 868.2125  823.2125 816 868.8125 823.8125
723 867.6250  822.6250 769 868.2250  823.2250 817 868.8250  823.8250
724 867.6375  822.6375 770 868.2375  823.2375 318 868.8375 823.8375
725 867.6500 822.6500 771 868.2500  823.2500 819 868.8500 823.8500
726 867.6625  822.6625 772 868.2625  823.2625 820 868.8625  823.8625
727 867.6750  822.6750 773 868.2750  823.2750 821 868.8750  823.8750
728 867.6875  822.6875 774 868.2875  823.2875 822 868.8875  823.8875
729 867.7000 8227000 775 868.3000  823.3000 823 868.9000  823.9000
730 867.7125  B822.7125 776 868.3125 8233125 824 368.9125 823.9125
731 867.7250  822.7250 777 868.3250  823.3250 825 868.9250  823.9250
732 867.7375  822.7375 778 868.3375  823.3375 826 868.9375 8239375
733 867.7500  822.7500 779 868.3500  823.3500 827 868.9500  823.9500
734 867.7625  822.7625 780 868.3625 823.3625 328 868.9625  823.9625
735 867.7750  822.7750 781 868.3750  823.3750 329 868.9750 823.9750
736 867.7875  822.7875 782 868.3875  823.3875 830 868.9875 823.9875
737 867.8000  8§22.8000 783 868.4000  823.4000 - 869.0000 824.0000
738 867.8125 8228125 784 868.4125  823.4125 - 369.0125  824.0125
739 867.8250  8§22.8250 785 868.4250  823.4250 - 869.0250 824.0250
740 867.8375  822.8375 786 868.4375  823.4375 - 869.0375  824.0375
741 867.8500  822.8500 787 868.4500 823.4500 - 869.0500 824.0500
742 867.8625  822.8625 788 868.4625  823.4625 - 869.0625  824.0625
743 867.8750  822.8750 789 868.4750  823.4750 - 869.0750  824.0750
744 867.8875  822.8875 790 868.4875  823.4875 - 869.0875  824.0875
745 867.9000  822.9000 791 868.5000 823.5000 - 869.1000  824.1000
746 8679125 8229125 792 868.5125 823.5125 - 869.1125 824.1125
747 8679250  822.9250 793 868.5250  823.5250 - 869.1250 824.1250
748 8679375  822.9375 794 868.5375  B823.5375 - 869.1375  824.1375
749 867.9500  822.9500 795 868.5500 8235500 - 869.1500 8§24.1500
750 867.9625  822.9625 796 868.5625  823.5625 - 869.1625  824.1625
751 867.9750  822.9750 797 868.5750  823.5750 - 869.1750  824.1750
752 3679875 822.9875 798 868.5875  823.5875 - 869.1875 824.1875
- 868.0000  8§23.0000 799 868.6000 823.6000 - 869.2000  824.2000
753 868.0125 823.0125 800 868.6125 823.6125 - 869.2125  824.2125
- 868.0250  823.0250 801 868.6250  823.6250 - 869.2250  824.2250
754 868.0375  823.0375 802 868.6375 823.6375 - 869.2375  824.2375
755 868.0500  823.0500 803 868.6500  823.6500 - 8692500  824.2500
756 868.0625  823.0625 804 868.6625  823.6625 - 869.2625  824.2625
757 868.0750  823.0750 805 868.6750  823.6750 - 8692750  824.2750
758 868.0875  823.0875 806 868.6875  823.6875 - 869.2875  824.2875
FebsFErmry 1999

4-33

Part No. 001-5300-001




TRANSCEIVER PROGRAMMING

800 MHz Channels
FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx|{ Mobiie Tx
No. Freq. Freq—l No. Freq. Fregq No. Freq Freq

- 869.3000 8§24.3000 - 869.5375  B824.5375 - 869.7750  824.7750
- 8693125  824.3125 - 869.5500  824.5500 - 869.7875  824.7875
- 869.3250 824.3250 - 869.5625  824.5625 - 869.8000  824.8000
- 869.3375 8243375 - 869.5750  824.5750 - 8698125  824.8125
- 869.3500  824.3500 - 869.5875  824.5875 - 869.8250  824.8250
- 869.3625  824.3625 - 869.6000  824.6000 - 869.8375  824.8375
- 869.3750  824.3750 - 869.6125 824.6125 - 869.8500  824.8500
- 869.3875 8243875 - 869.6250 824.6250 - 869.8625  824.8625
- 869.4000  824.4000 - 869.6375  824.6375 - 869.8750 824.8750
- 869.4125 824.4125 - 869.6500  824.6500 - 869.8875  824.8875
- 869.4250 824.4250 - 869.6625  824.6625 - 869.9000 824.9000
- 869.4375  824.4375 - 869.6750  824.6750 - 8699125 8249125
- 869.4500  §24.4500 - 869.6875  824.6875 - 869.9250  8§24.9250
- 869.4625  824.4625 - 869.7000  824,7000 - 8699375  824.9375
- 869.4750 824.4750 - 8697125  824.7125 - 869.9500  824.9500
- 8694875  824.4875 - 869.7250  824.7250 - 869.9625  824.9625
- 869.5000 824.5000 - 869.7375  824.7375 - 8699750  824.9750
- 869.5125  824.5125 - 8697500 824.7500 - 869.9875 RB24.9875
- 869.5250  824.5250 - 869.7625  824,7625

April 1999

Part No. 001-5300-001 4-34




CIRCUIT DESCRIPTION

SECTION 5 CIRCUIT DESCRIPTION

5.1 GENERAL TRANSCEIVER DESRIPTION

5.1.1 INTRODUCTION

The EFJohnson Stealth 25 Digital Radio is a
microcontroller-based radio that uses a Digital Signal
Processor (DSP) to provide the following modes of
operation:

Narrowband Analog - FM modulation with a
maximum deviation of 2.5 kHz. This mode is usually
used in systems where the channel spacing is 12.5
kHz. Call Guard (CTCSS or DCS) subaudible squelch
signaling can be used in this mode.

Wideband Analog - FM modulation with a maximum
deviation of 5 kHz. This mode is usually used in
systems where the channel spacing is 25 kHz or 30
kHz. Call Guard {(CTCSS or DCS) subaudible squelch
signaling can be used in this mode.

Project 25 Digital - The voice is digitized, error
corrected, optionally encrypted and transmitted using
C4FM modulation according to the Project 25 stan-
dard. This mode can be used in channel spacings of
12.5 kHz.

DES/DES-XL - This mode is compatible with the
Motorola DES and DES-XL protocols. Veice is digi-
tized, encrypted, and transmitted using FSK modula-
tion. This mode can be used in channel spacings of

25 kHz. The DSP processes the received signals and
generates the appropriate output signals. The micro-
controller controls the hardware and provides an inter-
face between hardware and DSP.

5.1.2 PC BOARDS

The 5300-series mobile contains the following
PC board assemblies:

RF Board - Contains the receiver, synthesizer, and
exciler sections.

PA Board - Contains the transmitter power amplifier,

power control, and main DC power switching sections.

5-1

Logic Board - Contains the digital signal processing
(DSP), control logic, and audio processing sections.

Interface Board - A small board that provides the
electrical connections between the logic and RF/PA
boards. It also contains the audio amplifier and volume
control circuits for internal and external speakers.

Display Controller - Contains a microcontroller
which provides an interface between the controller on
the logic board and the front panel display and
switches.

Display Board - Contains the liquid crystal display,
option switch keypad, and display drivers. In addition,
it contains the backlight for the display and keypad.

5.1.3 CIRCUIT PROTECTION (FUSES)
Circuit protection is provided as follows:

® A 15-ampere fuse in the power cable provides
overal! transceiver protection.

® A 2-ampere fuse on the RF board protects circuits
on that board.

® F700 (2-ampere) on the display controller board
protects the Sw B+ output of the microphone
connector.

* F1 on the logic board protects the Sw B+ output of
universal interface connector J5.

® The various voltage regulators provide circuit
protection by antomatically limiting current.

5.1.4 ANALOG MODE DESCRIPTION
Receive Mode

The RF signal is routed from the antenna connec-
tor to the RF Board where it is filtered, amplified, and
mixed with the first local oscillator frequency gener-
ated by the synthesizer. The resulting IF signal is also
filtered and amplified and sent to the ABACUS chip.

The signal is then mixed with the second local
oscillator frequency to create a second IF signal of 450
kHz. The second IF signal is then sampled at 14.4
Msps and downconverted to baseband. The baseband
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signal is then decimated to a lower sample rate that is
selectable at 20 kHz. This signal is then routed via a
serial interface using a differential current output to
the ADSIC U3 on the logic board.

On the logic board ADSIC U3 digitally filters the
input signal, performs frequency discrimination to
obtain the message signal, and then routes the message
signal to DSP (Digital Signal Processor) U12. The
DSP first performs a carrier-detection squelch function
on the radio. If a signal is determined to be present, the
audio portion of the signal is resampled to an 8 kHz
rate and then filtered appropriately. The filtered signal
is then routed back to a D/A in the ADSIC to produce
an analog signal for output to the audio power ampli-
fier (PA) and then the speaker. Any detected signaling
information is decoded and the resulting information is
sent to the microcontroller.

Transmit Mode

The signal from the microphone is amplified by
the audio PA and is then routed to ADSIC U3 where it
is first digitized at a 16 ksps rate and then sent to DSP
U12. The DSP performs the required filtering, adds the
desired signaling, converts the sample rate to 48 ksps
and then sends the resulting signal back to a D/A in the
ADSIC to produce the analog modulation signal for
the VCO. The modulated VCO signal is then sent to
the RF PA for amplification.

5.1.5 PROJECT 25 DIGITAL MODE

Introduction

In Project 25 Digital Mode, the carrier is modu-
lated with four discrete deviation levels of + 600 Hz
and + 1800 Hz. Digitized voice is created using an
IMBE™ vocoder.

Receive Mode

The signal is processed in the same way as an
analog mode transmission untit after the squelch func-
tion is performed. If a signal is detected to be present,
DSP U12 resamples the signal from 20 kHz to 24 kHz.
This is done so that the sample rate is an integer
multiple (5x) of the data rate of the digital modulation
which is 4800 symbols/sec (9600 bits/sec).
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The resampled signal is then processed by a
demodulator routine to extract the digital information.
The resulting bit stream (9600 bps) is sent to a routine
that performs unframing, error-correction, and voice
decoding. The result of these operations is a recon-
structed voice signal sampled at 8 kHz. The sampled
voice signal is sent to a D/A in ADSIC U3 to produce
an analog signal for output to the audio power ampli-
fier and speaker.

Transmit Mode

The microphone signal is processed as in the ana-
log mode until it reaches DSP U12. At this point the
audio signal is processed by a voice encoding routine
to digitize the information. The resulting samples are
then converted to a bit stream that is placed into the
proper framing structure and error protected. The
resulting bit stream has a bit rate of 9600 Hz.

This bit stream is then encoded, two bits at a time,
into a digital level corresponding to one of the four
allowable frequency deviations. This produces 16-bit
symbols with a rate of 4800 Hz. The symbols are
resampled to a rate of 48 kHz and filtered to comply
with channel bandwidth requirements. The filtered
signal is then sent to a D/A in ADSIC U3 to produce
the analog modulation signal for the VCO. The modu-
lated VCO signal is then mixed up to the final transmit
frequency and then sent to the RF board power ampli-
fier section.

5.2 RF BOARD

NOTE: The RF Board is not field serviceable. There-
Jore, it must be replaced if it is defective.

5.2.1 RF BOARD OVERVIEW

The receiver front end consists of a preselector,
RF amplifier, second preselector, and mixer (see
Figure 5-1). Both preselectors on the VHF board are
varactor-tuned, two-pole filters controlled by the
microcontroller unit through the D/A IC. The 800
MHz board uses stripline technology for the prese-
lector. The RF amplifier is a dual-gate galltum-
arsenide 1C. The mixer is a double-balanced, trans-
former-coupled active mixer. Injection is provided by
the VCO through an injection filter. See Table 5-1 for
local oscillator (LO) and first IF information.

IMBE™ voice coding technology embodied in this product
is protected by intellectual property rights including patent
rights of Digital Voice Systems, Inc.
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The frequency generation function is performed
by the PLL (Phase-Locked-Loop) consisting of
synthesizer U204 and VCO circuit Q202/U201. Refer-
ence oscillator U203 generates and supplies a refer-
ence signai of 16.8 MHz to synthesizer. The synthe-
sizer contains a programmable reference divider,
programmable A and B dividers, a programmable
prescaler counter (P), and a programmable fractional
N divider with two programmable values (N numer-
ator and N denominator).

All of these dividers are programmed through the
serial interface which connects the synthesizer to the
controller microprocessor. The 16.8 MHz reference
oscillator frequency is divided down to a synthesizer
reference frequency of 2.1, 2.4, or 2.225 MHz. This
signal is fed to the phase detector which generates the
steering voltage for the VCO. The output of the VCO
circuit is coupled back and divided by AP+B and then
divided by the fractional divider and fed into the
second input of the phase detector. The VCO buffer
has two outputs. One input goes to the input of Rx
mixer chip U2, and the other is applied to the input of
power amplifier module U105.

The receiver back end consists of a two-pole
crystal filter, TF amplifier, a second two-pole crystal
filter, and the ABACUS digital back-end IC. The two

Table 5-1 LO and First IF Frequencies

VHF 800 MHz
LO Frequency range| 181.15-219.15  |776.65 - 796.65
MHz MHz
First [F 45.15 MHz 73.35 MHz
Frequency

pole filters are wide enough to accommodate 5 kHz
modulation. Final IF filtering is done digitally in the
ADSIC.

The ABACUS digital back-end chip consists of
an amplifier, second mixer, IF analog-to-digital
converter, a baseband down-converter, and a 2.4 MHz
synthesis circuit to provide a clock to the ADSIC on
the logic board. The second LO is generated by
discrete components external to the ABACUS. The
output of the ABACUS is a digital bit stream that is
current driven on a differential pair to reduce noise
generation.

The transmitter consists of an RF power amplifier
IC that amplifies an injection signal from the VCO.
Transmit power is controlled by two custom [Cs that
monitor the output of a directional coupler and adjust
the power amplifier control voltages correspondingly.
The signal passes through a Rx/Tx switch that uses

Inx MIXER
s DIGITAL
157 ]
AUTX [Rx FIRST SECOND iF quo.'lrz_ | czrwmswi_ _ | Backenp
SWITCH PRESELECTOR PRESELECTOR CRYS ™ cRcuIt
FILTER FILTER MOBULE
[ | [
Tx
DC CONTROL
{VHF AND UHF ONLY) SECOND
INJECTION LOCAL
FILTER OSCILLATOR 2 MHz
VCO CONTROL
¥ ;
RF POWER AMP VCO FEEDBACK
DIAECTIONAL | oy e veor SYNTHESIZER/
%E%fc;’a - BUFFER PROGRAMMABLE BUS CONTROL | “prescaLER
[} 1
16.8MHz
DC CONTROL (VHE AND UHF OHLY) v e
TX CONTROL CONTH REFER
= CIACUT | e oL CIRCUIT a~| OSCILATOR
MODULE MODWLE 16.8MMz
Figure 5-1 RF Board Block Diagram
April 1999

Part No. 001-5300-001




CIRCUIT DESCRIPTION

pin diodes to automatically provide an appropriate
interface to transmit or receive signals.

5.2.2 FREQUENCY GENERATION UNIT

The Frequency Generation Unit (FGU) consists
of these three major sections: (1) high stability refer-
ence oscillator, (2) fractional-N synthesizer, and (3)
VCO buffer. A 5-volt regulator supplies power to the
FGU. The regulator output voltage is filtered and then
distributed to the transmit and receive VCOs and the
VCO buffer IC. The mixer LO injection signal and
transmit frequency are generated by the receive VCO
and transmit VCO, respectively. The receive VCO
uses an external active device, and the transmit VCO
active device is a transistor inside the VCO buffer.

The receive VCO is a Colpitts-type oscillator.
The receive VCO signal is received by the VCO buffer
where it is amplified by a buffer inside the IC. The
amplified signal is routed through a low-pass filter and
injected as the first LO signal into the mixer. In the
VCO buffer, the receive VCO signal is also routed to
an internal prescaler buffer. The buffered ontput is
applied to a low-pass filter. After filtering, the signal is
routed to a prescaler divider in the synthesizer.

The divide ratios for the prescaler circuits are
determined from information stored in an EEPROM.
The microprocessor extracts data for the division ratio
as determined by the position of the channel-select
switch and routes the signal to a comparator in the
synthesizer. A 16.8 MHz reference oscillator applies
the 16.8 MHz signal to the synthesizer. The oscillator
signal is divided into one of three pre-determined
frequencies. A time-based algorithm is used to
generate the fractional-N ratio.

If the two frequencies in the synthesizer’s
comparator differ, an error voltage is produced. The
phase detector error voltage is applied to the loop
filter. The filtered voltage alters the VCO frequency
until the correct frequency is synthesized.

In the transmit mode, the modulation of the car-
rier is achieved by using a two-port modulation tech-
nique. The modulation for low frequency tones, such
as CTCSS and DCS, is achieved by injecting the tones
into the A/D section of the fractional-N divider, gener-
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ating the required deviation. Modulation of the high
frequency audio signals is achieved by modulating the
varactor through a frequency compensation network.

The transmit VCO signal is amplified by an inter-
nal buffer, routed through a low-pass filter, and then
sent to the transmit power amplifier module. The ref-
erence osciliator supplies a 16.8 MHz clock to the syn-
thesizer where it is divided down to a 2.1 MHz clock.
This divided down clock is fed to the ABACUS IC.

5.2.3 ANTENNA SWITCH

A pair of diodes is used to electronically steer the
RF signal between the receiver and transmitter. In
transmit mode, RF is routed through a transmit switch-
ing diode and sent to the antenna. In receive mode, RF
is received from the antenna, routed through a receive
switching diode and applied to the RF amplifier.

5.2.4 RECEIVER FRONT END

The RF signal from the antenna is sent through a
bandpass filter, The bandpass filter is electronically
tuned by the microcontroller via the D/A 1C by
applying a control voltage to the varactor diodes in the
filter. The /A output range is extended through the
use of a current mirror. Wideband operation of the
filter is achieved by retuning the bandpass filter across
the band.

The output of the bandpass filter is applied to a
wideband amplifier. After being amplified by the RF
amplifier, the RF signal is further filtered by a second
broadband, fixed tuned, bandpass filter to improve
spurious rejection.

The filtered RF signal is routed via a broadband
50-ohm transformer to the input of a broadband
mixer/buffer. The mixer uses GaAs FETs in a
double-balanced Gilbert Cell configuration. The RF
signal is mixed with a first LO signal of about —10
dBm supplied by the FGU. Mixing of the RF and the
first LO results in an output signal which is the first IF
frequency according to Figure 5-1. The first IF signal
output is routed through a transformer and impedance
matching components and is then applied to a two-
pole crystal filter. The two-pole crystal filter removes
unwanted mixer products,
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5.2.5 RECEIVER BACK END

The output of the crystal filter is matched to the
input of the IF buffer amplifier transistor. The output
of the IF amplifier is applied to a second crystal filter
through a matching circuit. This filter supplies further
attenuation at the IF sidebands to increase radio
selectivity.

In the ABACUS IC the first IF frequency is
amplified and then downconverted to 450 kHz, the
second IF frequency. At this point, the analog signal is
converted into two digital bit streams via a sigma-delta
A/D converter. The bit streams are then digitally
filtered and mixed down to baseband and filtered
again. The differential output data stream is then sent
to ADSIC U3 on the logic board where it is processed
to produce the recovered audio.

The ABACUS IC on the RF board is electroni-
cally programmable, and the amount of filtering,
which is dependent on the radio channel spacing and
signal type, is controlled by the microcontroller. Addi-
tional filtering, which used to be provided externally
by a conventional ceramic filter, is replaced by
internal digital filters in the ABACUS IC. The
ABACUS IC contains a feedback AGC circuit to
expand the dynamic range of the sigma-delta
converter. The differential output data contains the
quadrature (I and Q) information in 16-bit words, the
AGC informaticn in a 9-bit word, imbedded word
sync information and fill bits dependent on sampling
speed. A fractional-N synthesizer is also incorporated
on the ABACUS IC for 2nd LO generation.

The 2nd LO/VCO is a Colpitts oscillator. The
VCO has a varactor diode to adjust the VCO
frequency. The control signal for the varactor is
derived from a loop filter.

5.2.6 EXCITER

The exciter consists of three major sections:
Harmonic Filter, RF Power Amplifier, and the ALC

(Automatic Level Control) circuit.

The RF signal from the PA module is routed
through a coupler, then through the harmonic filter,
then to the antenna switch. The RF power amplifier
module is a wide-band multi-stage amplifier. The

* A reverse biased pin dicde presents a high impedance to RF signals.
Conversely, and a forward biased pin diode presents an variable low
impedance that changes inversely to current.

nominal input and output impedance of the power
amptlifier is 50 ohms. The DC bias for the RF power
amplifier is controlled by a switching transistor. The
microcontroller uses the D/A IC to produce a ready
signal for the transmit ALC IC. The synthesizer sends
a LOC signal to the transmit ALC 1C. When both the
ready signal and LOC signal are available to the
transmit ALC IC, the switching transistor for the RF
power amplifter is turned on.

A coupler module samples the forward power and
the reverse power of the PA output voltage. Reverse
power is present when there is other than 50-ohm
impedance at the RF output connector. Sampling is
achieved by coupling some of the forward and/or
reverse power for rectification and summing. The
resulting DC voltage is then applied to the transmit
ALC IC as an RF strength indicator.

The transmit ALC circuit is the core of the power
control loop. Circuits in the transmit ALC module
compare the RF strength indicator to a reference value
and generate a bias signal that is applied to the base of
a transistor. This transistor varies the DC control volt-
age applied to the RF PA controlling the RF power.

5.3 VHF PA BOARD
5.3.1 ANTENNA SWITCHES

The RF signal from the RF board is fed by a
coaxial cable to the PA board. Since both the receive
and transmit signals are present on the input of the PA
board, special antenna switching is required on the PA
board to route the receive signal around the amplifier
section to the antenna. Both a high power and a low
power antenna switch are used as shown below.

Anlenna

Low Power High Power
Antenna Switch Antenna Switch
Powar
‘_.O/Q—' Ampiitier
RF Board
o -t &

The low power switch consists of pin diodes*
CR512 and CR513 and other components. The Q7
output of shift registerllJ601 is high in the transmit
mode and fow in the receive mode. Therefore, in the
transmit mode, Q507 and Q514 are on and Q508 and
Q513 are off. This forward biases CR513 and reverse
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VHF PA BOARD DESCRIPTION (CONT'D)

biases CR512. The transmit signal from the RF board
then has a low impedance path through C533 and
CR513 to driver Q509, and the high impedance
provided by CR512 blocks it from the receive path.

In the receive mode, the opposite occurs, so
CR513 is reverse biased and CR512 forward biased.
The receive signat from the high power antenna switch
(see following) then has a low impedance path through
C544, CR512, and C534 to the RF board, and is
blocked from the power amplifier by CR513.

The high power antenna switch consists of pin
diodes* CR501, CR502, and CR503. This switch
effectively switches the antenna between the power
amplifier and the receive bypass path to the RF board
(see preceding illustration).

Transistor 501 is on in the transmit mode and
off in the receive mode. Therefore, in the transmit
mode, all three diodes are forward biased (CR501 and
CR502 are biased by voltage applied from the
collector of Q510). The transmit signal then has a low
impedance path through CR502 to the low-pass filter
and is blocked from the bypass path by L504/C511
and L505/C515 which present a high impedance at the
transmit frequency. In the receive mode, all three
diodes are reverse biased. Therefore, the receive signal
from the antenna is blocked from the power amplifier
by CR502 and has a low impedance path through
L504 and L505 to the RF board.

5.3.2 AMPLIFIERS (Q509, Q510)

Impedance matching between the low power
antenna switch and Q509 is provided by L511 and
several capacitors and sections of microstrip. Class C
biasing is provided by L.510 and ferrite bead EP503,
and negative feedback for stabilization is provided by
R557 and R543. Supply voltage to Q509 is controlled
by the power control circuit to regulate the power
output of the transmitter. Conditioning and isolation of
the DC supply to Q509 is provided by L.509, L514,
EP501, and C540-C542.

impedance matching between Q509 and final
amplifier Q510 is provided by several capacitors and
sections of microstrip. Class C biasing of Q510 is
provided by 1.515, EP502, R559, and R560. The
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current for this stage flows through L516, R561, and
L517. The voltage drop across R561 is sensed by the
power control circuit to detect an over-current
condition.

From Q510 the transmit signal is fed through
another impedance matching network to a directional
coupler, to the high power antenna switch (see
preceding section), and then to the low-pass filter. This
filter attenuates harmonics occurring above the
transmit frequency band to prevent adjacent channel
interference. The directional coupler detects the
forward component of the output power for use by the
power controi circuit.

5.3.3 POWER CONTROL

Introduction

The power control circuit maintains a constant
power output as changes occur in temperature and
voltage. It does this by sensing forward power and
then varying the drive to Q510 to maintain a constant
output power. The drive to Q510 is controlled by
varying the supply voltage to driver Q509. The current
to final amplifier Q510 is also sensed, but power
output is affected by this input only if current becomes
excessive. Power output is then cut back to approxi-
mately 25% of full power.

The power output level is set in 127 steps by D/A
converter U801 which is controlied by the microcon-
troller. This allows power to be adjusted using the
PCTune software and computer and also different
power levels to be programmed. In addition, it allows
the microcontroller to cut back power if the power
amplifier temperature is excessive. Temperature is
sensed via thermistor RT501.

U502A, Q500/0Q502 Operation

The forward power signal from the directional
coupler is applied to pin 2 of amplifier US02A. This is
a DC signal that increases proportionally to forward
power. The other input to U502A is a DC reference
voltage from a D/A converter formed by shift register
U801 and several resistors. The voltage from this /A
converter sets the voltage on pin 3 which sets the
power output of the transmitter.

* A reverse biased pin diode presents a high impedance to RF signals.
Conversely, and a forward biased pin diode presents an variable low
impedance that changes inversely to current.
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VHF PA BOARD DESCRIPTION (CONT’D)

U502A is a difference amplifier which amplifies
the difference between the reference voltage on pin 3
and the forward power signal on pin 2. The tum-on
time of U502A is controlled by the time constant of
C528 and R534, and negative AC feedback to prevent
oscillation is also provided by C528. This circuit oper-
ates as follows: Assume the output power attempts to
increase. The DC voltage applied to US02A, pin 2
then increases which causes the output voltage on pin
1 to decrease. Transistors Q305 and Q506 then turn off
slightly which decreases the supply voltage to driver
Q509. The output power then decreases to maintain a
constant power output. R541 and R542 limit the
voltage gain of Q505 and Q506 to approximately two.

Delayed PTT

Transistor Q504 is used to delay power output for
a short time after the transmitter is keyed. This allows
the synthesizer and exciter to stabilize so that the
transmitter does not transmit off-frequency. The signal
which controls Q504 is from microcontroller U9 on
the logic board. In the receive mode this output is low,
so Q504 is off. Pin 2 of U500A is then pulled high by
the 7.2-volt supply applied through R537 and CR506.
This causes the output on pin 1 of US02A to go low
which shuts off power to Q509. Then when the trans-
mitter is keyed, the Q504 control signal goes high after
a short delay. Q504 then turns on and diode CR506 is
reverse biased. Only the forward power signal is then
applied to pin 2 of U502A.

Over-Current Shutdown

Current to final amplifier Q510 is monitored by
sensing the voltage drop across R561. Pins 3 and 6 of
U506 are connected across this resistor. As current
increases, the output voltage on U506, pin 8 decreases.
This causes the output voltage of voltage follower
U507A to decrease. This signal is applied to Schmitt
trigger US02B. When the voltage on pin 6 rises above
the reference on pin 5, the output on pin 7 goes low.
This lowers the power control voltage applied to
U502A, pin 3 which lowers the power output to
approximately 25% of full power.

800 MHz BOARD DESCRIPTION
5.4 800 MHz PA BOARD
5.4.1 LOW POWER ANTENNA SWITCH

The RF signal from the RF board is fed by a
coaxial cable to the PA board. Since both the receive
and transmit signals are present on the input of the PA
board, special antenna switching is required on the PA
board to route the receive signal around the power
amplifier section to the antenna. Both high power and
a low power antenna switches are used as shown
below.

Antenn

Low Power

Antenna Switch High Power

Antenna Switch
Tx

————— 1 Tx Power

‘_’_L)/OT—. Ampiifier
RF Board

! IRx A I Rx
~J

RF Amplifier
{Rx RF}

Low power antenna switching is provided by
electronic antenna switch U603. Pin 5 is effectively
connected to pin 1 when pin 6 is high (and pin 4 is
low). Conversely, pin 5 is connected to pin 3 when pin
4 is high and pin 6 is low. These control signals are
provided by the Q7 output of shift register U501 and
inverters Q516/Q517. In the transmit mode, the signal
from the RF board is then routed through C532 to the
PA module, and blocked from RF amplifier Q503. In
the receive mode, the opposite occurs. Refer to Section
5.4.4 for a description of the high power antenna
switch.

5.4.2 POWER DETECTOR AND ATTENUATOR

The transmit RF output signal of pin 3 of antenna
switch U603 1s coupled by C595 to a power detector
circuit formed by CR521, R591, and other compo-
nents, When RF power is detected, the voltage on pin
13 of op amp U502 increases. When it rises above the
reference on pin 12, the output on pin 14 goes low and
turns off Q507. The base of Q505 is then no longer
grounded which allows it to be controlled by the
power control circuit. This provides maximum attenu-
ation in the receive mode to minimize the amplifica-
tion of any low level receive signal that may be
present (see following).
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800 MHz PA BOARD DESCRIPTION (CONT’D)

A 3-dB pad formed by R541, R542, and R543
provides attenuation of the RF signal and also a
50-ohm impedance. Matching between U603 and this
pad is provided by C532 and L514. This pad is then
matched by a section of microstrip and L503 to a
limiter and vartable 50-ohm attenuator formed by pin
diodes* C516-C518 and other components. This atten-
uator provides approximately 0-20 dB attention of the
RF signal input to PA module. This controls the power
output of the transceiver.

The limiter section formed by CR516, CR517,
C535 and biasing resistors R580/R581 attenuates high
level input signals that could cause improper operation
of the attenuator. The attenuator circuit is formed by
CR518 and CR519 and centrolled by 3505 and the
rest of the power control circuit {see Section 5.4.6).
Biasing of these diodes is provided by CR520, R597,
R584, R582, R586, and R538 connected to the emitter
of Q505. When Q505 is turned off, CR518 is reverse
biased by the voltage applied through R537. It then
provides maximum attenuation of the RF signal.

A shunt path is provided around CR518 by R583,
C537, and R585. Pin diode CR519 is at its maximum
forward biased condition when Q505 is off, and
connects R583 to AC ground through C538. This
maintains a constant 50-ohm impedance. Then as
Q505 turns on, CR518 becomes forward biased and
provides less attenuation. Likewise, CR519 becomes
less forward biased which increases the impedance of
the path to ground. From the attenuator the signal is
coupled by C542 to a 1 dB, 50-ohm pad formed by
R544-R546 and then applied to PA module U504,

5.4.3 POWER AMPLIFIER MODULE (U504),
FINAL (Q509)

Power amplifier module U504 provides approxi-
mately 19 dB of gain. Pins 2, 3, and 4 are the supply
voltage inputs to three separate gain stages. The
supply voltage on pin 2 (VS1) is switched by Q508
and limited to 12 volts by CR508 and R549. Switch
Q508 is controlled by the same signal used to control
the high power antenna switch (see Section 5.4.4).

The supply voitage applied to pins 3 and 4
(VS2/VS3) is the unswitched battery from the power
jack fed through R550. Therefore, power is applied to
these pins even when transceiver power is turned off.
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The power control circuit senses transmtitter current by
monitoring the voltage drop across R5350 (see Section
5.4.6).

The output signal on U504, pin 5 is then applied
to Q509 (high power models only). With lower power
models, Q509 is not used and is replaced by a jumper
strap. Amplifier Q509 provides approximately 5 dB of
gain. The output impedance on U504, pin 5 is 50
ohms, and it is matched to Q509 by a section of
microstrip, C556, C557, and C558. Class C biasing of
Q509 is provided by L507. The unswitched battery
supply applied to Q509 is isolated from RF by ferrite
bead EP503, L.508, and several capacitors. Impedance
matching is provided on the output by C559, C561,
562, C566, and a section of microstrip.

5.4.4 HIGH POWER ANTENNA SWITCH

The high power antenna switch consists of pin
diodes* CR501, CR502, CR503, and other compo-
nents. This switch effectively switches the antenna to
the power amplifier in the transmit mode, and the
receive RF amplifier path in the receive mode (sce
preceding tllustration).

Transistors Q506 and Q501 controtled by the Q7
output of shift register U501 after it is double inverted
by Q516 and Q517. This signal is high in the transmit
mode and low in the receive mode. Therefore, Q506
and Q501 are on in the transmit mode which forward
biases CR501, CR502, and CR503. One current path is
through Q501, R503, R504, CR501, L508, CR502,
and 1.508, and the other is through Q506, R559,
CR503, and R560.

Since a forward biased pin diode has a low
impedance, the RF signal passes through CR502 to the
low-pass filter. The signal is blocked from the RF
amplifier by two discrete grounded quarter-wave lines.
One line is formed by L508/C507 and the other by
L502/C514. Diode CR501 is effectively AC grounded
by €507, and CR503 is AC grounded by C514. When
one end of a quarter-wave line ts grounded, the other
end presents a high impedance to the quarter-wave
frequency.

In the receive mode, all three diodes are reverse
biased. Therefore, the receive signal from the antenna
is blocked from the power amplifier by CR502 and has

* A reverse biased pin diode presents a high impedance to RF signals.
Conversely, and a forward biased pin diode presents an variable low
impedance that changes inversely to current.
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800 MHz PA BOARD DESCRIPTION (CONT’D)

a low impedance path through the quarter-wave lines
which are no longer grounded. Resistors R505 and
R506 improve the isolation provided by CR501 and
CR502 when they are reverse biased in the receive
mode.

5.4.5 DIRECTIONAL COUPLER,
LOW-PASS FILTER, TEMP SENSE

A directional coupler is formed by adjacent sec-
tions of microstrip near C566. The forward component
of output power is rectified by CR509 and developed
across R557 and then fed to the power control circuit.
Reverse power is not detected in this transceiver.

From the directional coupler the transmit RF
signal is coupled by C511 to a low-pass harmonic
fitter formed by C501-C505 and several sections of
microstrip. This filter attenuates harmonic frequencies
occurring above the transmit band. Resistor R501
dissipates static buildup on the antenna.

The ambient power amplifier temperature is
sensed by thermistor RT501. The resistance of a ther-
mistor decreases as temperature increases. The ther-
mistor forms a voltage divider with R147 on the
audio/logic board, and the voltage across this divider
is monitored by A/D converter U21. If the PA temper-
ature increases above limits set in software, the power
is first cut back. Then if it continues to rise, the trans-
mitter is turned off.

5.4.6 POWER CONTROL
Introduction

The power control circuit maintains a constant
power output as changes occur in temperature and
voltage. It does this by sensing the forward power and
then varying the drive to Q505 to maintain a constant
output power (see Section 5.4.2). Although current to
PA module U504 is also sensed, power output is
affected by this input only if current becomes exces-
sive. Power output is then cut back to approximately
25% of full power.

The power output level is set in 127 steps by D/A
converter U501 which is controlled by the microcon-

troller. This allows power to be adjusted using the
PCTune software and computer and also different
power levels to be programmed. In addition, it allows
the microcontroller to cut back power if the power
amplifier temperature is excessive. Temperature is
sensed via thermistor RT501 (see Section 5.4.5).

U502A QOperation

The forward power signal from the directional
coupler is applied to pin 2 of amplifier US02A. This is
a DC signal that increases proportionally to forward
power. The other input to U502A is a DC reference
voltage from a D/A converter formed by shift register
U501 and several resistors. The voltage from this D/A
converter sets the voltage on pin 3 which sets the
power output of the transmitter.

U502A is a difference amplifier which amplifies
the difference between the reference voltage on pin 3
and the forward power signal on pin 2. The turn-on
time of US02A is controlled by the time constant of
C525 and R527. This circuit operates as follows:
Assume the output power attempts to increase. The
DC voltage applied to U502A, pin 2 then increases
which causes the output voltage on pin 1 to decrease.
Transistor Q505 then turns off slightly which increases
the attenuation provided by the attenuation circuit (see
Section 5.4.2). The output power then decreases to
maintain a constant power output.

Delayed PTT

Transistor Q504 is used to delay power output for
a short time after the transmitter is keyed. This allows
the synthesizer and exciter to stabilize so that the
transmitter does not transmit off-frequency. The signal
which controls Q504 is from pin 14 of micro-
controller U9 on the logic board. In the receive mode
this output is low, so Q504 is off. Pin 2 of US00A is
then pulled high by the 7.2-volt supply applied
through R530 and CR505. This causes the output on
pin 1 of USO2A to go low which shuts off Q505 and
produces maximum attenuation. Then when the trans-
mitter is keyed, the Q504 control signal goes high after
a short delay. Q504 then turns on and diode CR505 is
reverse biased. Only the forward power signal is then
applied to pin 2 of US02A.
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Over-Current Shutdown

Current to the first two amplifier stages of PA
module U504 is monitored by sensing the voltage drop
across R550. Pins 3 and 6 of U505 are connected
across this resistor. As current increases, the output
voltage on U505, pin 8 decreases. This causes the
output voltage of voltage follower U502 to decrease.
This signal is applied to Schmitt trigger US02B. When
the voltage on pin 6 rises above the reference on pin 5,
the output on pin 7 goes low. This lowers the power
control voltage applied to U505 which lowers the
power output to approximately 25% of full power.

5.4.7 RF AMPLIFIER (Q503)

The receive signal from the antenna switch is
applied to bandpass filter Z501. This is a three-pole
filter with a center frequency of 860 MHz and a band-
width of 18 MHz. This filter attenuates frequencies
outside the receive band such as the first injection,
image, and half IF frequencies.

The signal is then applied to RF amplifier Q503
which improves and stabilizes receiver sensitivity and
also recovers filter losses. A section of microstrip and
C515 provide impedance matching on the input.
CR504 protects the base-emitter junction of Q503
from damage caused by high level input signals.

The bias current of Q503 is fixed at a constant
level by Q502. The collector current of Q503 flows
through R511, and the voltage drop across that resistor
(and therefore the current) is set by R508 and R509.
For example, if current through R2511 attempts to
increase, the emitter voltage of Q502 decreases. Q502
then conducts less and turns Q503 off slightly to main-
tain a constant bias current. This provides a stable bias
over changes in temperature. The output signal of
Q503 is apptied to a 3 dB, 50-ohm pad formed by
R587-R589, and then coupled by C531 to antenna
switch U603. From U603 it is applied to the RF board.

5.5 DC POWER DISTRIBUTION
5.5.1 POWER ON OPERATION
When the On-Off/Volume knob is pressed 1o turn

power on (this is a push on/push off switch), the
following sequence of events occurs:
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1. The power switch closes and grounds the emitter of
Q8 on the logic board.

2. Ifignition switch sense is used, the 13V signal from
the ignition switch is applied to the base of Q8 and
pin 48 of microcontrolter U9. If ignition sense is not
used, pull-up resistor R145 is installed.

3. Q8 then turns on which grounds the base of Q512 on
the PA board and turns it on. This turns on main
power switching transistor Q511 and applies power
to the switched portions of the transceiver.

5.5.2 POWER OFF OPERATION

When power is turned off, the following sequence
of events occur:

1. If the power switch is pressed, it opens and the base
of Q8 is no longer grounded. This also applies a high
signal to pin 45 of microcontroller U9 which then
detects the power-off condition.

2. If ignition switch control of power is used, turning
the ignition switch off causes the signal applied to
the base of Q8 to go low. This signal is also inverted
by Q5 and applied to pin 48 of microcontroller U9.

3. Q8 then turns off. However, when the controller
detects the power-down request, it holds Q2 on to
delay power turn-off until all the required save oper-
ations are complete.

4. The controller then tumns off Q2 and both Q511 and
Q512 on the PA board turn off which turns off trans-
ceiver power.

5.6 LOGIC BOARD
5.6.1 LOGIC BOARD OVERVIEW

The Logic Board contains ADSIC U3, Digital
Signal Processor U12 (TMS320C50), static RAM
U5/U6, FLASH memory U2, and a programmable
logic IC U1. In addition, it contains microcontroller
U9, audio circuits, and a 5V power supply. The logic
board connects with the interface board via J9 and the
display controiler board via J1.
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The ADSIC performs the frequency discrimina-
tion and receiver filtering functions. It also performs
analog-to-digital (A/D) and digital-to-analog (D/A)
conversion. Functions previously performed in hard-
ware like filtering and limiting are performed by soft-
ware running in the DSP chip. The DSP performs
demodulation and modulation, voice encoding and
decoding, audio filtering, and squelch signaling. The
software for the radio is stored in FLASH memory that
is loaded in to static RAM at turn-on. The programma-
ble logic IC controls which device (Flash, SRAM, or
UART) is connected to the DSP address and data bus.

5.6.2 DIGITAL SIGNAL PROCESSING
OVERVIEW

The DSP section consists of a DSP chip (U12),
the ADSIC (U3), two 128K x 8-bit Static RAM chips
(U5, U6), one 512K x 16-bit FLASH ROM memory
chip (U2), a UART chip (U20), a programmable logic
IC (U1), and a glue-logic chip (U4). The FLASH
ROM contains the program code executed by the DSP.
Depending on the operational mode selected for the
radio, different sections of the program code in the
FLASH ROM are copied into SRAM for faster

execution.

The ADSIC is a support chip for the DSP. It
provides the interface between the DSP and the analog
signal paths, and between the DSP and the ABACUS
chip on the RF Board. Configuration of the ADSIC is
handled primarily by the microcontroller. The DSP
has access to a few memory-mapped registers on the
ADSIC.

In receive mode, the ADSIC interfaces the DSP
with the ABACUS IC on the RF board. The ADSIC
collects the 1 and Q samples from the ABACUS and
performs channel filtering and frequency discrimina-
tion on the signals. The resulting demodulated signal
is routed to the DSP via the serial port for further
processing. After the DSP processing, the signal is
sent to the ADSIC Speaker D/A by writing to a
memory- mapped register. The ADSIC then converts
the processed signal from the DSP to an analog signal
and then outputs this signal to the speaker power
amplifier on the interface board.

In transmit mode the ADSIC Microphone A/D
digitizes the analog signal from the microphone. The

DSP reads these values from a memory-mapped
register in the ADSIC. After processing, the DSP
sends the modulation signal to the ADSIC via the
serial port. In the ADSIC, the VCO I)/A converts the
sampled modulation signal into an analog signal and
then routes this signal to the VCO on the RF board.

5.6.3 RECEIVE SIGNAL PATH

The ABACUS IC on the RF board provides a
digital back end for the receiver section. It provides a
digital output of I (in phase) and Q (quadrature)
samples which represent the IF signal at the receiver
back end. These samples are routed to the ADSIC
where the signal is filtered and frequency discrimi-
nated to recover the modulating signal.

The recovered signal is sent to the DSP chip for
processing. The ADSIC interface to the ABACUS is
comprised of four signals SBI, DIN, DIN*, and ODC.
The ODC signal is a clock the ABACUS provides to
the ADSIC. Most internal ADSIC functions are
clocked by this ODC signal at a rate of 2.4 MHz and
are available as soon as the power is supplied to the
circuitry. This signal initialty may be 2.4 or 4.8 MHz
after power-up. It is programmed by the ADSIC
through the SBI signal to 2.4 MHz when the ADSIC is
initialized by the microcontroller through the SPI bus.
For any functionality of the ADSIC to exist, including
initial programming, the reference clock must be
present.

SBI is a programming data line for the ABACUS.
This line is used to configure the operation of the
ABACUS and is driven by the ADSIC. The microcon-
troller programs many of the ADSIC operational
features through the SPI interface. There are 36
configuration registers in the ADSIC of which 4
contain configuration data for the ABACUS. When
these particular registers are programmed by the
microcontroller, the ADSIC in turn sends this data to
the ABACUS through the SBIL.

DIN and DIN* are the data lines in which the |
and Q data words are transferred from the ABACUS.
These signals make up a differentially encoded current
loop. Instead of sending TTL-type voltage signals, the
data is transferred by flowing current one way or the
other through the loop. This helps reduce internally
generated spurious emissions on the RF board. The
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ADSIC contains an internal current loop decoder
which translates these signals back to TTL logic and
stores the data in internal registers.

The ADSIC performs digital IF filtering and
frequency discrimination on the signal, sending the
baseband demodulated signal to the DSP. The internal
digital IF filter is programmable with up to 24 taps.
These taps are programmed by the microcontroller
through the SP1 interface.

The DSP processes this data through the SSI
serial port. This is a six-port synchronous serial bus.
The ADSIC transfers the data to the DSP on the TxD
line at a rate of 2.4 MHz. This is clocked synchro-
nously by the ADSIC which provides a 2.4 MHz clock
on SCKT. In addition, a 20 kHz interrupt is provided
on TFS to signal the arrival of a data packet. This
means a new I and Q sample data packet is available to
the DSP at a 20 kHz rate which represents the
sampling rate of the received data. The DSP then
processes this data to extract audio, signaling, and
other information based on the 20 kHz interrupt.

In addition to the SPI programming bus, the
ADSIC also contains a paraliel configuration bus. This
bus is used to access registers mapped into the DSP
memory. Some of these registers are used for addi-
tional ADSIC configuration controlled directly by the
DSP. Some of the registers are data registers for the
speaker D/A. Analog speaker audio is processed
through this parallel bus where the DSP outputs the
speaker audio digital data words to this speaker D/A.
In addition, an analog waveform is generated which is
output to SDO (Speaker Data Out).

In conjunction with speaker D/A, ADSIC
contains a programmable attenuator to set the rough
signal attenuation. However, the fine levels and differ-
ences between signal types are adjusted through the
DSP software algorithms. The speaker D/A attenuator
setting is programmed by the microcontroller through
the SPI bus.

The ADSIC provides an 8 kHz interrupt to the
DSP on IRQB for processing the speaker data
samples. This 8 kHz signal must be enabled through
the SPI programming bus by the microcontroller and is
necessary for any audio processing to occur.
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5.6.4 TRANSMIT SIGNAL PATH

The ADSIC contains an analog-to-digital (ADC)
converter for the microphone. The microphone path in
the ADSIC also includes an attenuator that is
programmed by the microcontroller through the SPI
bus. The microphone input in the ADSIC is on pin
MAI (U3-19). The microphone ADC converts the
analog signal to a series of data words and stores them
in internal registers. The DSP accesses this data
through the parallel data bus. As with the speaker data
samples, the DSP reads the microphone samples from
registers mapped into its memory space. The ADSIC
provides an 8 kHz interrupt to the DSP on IRQB for
processing the microphone data samples.

The DSP processes these microphone samples
and generates and mixes the appropriate signaling and
filters the resultant data. This data is then transferred
to the ADSIC on the DSP SSI port. The ADSIC gener-
ates a 48 kHz interrupt so that a new sample data
packet is transferred at a 48 kHz rate and sets the
transmit data sampling rate at 48 ksps. These samples
are then input to a transmit D/A which converts the
data to an analog waveform. This waveform is the
modulation signal from the ADSIC and is connected to
the VCO on the RF Board.

5.6.5 DSP CHIP (U12)

DSP chip U12 has a 16-bit data bus and a 16-bit
address bus. It has 10K words of internal SRAM from
which 0.5K are used only to store data and 9.5K are
used either for data or for program storage. The DSP
bus can access through its buses the following external
devices:

SRAM U5 and U6 - These two chips are 128K x 8
chips. US stores the lower byte of the word while U6
stores the higher byte. Those chips are selected by
asserting CE2 high and CE1* low. The programmable
logic IC is responsible for controliing the select lines

of these ICs.

FLASH ROM U2 - This chip is 512K x 16 words in
size. It is selected by asserting CE* low. The program-
mable logic IC is responsible for controlling the select
line of this IC.
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ADSIC U3 - The ADSIC contains several registers
which can be read from or written to by the DSP. The
ADSIC IC has an output which drives a data/address
bus enable signal for the programmable logic IC.

UART U7 - This chip converts data from the DSP into
serial data. It is used to interface with the optional
encryption board.

Programmable Logic U1 - This IC arbitrates access
to the DSP’s address/data bus between the flash (U2),
SRAMs (U5,U6), and UART (U7). The DSP can
modify the memory configuration by writing to a
series of registers in the programmable logic IC. In
order to reduce power consumption, the programmable
logic IC can be *disconnected’ from the DSP’s
address/data bus using the bus enable input on the
programmabie logic IC (pin 44).

The DSP uses memory as data space, program
space, and 1/O space as follows. Refer to Figure 5-2
for more information.

Program Space - Internal SRAM, external SRAM,
and FLASH memory,

Data Space - Internal SRAM and external SRAM.

1/0 Space - Programmable logic IC, ADSIC, and the
UART.

The DSP accesses the difference spaces by
setting the corresponding lines PS*, DS*, [S* low.
Only one of these three signals can be low at a given
time. When the DSP accesses internal SRAM, none of
these lines is activated.

The programmable logic IC (PLD) acts as the pri-
mary arbitrator of the DSP’s memory map. The
FLASH ROM and the SRAM are both mapped in the
program space and cannot both be active at the same
time. The DSP may control which type of memory is
mapped in program space by enabling the programma-
ble logic 1C (PLD), then manipulating a register in the
PLD. In addition, the DSP can manipulate other regis-
ters to control paging of both the Flash and the SRAM.
Paging refers to the swapping of 64K word blocks of
Flash or SRAM into or out of the DSP’s memory map.

FLASH ROM U2 is used to permanently store
the program to be executed in the DSP. However, it 1s

slow to access, so to fully utilize the speed of the DSP,
the program stored in the FLASH ROM must be
copied into the SRAM. As the size of the SRAM is
half the size of the FLASH ROM, only the code
required for the current mode of operation is copied in
the SRAM. As previously mentioned, the FLASH
ROM and the SRAM cannot be active at the same
time. Therefore, the internal data memory is used as a
temporary buffer to transfer the program from the
FLASH ROM to the SRAM.

The following hardware interrupts are used on the
DSP:

Interrupt Description

INTI* 8 kHz interrupt for speaker DAC and micro-
phone ADC from ADSIC

INTZ* 125 kHz signal from ADSIC

INT3* 2 kHz timer interrupt from the Controller on
the Keypad Board.

INT4* Interrupt from the UART

NMI* Not used

Connector J3 allows connection to an emulator
for debugging purposes. The emulator connects to
some dedicated pins on the DSP.

5.6.6 UART (U20)

UART U20 performs parallel to serial and serial
to parallel conversion. The serial format used is a 9-bit
format with start and stop bits. The serial transmission
speed is 19200 bps. The UART appears as eight regis-
ters visible in the 1/O space of the DSP starting at
every multiple of 0008h from 0000h to 07FFh, Ul
performs the address decoding by selecting the UART
(pin 39} when both IS* and A15 are low. Crystal Y2
along with the internal oscillator of the UART
provides the clock required to generate the correct bit
rate on the serial output of the UART.

When the UART receives a new serial word or is
ready to accept a new word to send from the DSP, it
generates an interrupt on INTRN. This pin is
connected to one of the hardware interrupt lines on the
DSP. The DSP responds by reading the status register
in the UART and by answering accordingly.
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5.6.7 ADSIC

The ADSIC is a complex custom 1C which
performs many analog-to-digital, digital-to-analog,
and purely digital functions as previously described.
The ADSIC has four internal registers accessible by
the DSP. They are selected through the use of address
lines A15, Al14, A13, A2, Al, A0, IS* (IS* needs to be
inverted with U4 to be compatible with the logic level
required by the ADSIC), RD*, and WR*. Two of these
registers are read-only while the two others are
write-only. Therefore, they can be accessed as two
locations in the 1/0 spaces. Due to the decoding
performed, those locations appear at the following
addresses: Fxx0h, Fxx1h, Fxx8h, Fxx%h, Exx0h,
Exx1h, Exx8h, and Exx%h.

Crystal Y1 along with the internal oscillator in
the ADSIC provide a 20 MHz clock. This clock signal
is used internally by the ADSIC and is also multiplied
by two to provide a 40 MHz clock to the DSP. The
frequency of the clock can be electronically shifted a
small amount by controlling varicap D1 through the
OSCW pin (U3-97). This removes interference created
on some channels by the clock.

The ADSIC and DSP exchange the sampled
receive data and the sampled VCO modulation signal
through a serial port. This serial port consists of pins
SCKR*, RFS, RxD, TxD, SCKT, and TFS on the
ADSIC. U21 and U1 modify the relative phase of TxD
and TFS to be compatible with the timing required on
the serial port of the DSP.

SDO is the output of the internal speaker DAC.
MAI is the input of the internal microphone attenuator
and is followed by the microphone ADC.

The ADSIC is configured partially by the DSP
through its data and address bus (see preceding).
However, most of the configuring is provided through
an SPI compatible serial bus. This SPI serial bus
consists of pins SEL*, SPD, and SCLK. The other side
of this bus is connected to microcontroller U9,

5.6.8 MICROCONTROLLER U9 OVERVIEW

The microcontroiler provides an interface
between the hardware and DSP U12. When the user
presses or rotates a control such as the Select switch,
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an option button, or the PTT switch, the microcon-
troller signals the change to the DSP. Conversely,
when the DSP needs to change the display or an LED,
it signals the microcontroller which then performs the
action. The microcontroller also controls peripheral
ICs such as the synthesizer, reference oscillator,
display processor, and ADSIC.

The microcontroller uses a serial bus to commu-
nicate with the DSP and another RS-485 bus to com-
municate with the front panel/remote control unit. The
RS-485 bus is used for external communication with a
computer running the programming or tuning soft-
ware. Finally, the microcontroller maintains certain
operating parameters in the associated EEPROM
which is controlled via a two-wire serial bus.

5.6.9 MICROCONTROLLER DESCRIPTION

Microcontroller U9 is a Motorola 68HC08XL36
chip. It includes 28K bytes of internal ROM memory
and 1K byte of internal SRAM. It does not have an
external bus and therefore cannot access any external
program memory.

The clock to the microcontroller is provided by
Y3 and an internal oscitlator. The frequency of the
clock can be slightly offset by polarizing the base of
Q1 through software control. This prevents RF inter-
ference on some channels caused by the clock.

The microcontroller contains an SPI-compatible
synchronous serial bus. This bus consists of pins
MISO (U1-53), MOSI (U1-52), SPSCK (U1-50), and
a chip enable for each device with which it communi-
cates. The devices which communicate with the
microcontroller through this bus are as follows:

PA temperature sense ADC U21
ADSIC chip U3

Reference Oscillator (RF Board)
Front-End DAC (RF Board)
Synthesizer chip (RF Board)
Shift register U801 (PA board)
Optional DES board

The microcontroller communicates with the DSP
chip through a custom serial bus. This serial port
includes pins PTA3 (U9-8), PTA4 (U9-9), PTAS
(U9-10), PTA6 (U9-11), and PTA7 (U9-12).
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Program Space

Internal Map ps_map = 1

On-chip ROM (MP/MC = 0}
extamnat (MPMC = 1)

$7FF

3300

On-chip SRAM (RAM = 1)
extomal (RAM = 0)

$2BFF

$2C00

External SRAM
{pages 0 and 1)

axternal

SFBFF

SFECO

On-Chip SRAM (CNF=1)
extamal (CNF=0} |

Data Space

Internal Map External Map

mmregs
$5F

$60
On-Chip SRAM
$7F

$80
reserved

$FF

On-Chip SRAM (CNF=0)
$2FF External SRAM

$300
On-Chip SRAM (pages Oand 1)
$4FF Note: same sram in data

$500 space is also mapped to
reserved program space:

§7FF

5800

On-Chip SRAM (OVLY = 1)
external (OVLY = 0}

$2BFF

$2C00

extenal

External Flash
(pages 0-7)

I/O Space

UART control/status regs

SOFFF

$1000

unused

$7FEF

$68000
flash page reg (riw}
SAFFF

$9000
mem control rag (riw)
SBFFF

$AODO
i2c interface reg {riw)

SAFFF

$BOOO
unused

SDFFF

SEOOC
ADSIC ragisters (riw)

Figure 5-2 Memory Utilization
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The microcontroller SCI asynchronous serial bus
is converted to an RS-485 bus by U14. The R5-485
bus is then used for communication with the front
panel/remote control unit controller and the external
computer running the programming or tuning soft-
ware. The SCI bus consists of RxD (U9-42) and TxD
{U9-43). The RS-485 driver (U14) converts U9 signals
at a logic level of 0 and 5 V to three-state RS-485
logic levels.

Serial EEPROM U 10 is used to store some
important radio parameters. The EEPROM is read to
or written from using I/O lines PTC6 and PTC7 of the
microcontroller. PTC6 is the data line, and PTC7 is the
clock line.

5.6.10 RECEIVE AUDIO CIRCUIT

In receive mode, the analog receive waveform
created by the ADSIC is fed to summing amplifier
U19A. This amplifier sums this signal with the audio
tones generated by the microcontroller on pin 46. The
output of the summing amplifier is then fed to buffer
amplifiers U19B and U18B, and to U17A/U17B
which provide a differential output.

The output signal from U19B is fed to volume
control 1C U4 on the interface board and then to audio
amplifier U1l. The output signal from U18B provides
the External PA output to the accessory cable, and the
output signal from U17A/U17B is fed to the display
controller board. It is then converted back to a single-
ended signal and fed to the Rx Audio pin of the front
panel microphone jack. If a remote control unit is
used, the U17A/U17B output signal is also routed to
the audio amplifier in the remote control unit.
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5.6.11 TRANSMIT AUDIO CIRCUIT

In transmit mode, the audio for transmission can
be selected from the microphone connected to the
front panel microphone jack or the microphone
connected to a remote control unit. U15A and U15B
convert a differential input to a single-ended output,
and analog switch U18A selects the desired micro-
phone signal.

The microphone signal is then buffered by U15C
and fed to analog switch UJ18B and to the microphone
output pin of the universal interface connector. U18B
which selects gither the microphone or universal inter-
face microphone input signal. Additional buffering is
provided by U15D and the signal is then fed to the
A/D input of the ADSIC.

5.6.12 VOLTAGE REGULATION

The 5-volt supply is produced by switching
DC-DC converter Ul1. This device is powered by the
switched 7.2V supply, and the switching frequency is
approximately 160 kHz. A switching regulator
provides improved efficiency compared to a standard
lingar regulator. The 5-volt supply power provides a
large percentage of the total power consumed by the
radio. The peak-to-peak residual ripple on the 5-volt
supply is approximately 50 mV.

The DC-DC converter has a soft-start feature
(R27, C141) to prevent chattering of the output regu-
lated voltage due to “bouncing” of the on/off switch.
The converter has current limiting that limits cutput
current to 1.5 A. The under voltage protection turns
the converter off if the input (switched B+) voltage
drops below 545 V.
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SECTION 6 ALIGNMENT PROCEDURE

Remote Programming Interface (RP¥)
Part No. #23-5300-000

Cable Assembly
Part No. 023-9750-005

o -]
Communication an LA

Monitor
o o 0O 0O o E
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0000:0000

3 10 Battery
-z
23 o o

Figure 6-1 Alignment Setup

6.1 GENERAL
6.1.1 INTRODUCTION

The following alignment procedure should be
performed if repairs are made that could affect the
factory alignment or if adjustments may have changed
for some other reason.

To perform transceiver alignment, a PC-compat-
ible computer, Remote Programming Interface (RPI)
Part No. 023-5300-000, and PCTune software are
required (see Table 1-1). Earlier RPis, such as Part
No. 023-9800-000 or 023-9750-000, cannot be used.
Refer to Section 4.1.4 for more RPI information. The
programming setup is shown in Figure 6-1.

All adjustments are set digitally using the
computer. Therefore, there is no need to disassemble
the transceiver to access adjustment points. In addi-
tion, audio test signals are generated internatly, so an
audio generator is not required. The required test
equipment is shown in Figure 6-1.

6-1

6.1.2 TUNE SOFTWARE
General

The PCTune software is a Windows® program.
Minimum software and hardware requirements are as
follows:

Windows® 95 or 3.1

386SX or faster microprocessor

4 megabytes of RAM

3 megabytes free space available on hard drive.

An available serial port

Software Installation

Proceed as foliows to install this software:

1. Close all applications that are currently running
{other than Windows).

2. Insert the disk containing the PCTune software in
drive A: (or B:).
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3. From the Windows 95 taskbar, choose RUN and
open SETUP.EXE on drive A: (or B:). Alterna-
tively, use File Explorer and double click
SETUP.EXE.

From the Windows 3.1 Program Manager, choose
FILE > RUN and select the SETUP.EXE file on
drive A; (or B:).

4. Follow the instructions on the screen. The program
is automatically loaded on the hard drive and

start-up shortcuts or groups are created.

Starting PCTune

From Windows 95 - Select Start in the taskbar, then
Programs > PCTune > PCTune.

From Windows 3.1 - From the Program Manager,
open the PCTune group and then double click the
PCTune icon.

Exiting PCTune

Select FILE > EXIT or press ALT + F4.

On-Line Help

On-line help is not available at this time.

6.1.3 PRELIMINARY

1. With transceiver power turned off, connect the RP1
to an unused serial port of the computer using a suit-
able cable (see Section 4.1.4).

2. Connect the RPI to the microphone jack of the
computer using cable Part No. 023-9750-005.

3. If the receiver squelch adjustment will be made,
connect the SINAD meter to the Speaker Audio Out
jack on the RPI (see Section 6-2). This is a 2.6 mm
(3/32”) phone jack.

4. Start the program as described in the preceding
section. Select Options > Set Com Port and make
sure that the correct serial port is selected (see
screen in Figure 6-3).
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Figure 6-2 RPI Front Panel

5. Turn transceiver power on and make sure that the
monitor mode is not selected by the Monitor option
switch (the monitor mode is indicated by MON in
the display). The power indicator on the RPI should
be green. If not, check the cabling and the fuse in the
transceiver.

6. On the opening screen select “Mobile Radio” as the
radio type. Then on the main screen, select
Tuning > Complete Tuning to automatically step
through a complete alignment or Partial Tuning to
adjust only certain settings or randomly select
adjustments.

7. The computer then attempts to establish communi-
cation with the transceiver. A message is displayed
to indicate success or failure. From this point,
prompts are displayed for each step of the program-
ming procedure.

6.2 TRANSMIT FREQUENCY TUNING

The transmit frequency is set by transmitting on
the indicated frequency and then adjusting the refer-
ence oscillator frequency via the tuning software.
Proceed as follows:

1. Connect a 50-ohm load to the antenna jack and
monitor the transmit signal with a communication
monitor.

2. Set the communication monitor to the indicated
frequency and click OK to key the transmiftter.

3. Adjust the frequency by clicking the + and — keys.
The current setting is indicated in the “Current
Value” box. When the frequency is correct, click
OK again to complete the adjustment and store the
setting.
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Figure 6-3 Tuning Software Screen (800 MHz Models)

6.3 TRANSMIT MODULATION TUNING

Transmit modulation is set by balancing the
modulation produced by 80 Hz and 3 kHz tones and
then setting modulation limiting using a | kHz tone.
All these tones are internally generated by the trans-
ceiver, so no external audio generator is required.
Proceed as follows:

1. Click OK with “TX Modulation” selected. Set the
cominunication monitor for the displayed
frequency.

Click OK to transmit a signal modulated with an 80
Hz tone. Enter the resulting deviation (in hertz) in
the displayed box and click OK.

3. Continue following the screen tnstructions to adjust
the 3 kHz tone deviation. The + and — buttons are
clicked to set the deviation to the indicated level.
The 1 kHz tone deviation ts then adjusted.

4. The preceding 3 kHz and 1 kHz tone adjustments
are then repeated on several other frequencies across
the band. After the last adjustment is made, the
transmitter unkeys and the settings are stored.

6.4 TRANSMIT POWER ADJUSTMENT
Set transmitter power output as follows:

|. Connect a wattmeter and 50-ohm load to the
antenna jack. Click OK with “TX Power” selected.

2. Follow on-screen instructions to adjust for the
displayed power output at various frequencies
across the band.

3. When the last setting is complete, the transmitter
unkeys and the settings are stored.

6.5 RECEIVE SENSITIVITY TUNING

NOTE: This adjustment is not performed with 800
MHz models.

The receiver front end is tuned as follows:

1. Connect an RF signal generator to the antenna jack.
Click OK with “RX Sensitivity” selected.

Inject the frequencies and signal levels indicated on
the computer screen. When tuning is complete, a
message is displayed and the settings are saved.
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6.6 SQUELCH ADJUSTMENT

Adjust the squelch level as follows:

1. Connect a SINAD meter to the Speaker Audio
Output jack of the RPI (see Figure 6-2).

2. Connect an RF signal generator to the antenna jack.
Click OK with “Squelch” selected.

3. Set the signal generator for the indicated frequency
and modulation. Adjust the generator output level
for 12 dB SINAD and click OK.

4. When prompted, adjust the output level for 8 dB
SINAD and click OK.

5. Proceed as prompted and when this adjustment is
complete, a message is displayed and the settings
are stored.
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6.7 RSSI ADJUSTMENT

This adjustment calibrates the RSSI signal level.
Proceed as follows:

1. Connect an RF signal to the antenna jack. Click OK
with “RSSI” selected.

2. Set the generator for the indicated frequency and
output level and click OK.

3. Select the other output levels as prompted. When
this adjustment is complete, a message is displayed
the settings are stored.
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SECTION 7 PARTS LIST

Chassis, Hardware, Misc.

Interface Board

[Ref No. Description Part No. [Ref No. Description Part No.
HW 150|Screw, 4-40 x 5/16 phil pan hd 575-0604-010
CHASSIS, HARDWARE, AND HW202|Screw, 4-40 x 1-1/8 mach pan hd |575-1604-036
MISCELLANEOUS R e M e
A 000 |DC power cable assembly, 22 ft|023-9750-010 crew, s x S pan Bt
(see separate listing on page 7-15)
A 000 |Accessory wire hamess kit (extrnb)|023-9750-011|  |! 902 |RF —PA board connector 315-9006-110
(see separate listing on page 7-16) 1200 |Connector, 28-pin inline header  |515-7181-038
A 000 |Mounting bracket, standard 023-9750-012
(see separate listing on page 7-16) MP 002|Cover, top black RS-5300 015-0970-007
A 102 |Front panel assembly 023-5300-710 MP 003 |Cover, bottom black 015-0905-031
(see separate listing on page 7-13) MP 156(Gasket, top cover 032-0792-060
A 200 |Interface board assembly 023-5300-201 MP 137|Gasket, bottom cover 032-0792-064
(see separate listing which follows) MP 300|Foam tape, dbl side 574-3002-013
A 300 |Receiver/exciter assembly (VHF) [023-5317-202 MP501 |Shield, coax gnd (800 MHz) 017-2226-017
(see separate listing on page 7-2) MP 502 |Shield, low-pass filter (800 MHz) [017-2226-036
I}s[e:[i')"é‘;:’if‘:e; aiiemb'y 58%0 023-5387-202)  ly4p 503|Grounding finger (800 MHz)  |537-5001-010
w301 |a _Si ,gl b‘;a%,et o |so7.2002.230]  |MP 504|Grounding cip (800 M) 537-5001-004
a i -2002-
ceessory pigtar’ cabic Unternd MP 601 |Shield, low-pass filter 017-9700-000
A 400 |Logic board assembly 023-5300-400 MP 990 | Mi Ket $74-3002-121
(see separate listing on page 7-8) 1€ gaske e
A 500 |PA board assembly (VHF) 023-5315-501 MP 999 | Seal, mic connector 032-0792-129
(see separate listing on page 7-3)
PA board assembly (800 MHz) 023-5385-501 W 101 |Display - logic bd cable assy?? 023-5300-025
(see separate listing on page 7-5) W 501 |Power cable assembly, PA 597-2002-235
W 502 |RF cable assembly, PA 597-2002-240
CH 101 |Chassis, metal 015-0970-001
EP 001 |No. 6 terminal lug 586-0005-106 INTERFACE BOARD
EP 002 |Ferrite bead, .375 x .375 517-2002-003 Part No. 023-5300-201
EP 003 |Ferrite block, for J200 2999797787
C 002 470 pF 25V electrolytic 510-4064-471
HW001| Captive screw, cover 537-9007-045 C 003 {100 uF 25V electrolytic 510-4425-101
HW002Screw, 6-32 x 5/16” Torx 575-0006-010 C 004 |1.0 uF 10V tantalum smd 510-2624-109
HW 003{Plug, option {(in unused chass hole)|032-0792-075 C 005 .1 uF £5% X7R 50V cer smd 510-3609-104
HW 004) Audio amp U1 clip 017-9700-001 C 006 |.1 uF +5% X7R 50V cer smd 510-3609-104
HW005|O-ring, 1/8” x 1/4” cover screw  |574-2002-001 C 007 |.1 uF 5% X7R 50V cer smd 510-3609-104
HW 006|Nylon washer, cover screw 596-4408-015 C 009 {470 pF +5% NPO cer smd 510-3602-471
HW 007 Split rabber grommet 1/8”1D 574-0002-015 C 010 {.1 uF £10% X7R SOV cer smd 510-3606-104
HW 009| Flat washer, cover screw 596-9408-009 CO11 |.1 uF +10% X7R 50V cer smd 510-3606-104
HW010|Screw, 4-40 x 1/4 pan hd 375-1604-008 C012 |.1uF+10%X7R 50V cersmd  |510-3606-104
HW 011{Washer, No 4 shake proof’ 596-1104-008 C 013 {4.7 uF 10V tantalum smd 510-2624-479
HW 012 Washer, No. 4 split lock 596-1304-008 C 014 (4.7 uF 10V tantalum smd 510-2624-479
HW020!1/4” x 1.20"" x 1.90” urethane pad [018-1007-250 C OIS {.01 pF £5% X7R 50V cer smd 510-3609-103
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Interface Board Assembly (Cont’d)

Receiver/Exciter Assembly

lRef No, Description Part No. [Ref No, Description Part No.
RECEIVER/EXCITER ASSEMBLY
CR 001 {10V zener SOT-23 523-2016-100 Part No. 023-53x7-202
CR 002 { Switching diode SOT-23 523-1504-002
A 001 |Interconnect board assembly 023-5300-050
J201 | Connector, 20-pin 515-7111-230 (see separate listing which follows)
7202  |Connector, 30-pin 515-7106-430 A 002 |RF board assembly, VHF 585-0400-003
RF board assembly, 800 MHz 587-5000-003
P 100 [Header, 2-pin friction lock 515-9031-201
P 101 |Header, 3-pin friction lock 515-9031-202 HW 001|Screw, 2-56 x 1/8” pan hd 575-1602-004
PC 201 [PC board, interface 035-5300-200 HW 002|Screw, 4-40 x 1/4” pan hd 575-1604-008
HW 003 | Lockwasher, internal 596-2102-006
Q001 |NPN general purpose 576-0003-658 HW 004| Washer, split lock #4 ZPS 596-1304-008
Q002 [NPN general purpose 576-0003-658
MP 002 | Metal RF board housing 015-0970-003
R 002 [2.2 ohm+5% 1W smd 569-0175-229 MP 003 |Cover for housing MP2 015-0970-005
R 003 |10k ohm +5% 1/8W smd 569-0105-103 MP 004 | H-clip for RF board 017-2229-509
R 004 |47k ohm +5% 1/8W smd 569-0105-473 P 001 |Jumper, flex 515-9500-005
R 005 |10k ohm 5% 1/8W smd 569-0105-103 PC 001 |PC board, RF connection 035-5300-310
R 006 |7.5k ohm +5% 1/8W smd 569-0105-752 W 001 |Coax assy, right angle 597-3008-001
R 008 ([1k ohm +5% 1/8W smd 569-0115-102
R 009 |1k ohm £5% 1/8W smd 569-0115-102 INTERCONNECT BOARD ASSEMBLY
R 010 |1k ohm +5% 1/8W smd 569-0115-102 Part No. 023-5300-050
R O11 |10k ohm %1% 1/8W smd 569-0111-401 C 001 |39 pF £5% NPO 50V cer smd 510-3674-390
R 012 |35.7k ochin £1% 1/8W smd 569-0111-454 C 002 |39 pF £5% NPO 50V cer smd 510-3674-390
R 013 |10k ohm =5% 1/8W smd 569-0115-103 C 003 |39 pF +5% NPO S0V cer sind 510-3674-390
R 014 [10k ohm £5% 1/8W smd 569-0115-103 C 004 |39 pF £5% NPO 50V cer smd 510-3674-390
R 015 |Zero ohm jumper 569-0115-001 C 005 |39 pF £5% NPO 50V cer sid 510-3674-390
R 016 |10k ohm +5% 1/8W smd 569-0115-103 C 007 |39 pF £5% NPO 50V cer simd 510-3674-390
R 017 |3k ohm £5% 1/8W smd 569-0115-302 C 008 |39 pF £5% NPO 50V cer smd 510-3674-390
R 018 |10k ohm +5% 1/8W smd 569-0115-103 C 009 |39 pF £5% NPO 50V cer smd 510-3674-390
R 019 |Zero ohm jumper 569-0115-001 C 010 |39 pF £5% NPO 50V cer smd 510-3674-390
R 020 |10k ohm £3% 1/8W smd 569-0115-103 C 011 |39 pF £5% NPO 50V cer smd 510-3674-390
R 021 |10k ohm £5% 1/8W smd 569-0115-103 C 012 |39 pF 5% NPO 50V cer smd 510-3674-390
R 022 |10k ohm +5% 1/8W smd 569-0105-103 C 014 |39 pF £5% NPO 50V cer smd 510-3674-390
C 016 |39 pF £5% NPO 50V cer smd 510-3674-390
U001 |Audio amp, 22W TDA1519 544-2004-003 CO017 [.1 pF X7R £10% S0V cer smd 510-3675-104
U 002 [Voltage regulator, adjust TK11900|544-2603-093 C 018 |39 pF 5% NPO 50V cer smd 510-3674-390
U003 [Opamp, dual LM2904 544-2019-004 C 019 |39 pF £5% NPO 50V cer smd 510-3674-390
U 004 |{Digital potentiomtr, 2-ch AD8402 |544-0004-213 C 020 (39 pF =£5% NPO 50V cer smd 510-3674-390
C 021 |39 pF £5% NPO 50V cer smd 5310-3674-390
C 022 (39 pF £5% NPO 50V cer smd 510-3674-390
C 024 |39 pF £5% NPO 50V cersmd 510-3674-390
C 025 |39 pF £5% NPO 50V cer smd 510-3674-390
C 026 |39 pF +5% NPQ 50V cer smd 510-3674-390
C 027 |39 pF £5% NPO 50V cer smd 510-3674-390
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Receiver/Exciter Assembly (Cont’d) VHF PA Board Assembly
[Ref No. Description Part No. [Ref No., Description Part No.
C 028 |30 pF 5% NPO SOV cersmd __ |510-3674-390|  |C 527 [30 pF +5% NPO 50V cersmd  |510-3615-301
C 029 (39 pF +5% NPO 50V cer smd 510-3674-390 C 528 |.01 pF £10% X7R 30V cer smd | 510-3605-103
C 529 |300 pF £5% NPO 50V cersmd  |510-3615-301
EP 001 |Ferrite bead smd 517-2503-002|  |C530 |.1 WF£10% X7R 50V cersmd  |510-3606-104
EP 002 |Ferrite bead smd 517-2503-002 C531 |.1 pF£10% X7R 50V cersmd  |510-3606-104
J 001 Connector, 2 x 10-pin 515-7113-070 C 532 |.01 uF X7R £10% 50V cersmd  {510-3605-103
1002 |Connector, 30-pin 515-7111-430]  |C 533 |300 pF =5% NPO 50V cersmd  |510-3615-301
MP 011 |Contact, power 013-1724-001 C 534 |300 pF =5% NPO 50V cersmd  |510-3615-301
C 535 |240 pF =5% NPO 50V cersmd  |510-3615-241
PC 001 |PC board, interconnect 035-5300-050 C 536 |51 pF 5% NPO 50V cer smd 510-3601-510
PC 011 |Flex circuit, power 035-1800-180 C 537 |[100 pF +5% NPO 50V cer smd 510-3601-101
C 538 |150 pF +5% NPO 50V cersmd  |510-3601-151
R O01 |Zero ohm jumper 569-0155-001 C 540 [4.7 uF 20V tantalum smd 510-2626-479
R002 |Zero ohm jumper 569-0155-001 C541 300 pF £5% NPO 50V cersmd  |510-3615-301
R 003 |Zero ohm jumper 569-0155-001 C 542 |.01 pF X7R £10% 50V cersmd  510-3603-103
R 004 {Zero ohm jumper 569-0155-001 C 543 |.01 uF XTR £10% 50V cersmd  |510-3605-103
R 005 {Zero ohm jumper 569-0155-001 C 544 300 pF £5% NPO 50V cersmd  |510-3615-301
PA BOARD ASSEMBLY (VHF) C 545 120 pF £10% 50V high Qsmd  |510-3663-121
Part No. 023-5315-501 C 546 |120 pF £10% SOV high Qsmd  [510-3663-121
C 547 |4.7pF=10% S0V high Qsmd  |510-3663-4751
Cso1 |12 pF £10% S0V high Qsmd  |510-3663-120| |G 348|300 pF £10% 50V high Qsmd 510-3663-301
C 502 |10 pF 250V mini mica s10.0019-100]  |C 549 [220 pF £10% 50V high Qsmd  |510-3663-221
C503 |22 pF £10% 50V high Qsmd  |510-3663-220|  [C 350 |120 pF £10% 50V high Qsmd |510-3663-121
C 504 |12 pF 250V mini mica 510.0019.1201  |C 551 [150 pF £10% 50V high Qsmd  |510-3663-151
C505 |22 pF £10% 50V high Qsmd  |510-3663-220]  [C 552 [220 pF £10% 50V high Qsmd  |510-3663-221
C 506 |10 pF 250V mini mica s10.0019.100]  |C 553|220 pF +10% 50V highQsmd  |510-3663-221
C507 |8.2pF+10% 50V highQsmd  [510-3663-820f  [C 534 |300pF 250V mini mica 510-0019-301
C 508 |300 pF+10% 50V high Qsmd  |510-3663-301 C 555|300 pF 250V mini mica 510-0019-301
€509 |12 pF+10% S0V highQsmd  [510-3663-120f  [€ 336|240 pF 250V mini mica 310-0019-241
C510 |300 pF+5% NPO 50V cersmd  |510-3615-301 C 557 1270 pF 250V mini mica 510-0019-271
C511 |300 pF+10% S0V high Qsmd  |510-3663-301 C 558 1100 pF 250V mini mica 510-0015-101
C512 |33 pF£5%NPO 50V cersmd  |510-3615-330 C 559|100 pF 250V mini mica 510-0019-101
C513 |12 pF£5% NPO SOV cersmd  |510-3615-120]  [C 360 |47 pF 250V mini mica 510-0019-470
C 515 300 pF £5% NPO 50V cer smd 510-3615-301 C 561 |.01 pF X7R £10% 50V cersmd  [510-3605-103
C 516 {300 pF £5% NPO 50V cersmd  |510-3615-301 €562 |300 pF £10% 50V high Qsmd |510-3663-301
C517 |51 pF£5%NPO 50V cersmd  |510-3601-510  |C 363 [1pF£10% XTR 16V cersmd —510-3606-105
C 518 |01 pF£10% XTR S0V cersmd |510-3605-103| | 364 | OLuF XTR £10% 50V cersmd ) 510-3605-103
C519 |300 pF£5% NPO 50V cersmd  |510-3615-301  |C 365|300 pF +5% NPO 50V cersmd 310-3615-301
520|300 pF £5% NPO 50V cersmd  |510-3615-301 C 567 |.018 uF £10% X7R 50V cersmd |510-3605-183
C521 |300 pF £5% NPO 50V cersmd  |510-3615-301 C 568 (300 pF £5% NPO 50V cersmd 510-3615-301
C 522|300 pF 5% NPO 50V cersmd  |510-3615-301 C 569 |300 pF £5% NPO 50V cersmd |510-3615-301
C523 33 pF+5%NPO 50V cersmd  |510:3615-330]  [C370 |18 uF £10% XTR SOV cer smdl |510-3605-183
C 524 120 pF £5% NPO 50V cersmd  |510-3601-121 €571 (300 pF +5% NPO 50V cer smd 1510-3615-301
526 |01 uF +10% X7R S0V cersmd  |510-3605-103 €572 |.018 uF £10% X7R 50V cer smd |510-3605-183
C 573 |300 pF £5% NPO 50V cer smd 510-3615-301
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PARTS LIST

VHF PA Board Assembly (Cont’d)

FRef No. Description Part No. [Ref No. Description Part No.
C 574 |1500 pF 25V electrolytic 510-4055-152 L 503 |2T inductor 016-0020-082
C 577 |.t pF £10% X7R 50V cer smd 510-3606-104 L 504 |8T inductor 016-0020-058
C 579 (10 pF 25V tantalum smd 510-2627-100 L 505 [10T inductor 542-0030-010
C 580 |1 pF £10% X7R 16V cer smd 510-3606-105 L 506 [1.0 uH £5% smd 542-9000-109
C 581 .01 pF +5% X7R 50V cer smd 510-3609-103 L 507 |{1.0 pH +5% smd 542-9000-109
C 582 |1 pF +10% X7R 16V cer smd 510-3606-105 L 509 [10T 43 nH smd 542-0030-010
C 583 |1 pF £10% X7R 16V cer smd 510-3606-105 L 510 (10T 43 nH smd 542-6030-010
C 585 (470 pF 16V electrolytic 510-4056-471 L511 |6T17.5nH 542-0030-006
C 588 |1 pF £10% X7R 16V cer smd 510-3606-105 L 514 (10T 43 nH smd 542-0030-010
C 589 |470 uF 16V electrolytic 510-4056-471 L 515 |10T 43 nH smd 542-0030-010
C 590 (1500 pF 25V electrolytic 510-4055-152 L 516 |8T inductor 016-0020-058
C 591 |.01 uF +10% X7R 50V cersmd  [510-3605-103 L.517 4T inductor 542-0020-044
C 593 [.001 uF X7R £10% 50V cer smd |510-3605-102 L. 518 4T inductor 542-0020-034
C 594 |.001 pF X7R £10% 50V cer smd  [510-3605-102 L 519 |70 uH DC line filter 542-5010-003
C 597 100 pF £5% NPO 50V cer smd 510-3601-101 L 520 |100 uH 3A toroid inductor 542-5010-016
C 598 100 pF £5% NPO 50V cer smd 510-3601-101 L. 521 |50 pH 3A toroid inductor 542-5010-013
C 599 100 pF +£5% NPO 50V cer smd 510-3601-101
C 600 |100 pF £5% NPO 50V cer smd 510-3601-101 PC 501 [PA board, VHF 035-5315-500
C 608 |100 pF £5% NPO 50V cer smd 510-3601-101
C 609 100 pF 5% NPO 50V cer smd 510-3601-101 Q501 |NPN general purpose 576-0003-658
C 611 |27 pF £10% 50V high Q smd 510-3663-270 Q 504 |NPN general purpose 576-0003-658
C 612 147 pF £10% 50V high Q smd 510-3663-470 Q 505 |NPN general purpose 576-0003-658
C613 |1 pF+10% X7R 16V cer smd 510-3606-105 Q 506 |PNP power Darlington amp 576-0007-013
Q 507 |NPN general purpose 576-0003-658
CR 501 |Pin diode 523-1504-032 Q 508 |NPN general purpose 576-0003-658
CR 502 |Pin diode 523-1504-032 Q509 |NPN RF power 576-0004-111
CR 503 |Pin switching diode 523-1504-001 Q510 |NPN RF power 75W, 175 MHz  |576-0004-053
CR 506 |Switching diode SOT-23 523-1504-002 Q511 |PNP power Darlington 576-0007-013
CR 508 | Switching diode SOT-23 523-1504-002 Q512 |PNP switching 576-0003-612
CR 509 |Switching diode SOT-23 523-1504-002 Q 513 |NPN general purpose 576-0003-658
CR 510 [HC diode 523-1504-016 Q514 |NPN general purpose 576-0003-658
CR 512 |Pin switching diode 523-1504-001
CR 513 |Pin switching diode 523-1504-001 R 501 |220k ohm +5% 1/8W smd 569-0105-224
CR 514 | Transient suppressor 523-2906-001 R 502 {220k ohm +5% 1/8W smd 569-0105-224
CR 515 |Schottky power 3A,40V 523-0519-032 R 503 {220 ohm +5% 1/8W smd 569-0105-221
R 505 (100 ohm +5% W smd 569-0175-101
EP 501 (Ferrite bead smd 517-2503-010 R 506 |100 ohm +5% ] W smd 569-0175-101
EP 502 |Ferrite bead smd 517-2503-010 R 507 {220k ohm +5% 1/8W smd 569-0105-224
EP 503 (Ferrite bead smd 517-2503-002 R 508 |4.7k ohm +5% 1/8W smd 569-0105-472
R 509 |68k ohm 5% 1/8W smd 569-0105-683
J 501  |Connector, 20-pin 515-7111-230 R 510 |2.0k ohm +5% 1/8W smd 569-0105-202
1502 |Connector, SMT receptacle 515-7111-47¢ R 519 [47k ohm +5% 1/8W smd 569-0105-473
R 520 |20k ohm £5% 1/8W smd 569-0105-203
L 501 (2T inductor 016-0020-082 R 521 [20k ohm +5% 1/8W smd 569-0105-203
L. 502 |2T inducter 016-0020-082 R 522 |10k chm +5% 1/8W smd 569-0105-103
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VHF PA Board Assembly (Cont’d)}

800 MHz PA Board Assembly

[Ref No. Description Part No. ef No, Description Part No.
R 523 |20k ohm £5% 1/8W smd 569-0105203|  [R570 470 ohm +5% 1/8W smd 569-0105-471
R 524 |10k ohm £5% 1/8W smd 569-0105-103|  |R571 | 100 ohm £5% 1/8W smd 569-0105-101
R 525 |20k ohm £5% 1/8W smd 569-0105-203[  |R572 |1.2k ohm £5% 1/8W smd 569-0115-122
R 526 |10k ochm £5% 1/8W smd 569-0105-103[  |R573 |1.2k ohm £5% 1/8W smd 569-0115-122
R 527 |20k ohm 5% 1/8W smd 569-0105-203] R 574|100k ohm £5% 1/8W smd 569-0105-104
R 528 |10k ohm 5% 1/8W smd 569-0105-103]  |R 375 |560 ohm 5% 1/8W smd 569-0105-561
R 529 |20k ohm £5% 1/8W smd 569-0105203]  |R 576 |1.2k ohm £5% 1/8W smd 569-0115-122
R 530 |10k ohm =5% 1/8W smd 569-0105-103]  |R 577 |47k obm 5% 1/8W smd 569-0105-473
R 531 |20k ohm 5% 1/8W smd 569-0105203|  |R 378 |3.01k £1% 1/8W smd 569-0111-347
R 532 |10k ohm £5% 1/8W smd 569-0105-103|  [R 579 |1.27k ohm 1% 1/8W smd 569-0111-311
R 533 |20k ohm £5% 1/8W smd 569-0105-203|  |R 580 |1.0k ohm 5% 1/8W smd 569-0105-102
R 534|220k ohm +3% 1/8W smd 569-0105-224|  |R 581 |18k ohm £5% 1/8W smd 569-0105-183
R 535 |10k ohm £5% 1/8W smd 569-0105-103]  |R 582 |68k ohm +5% 1/8W smd 569-0105-683
R 536 2.2k ohm £5% 1/8W smd 569-0105-222]  |R 583 |10k ohm £5% 1/8W smd 569-0105-103
R 537 |10k ohm +5% 1/8W smd 569-0105-103]  |R 584 120k ohm 5% 1/8W smd 569-0105-203
R 538 |18k ohm +5% 1/8W smd 569-0105-183]  |R 585 !1.0k ohm 5% 1/8W smd 569-0105-102
R 539 47k ohm £5% 1/8W smd 569-0105-473)  |R 386 [1.0k ohm 5% 1/8W smd 569-0105-102
R 540 |10k ohm £5% 1/8W smd 569-0105-103]  |R 587 |1.0k ohm =5% 1/8W smd 569-0105-102
R 541 |1.8k ohm +5% 1/8W smd 569-0105-182[  |R 588 {1.0k ohm 5% I/8W smd 569-0105-102
R 542 |1.0k ohm £5% 1/8W smd 569-0105-102
R 543 |4.3k ohm +5% 1/8W smd 569-0105-432|  |RT 501 | Thermistor, 10k ohm 5% smd ~ |569-3013-007
R 544 |4.3k ohm +5% 1/8W smd 569-0105-432
R 545 |6.2k ohm 5% 1/8W smd 569-0105-622|  |U501 |Shift reg, 8-stage MC4094 544-3016-094
R 546|330 ohm +5% 1/8W smd 569-0105-331|  |U502 |Op amp, dual LM2904 544-2019-004
R 547 |470k ohm +5% 1/8W smd 569-0105-474]  |U505 |Current sense amp MAX472ESA | 544-2039-002
R 548 |10k ohm £5% 1/8W smd 569-0105-103]  |U 506 |Switching regulator, 3A MC33166 | 544-2003-102
R 549 |20k ohm +5% 1/8W smd 569-0105-203|  |U 507 |Op amp, dual LM2904 544-2019-004
R 551 |18k ohm £5% 1/8W smd 569-0105-183
R 552 |68k ohm +5% 1/8W smd 569-0105-683 PA BOARD ASSEMBLY (800 MHz)
R 553 [1.0k ohm +£5% 1/8W smd 569-0105-102 Part No. 023-5385-501
R 555 |4.7k ohm £5% 1/8W smd 569-0105-472
R'536 |10 ohm £5% 1W smd 369-0175-100 1 501 13.9 pF £10% 50V high Qsmd  |510-3653-399
R'557 1100 ohm £5% 1W smd 369-0173-101} e 502 17.5 pF +10% S0V high Qsmd  |510-3663-759
R 558 |18k ohm +5% 1/8W smd 569-0105-1831 ¢ 503 |1.0 pF 5% NPO 50V cersmd | 510-3615-109
R 559|100 ohm 5% 1W smd 369-0175-101 e 504 |7.5 pF £10% 50V high Qsmd  |510-3663-759
R'560 1100 ohm £5% 1W smd 369-0175-101 1 505 (3.9 pF £10% 50V high Qsmd  |510-3653-399
R 561 |.015 ohm £5% 2W smd 3692019157} 1¢ 506 |39 pF +5% NPO 50V cersmd  |510-3615-390
R 562 1200 ohm =5% 1/8W smd 569-0115-201 €507 [9.1pF+5%NPO 50V cersmd  |510-3615-919
R 563 1200 ohm +5% 1/8W smd 569-0115-201 €508 |1.8pF+5%NPO 50V cersmd  |510-3615-189
R 564 4.7k ohm +3% 1/8W smd 569-0115-472 C 509 139 pF £5% NPO SOV cersmd  |510-3615-390
R 565 1330 ohm +5% 1/8W smd 569-0105-331 C510 |22 pF+£5%NPO 50V cersmd  1510-3615-229
R 566 |100 ohm +5% 0.75W smd 569-0135-101] |54y Is6 pF<10% 50V high Qsmd  |510-3653-560
R 567 68k ohm £5% 1/8W smd 569-0105-683 C512 |1.8 pF £5% NPO 50V cersmd  {510-3615-189
R 568 | 100k ohm +5% 1/8W smd 369-0105-104 C513 |1.8 pF £5% NPO 50V cersmd  [510-3615-189
R 569 |68k ohm 5% I/8W smd 569-0105-683
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[Ref No. Description Part No. [Ref No. Description Part No.
C 514 |12 pF +5% NPO 50V cer smd 510-3601-120 C 567 |12 pF £5% NPO 50V cer smd 510-3615-120
C 515 |8.2 pF £5% NPO 50V cer smd 510-3615-829 C 568 |39 pF 5% NPO 50V cer smd 510-3613-390
C 516 .01 uF X7TR £10% 50V cersmd  |510-3605-103 C 569 |.018 uF+£10% X7R 50V cersmd {510-3605-183
C517 (.01 uF X7R £10% 50V cersmd  $510-3605-103 C 570 39 pF £5% NPO 50V cer smd 510-3615-390
C518 {.01 pF X7R £10% 50V cersmd  |510-3605-103 C 571 |1500 pF 25V electrolytic 510-4055-152
C 519 (39 pF £5% NPO 50V cer smd 510-3615-390 C 572|100 pF NPO +£5% 50V cer smd 510-3601-101
C 521 |39 pF £5% NPO 50V cer smd 510-3615-390 €573 (39 pF +5% NPO 50V cer smd 510-3615-390
C 522 2.2 pF £5% NPO 50V cer smd 510-3615-229 C 577 |.1 pF £10% X7R 50V cer smd 510-3606-104
C 524 |39 pF £5% NPO 50V cer smd 510-3601-390 C579 10 pF 25V tantalum smd 510-2627-100
C525 |.01 uF XTR £10% 50V cersmd  [510-3605-143 C 580 |1 pF=10% X7R 16V cer smd 510-3606-105
C526 |.01 pF XTR +£10% 350V cersmd  [510-3605-103 C 581 |.01 pF X7R £5% 50V cer smd 510-3609-103
C 527 |.1 uF X7R £10% 50V cer smd 510-3606-104 C 582 |1 pF+£10% X7R 16V cer smd 510-3606-105
C 528 |39 pF £5% NPO 50V cer sid 510-3601-390 C583 |1 uF£10% X7R 16V cer smd 510-3606-105
C 529 [.1 pF X7R £10% 50V cer smd 510-3606-104 C 585 [470 uF 16V electrolytic 510-4056-471
C 530 |39 pF £5% NPO 50V cer smd 510-3601-390 C 586 |470 uF 16V electrolytic 510-4056-471
C 531 |39 pF +5% NPO 50V cer smd 510-3601-390 C 589 |1 uF+10% X7R 16V cer smd 510-3606-105
C 532 139 pF £5% NPO 50V cer smd 510-3601-390 C 590 |.018 uF £10% X7R 50V cersmd [510-3605-183
C 533 |39 pF £5% NPO 50V cer smd 510-3601-390 C 591 [.018 uF £10% X7R 50V cersmd [510-3605-183
C 534 |39 pF +5% NPO 50V cer smd 510-3601-390 C 592 |39 pF £5% NPO 50V cer smd 510-3615-390
C 535 |12 pF +#5% NPO 50V cer smd 510-3601-120 C 593 .01 uF X7R £10% 50V cer smd 510-3605-103
C 536 |39 pF 5% NPO 50V cer smd 510-3601-390 C 595 |39 pF £5% NPO 50V cer smd 510-3601-390
C 537 |39 pF £5% NPO 50V cer smd 510-3601-390 C 596 |39 pF 5% NPO 30V cer smd 510-3601-390
C 538 |5.6 pF £5% NPO 50V cer smd 510-3601-569 C 597 39 pF +5% NPO 50V cer simd 510-3601-390
C 539 139 pF £5% NPO 50V cer smd 510-3601-390 C 598 (5.1 pF +5% NPO 50V cer smd 510-3601-519
C 540 |39 pF £5% NPO 50V cer smd 510-3601-390 C 599 |39 pF £5% NPQ 50V cer smd 510-3601-390
C 541 (1 pF+10% X7R 16V cer smd 510-3606-105 C 601 |39 pF £5% NPO 50V cer smd 510-3601-390
C 542 (39 pF +5% NPO 30V cer smd 510-3601-390 C 602 |39 pF £5% NPO 50V cer smd 510-3601-390
C 543 |1 pF £10% X7R 16V cer smd 510-3606-105 C 604 |39 pF +5% NPO 50V cer smd 510-3601-390
C 544 (1 uF +10% X7R 16V cer smd 510-3606-105 C 605 |39 pF £5% NPO 50V cer smd 510-3601-390
C 545 |39 pF +5% NPO 50V cer smd 510-3615-390 C 606 |39 pF £5% NPO 50V cer smd 510-3601-390
C3546 |.018 pF £10% X7R 50V cersmd |510-3605-183 C 607 |39 pF 5% NPO 50V cer smd 510-3601-390
C 547 {1 pF £10% X7R 16V cer smd 510-3606-105 C 608 (39 pF +5% NPO 50V cer smd 510-3601-390
C 548 |39 pF £5% NPO 50V cer smd 510-3615-390 C609 |.018 pF +£10% X7R 50V cersmd |[510-3605-183
C549 (.018 uF +10% X7R 50V cer smd |510-3605-183 C 610 |39 pF £5% NPO 50V cer smd 510-3601-390
C 550 |39 pF £5% NPO 50V cer smd 510-3615-390 C611 (39 pF £5% NPO 50V cer smd 510-3601-390
C 551 |.018 uF £10% X7R 50V cersmd [510-3605-183 C612 |39 pF £5% NPO 50V cer smd 510-3601-390
€ 552 |1 uF £10% X7R 16V cer smd 510-3606-105 C613 39 pF £5% NPO 50V cer smd 510-3601-390
C 553 |.018 pF +£10% XT7R 50V cersmd {510-3605-183 C614 |39 pF £5% NPO 50V cer smd 510-3601-390
C 554 |39 pF £5% NPO 50V cer smd 510-3615-390 C615 |39 pF £5% NPO 50V cer smd 510-3601-390
C 555 {.018 uF +10% X7R 50V cersmd  [510-3605-183 C 616 |39 pF £5% NPO 50V cer smd 510-3601-390
C 556 (3.0 pF £5% NPO 50V cer smd 510-3615-309 C617 |39 pF £5% NPO 50V cer smd 510-3601-390
C 563 (1 pF+10% X7R 16V cer smd 510-3606-105 C618 |39 pF £5% NPO 50V cer smd 510-3601-390
C 564 [.01 pF X7R £10% 50V cersmd  [510-3605-103 C 619 |39 pF 5% NPO 50V cer smd 510-3601-390
C 565 |56 pF £10% 50V hi Q smd 510-3653-560 C 620 139 pF £5% NPO 50V cer smd 510-3601-390
C 566 |[1.0to4.5pF smd variable 512-10608-001 C 621 (39 pF £5% NPO 50V cer smd 510-3601-390
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IRef No, Description Part No. IRef No. Description Part No.
C 622 |39 pF 5% NPO 50V cer smd 510-3601-390 Q503 |NPN low noise amp 576-0003-618
C 623 |1 uF +£10% X7R 16V cer sind 510-3606-105 Q504 |NPN general purpose SOT-23 576-0003-658
C 624 |39 pF +£5% NPO 50V cer smd 510-3601-350 Q505 |NPN general purpose SOT-23 576-0003-658

Q 506 {NPN general purpose SOT-23 576-0003-658
CR 501 [Pin diede 523-1504-032 Q507 INPN general purpose SOT-23 576-0003-658
CR 502 |Pin diode 523-1504-032 Q 508 |PNP low noise amp 576-0003-657
CR 503 [Pin switching diode 523-1504-001 Q509 |NPN 800 MHz high power amp
CR 504 |Switching diode SOT-23 523-1504-002 Q513 [PNP pwr Darlington 576-0007-013
CR 505 |Switching diode SOT-23 523-1504-002 Q515 {PNP switching 576-0003-612
CR 506 |5.1V zener SOT-23 523-2016-519 Q516 |NPN general purpose SOT-23 576-0003-658
CR 507 |Switching diede SOT-23 523-1504-002 Q517 {NPN general purpose SOT-23 576-0003-658
CR 508 |12V zener diode SOT-23 523-2016-120
CR 509 |HC diode SOT-23 523-1504-016 R 501 |220k ohm 5% 1/8W smd 569-0105-224
CR 510 | Transient suppressor, axial 523-2906-001 R 502 {560 ohm +5% 1/8W smd 569-0105-561
CR 515 |Schottky power, 3A, 40V SMT  |523-0519-032 R 503 |100 ohm £5% 3/4W smd 569-0135-101
CR 516 | Pin diode 523-1504-032 R 504 (100 ohm =5% 3/4W smd 569-0135-101
CR 517 {Hc diede SOT-23 523-1504-016 R 505 |[220k ohm +5% 1/8W smd 569-0105-224
CR 518{Pin diode 523-1504-032 R 506 [220k ohm +5% 1/8W smd 569-0105-224
CR 519 {Pin diode 523-1504-032 R 507 |68k ohm 5% 1/8W smd 569-0105-683
CR 520/{3.3V zener SOT-23 523-2016-339 R 508 |4.7k ohm +5% 1/8W smd 569-0105-472
CR 521 |HC diode SOT-23 523-1504-016 R 509 |10k ohm £5% 1/8W smd 569-0105-103
CR 522 [Switching diode SOT-23 523-1504-002 R 510 |4.7k ohm +5% 1/8W smd 569-0105-472
R 511 |100 ohm £5% 1/8W smd 569-0105-101
EP 501 |Ferrite bead smd 517-2503-010 R 512 (220 ohm £5% 1/8W smd 569-0105-221
EP 502 |Ferrite bead smd 517-2503-010 R 513 |20k ohm #5% 1/8W smd 369-0105-203
EP 503 |Ferrite bead smd 517-2503-010 R 514 |20k ohm £5% 1/8W smd 569-0105-203
R 515 |10k ohm +5% 1/8W smd 569-0105-103
J501 |Connector, 20-pin 515-7111-230 R 516 |20k ohm +5% 1/8W smd 569-0105-203
R 517 |10k ochm £5% 1/8W smd 569-0105-103
L 501 (8.0nH smd air core 542-06030-003 R 518 |20k ohm +5% 1/8W smd 569-0105-203
L 502 |8.0nH smd air core 542-0030-003 R 519 |10k chm +5% 1/8W smd 569-0105-103
L 503 (12 nH smd 542-9003-127 R 520 |20k ohm +5% 1/8W smd 569-0105-203
L 504 |15nH smd 542-9003-157 R 521 |10k ohm £5% 1/8W smd 569-0105-103
L 505 (15 nH smd 542-9003-157 R 522 {20k ohm +£5% 1/8W smd 569-0105-203
L 506 |9T,35.5nH smd 542-0030-009 R 523 |10k ohm +£5% 1/8W smd 569-0105-103
L 507 |8T 22 AWG. 090 1D smd 542-0016-008 R 524 [20k ohm +5% 1/8W smd 569-0105-203
L 308 (8T 22 AWG. 090 1D smd 542-0016-008 R 525 [10k ohm £5% 1/8W smd 569-0105-103
L 509 |DC line filter 542-5010-003 R 326 [20k ohm £5% 1/8W smd 569-0105-203
L 511 [12 nH smd 542-9003-127 R 527 220k ohm +5% 1/8W smd 569-0105-224
L 512 |100 uH 3A toroid 542-5010-016 R 528 {10k ohm +£5% 1/8W smd 569-0105-103
L 513 (50 uH 3A toroid 542-5010-013 R 529 {2.2k ohm +3% 1/8W smd 569-0105-222
L 514 [15nH smd 542-9003-157 R 330 |10k ohm +5% 1/8W smd 569-0105-103
R 531 {47k ohm 5% 1/8W smd 569-0105-473
Q 501 |NPN general purpose sw/amp 576-0001-300 R 532 |47k ohm +5% 1/8W smd 569-0105-473
Q 502 [PNP switching 576-0003-612 R 533 }1.15k ohmn £1% 1/8W smd 569-0101-307
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R 534 |4.3k ohm =5% 1/8W smd 569-0105-432]  [R579 |120 ohm £5% 1/8W smd 569-0105-121
R 535 |7.5k ohm £5% 1/8W smd 569-0105-752|  |R 580 |10k ohm 5% 1/8W smd 560-0105-103
R 536|100k ohm %1% 1/8W smd 569-0101-501| R 581 |1.0k ohm 5% 1/8W smd 569-0105-102
R 537 |10k ohm =5% 1/8W smd 569-0105-103| R 582 |680 ohm £5% 1/8W smd 569-0105-681
R 538|330 ohm +5% 1/8W smd 5690105331 [R583 |51 ohm £5% 1/8W smd 569-0115-510
R 539 |Zero ohm £5% 1/8W smd 569-0105-001| R 584 |3.9k ohm 5% 1/8W smd 569-0105-392
R 540 |10k ohm £5% 1/8W smd 569-0105-103]  |R585 |51 ohm +5% 1/8W smd 569-0115-510
R 541|300 ohm 5% 425W smd 569-0116-301|  [R 586 1.0k ohm 5% 1/8W smd 569-0105-102
R 542 |18 ohm +5% 425W smd 569-0116-180]  |R 587 {300 ohm +5% 1/8W smd 569-0105-301
R 543|300 ohm £5% .425W smd 569-0116-301f  [R 588 |18 ohm £5% 1/8W smd 569-0105-180
R 544|270 ohm £5% 1/8W smd 560-0115271] IR 589 {300 ohm £5% 1/8W smd 569-0105-301
R 545 118 ohm £5% 1/8W smd 569-0115-180]  [R 590 |100 ohm +5% 1/8W smd 569-0105-101
R 546 |270 ohm 5% 1/8W smd 569-0115-271  [R 591 |100k ohm £5% 1/8W smd 569-0105-104
R 547 |10k ohm £5% 1/8W smd 569-0115-103]  [R 392 |47k ohm 5% 1/8W smd 569-0105-473
R 548 |5.1k ohm £5% 1/8W smd 569-0115-512|  [R 593 |47k ohm 5% 1/8W smd 560-0105-473
R 549 |1k ohm +5% 1/8W smd 560-0115-102|  [R 595 |510 ohm 5% 1/8W smd 569-0105-511
R 550 |.015 ohm £5% 2W smd 569-2019-157f  |R 596 |10k ohm £5% 1/8W smd 569-0105-103
R 551|200 ohm =5% 1/8W smd 5690115201 R 597 |3.9k ohm 5% 1/8W smd 569-0105-392
R 552|200 ohm +5% 1/8W smd 569-0115-201| R 398 |1.2k ohm 5% 1/8W smd 569-0115-122
R 553 |6.8k ohm £5% 1/8W smd 560-0115-682]  |R601 |Zero ohm jumper 569-0105-001
R 554|100 ohm £5% 1/8W smd 569-0105-101]  [R 631 |5.1k ohm £5% 1/8W smd 569-0105-512
R 555|100 ohm +5% 1/8W smd 569-0115-101
R 556|100k ohm 5% 1/8W smd 569-0105-104|  |U501 |Shift register, 8-bit MC14094  |544-3016-004
R 557 1220k ohm %5% 1/8W smd 569-0105-224 U502 |Opamp, low pwr quad LM2902  (544-2020-011
R 558 |47k ohm 5% 1/8W smd 569-0105-473|  [U503 |RF switch, DC-2 GHz AS139-73 (544-9015-100
R 559 (510 ohm +5% 1/8W smd 569-0105-511 U 505 | Current sense amp MAX472ESA  [544-2039-002
R 560 [510 ohm +5% 1/8W smd 569-0105-511|  |U 506 |Regulator, 3A switching MC33166|544-2003-102
R 561 {560 ohm +5% 1/8W smd 569-0105-561]  [U507 |Regulator, 8V low cur 7808 |544-2603-042
R 562|100k ohm +5% 1/8W smd 569-0105-104
R 563|100 ohm £5% 1/8W smd 569-0105-101| |7 501 |Filter, 860 MHz 20 MHz 3-pole  |532-2007-011
R 564 |1.2k ohm £5% 1/8W smd 569-0115-122
R 565 |1.2k ohm +35% 1/8W smd 569-0115-122 LOGIC BOARD ASSEMBLY
R 566 |47k ohm +5% 1/8W smd 569-0105-473 Part No. 023-5300-400
R 567 |3.01k ohm 1% 1/8W smd 569-0111-347
R 568 11.27k ohm £1% 1/8W smd S69-0LI-31LE - He g1 |1 wF +80/-20% Z5U 25V cer smd|510-3680-104
R569 |91k ohm :£5% I/BW smd 369-0105-9131 902 .1 uF +80/~20% Z5U 25V cer smd|510-3680-104
R'570 1220k ohm +5% 1/8W smd 269-0105-224F 1 003 |.1 wF +80/-20% Z5U 25V cer smd |510-3680-104
R 571 |75k ohm £5% 1/8W smd 369-0105-753(  fe 0p4 |1 uF +80/-20% Z5U 25V cer smd|510-3680-104
R372 |47k ohm =5% 1/8W smd S69-0105-4731 10005 |.1 uF +80/-20% Z5U 25V cer smd |510-3680-104
R573 |47k ohm +5% 1/8W smd 369-0105-4731 [ 006 |.1 uF +80/-20% Z5U 25V cer smd |510-3680-104
R 374 147k ohm £3% I/8W smd S69-0103-4731 1 007 |.1 uF +80/-20% Z5U 25V cer smd|510-3680-104
R 575 |18k ohm £5% 1/8W smd 569-0103-1821 1 90g 1220 pF 5% NPO 50V cersmd ~ |510-3674-221
R 576 |47k ohm 5% I/8W smd 369-0105-4731 1 009 |.1 uF +80/-20% Z5U 25V cer smd|510-3680-104
R 577 147k ohm £3% 1/8W smd 369-0103-4731 ¢ 010 |.1 uF +80/-20% Z5U 25V cer smd,510-3680-104
R 578 |1.8k ohm +5% L/8W smd 569-0105-182
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COIl |.1 pF +80/-20% Z5U 25V cer smd |[510-3680-104 C 057 [.1uF +80/~20% Z5U 25V cer smd [510-3680-104
C012 |.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 058 {100 pF 10V tantalum smd 510-2624-101
C 013 |.1pF +80/-20% Z5U 25V cer smd |510-3680-104 C 059 |4.7 uF 10V tantalum smd 510-2624-479
C 014 [.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 060 (4.7 pF 10V tantalum smd 510-2624-479
C 015 |[.1 pF +80/-20% Z5U 25V cer smd{510-3680-104 C 061 |220 pF £5% NPO 50V cer smd 510-3674-221
C016 |.1pF +80/-20% Z5U 25V cer stnd|510-3680-104 C 062 220 pF £5% NPO 50V cersmd  |510-3674-221
C 017 |.1 pF +80/-20% Z5U 25V cer smd [510-3680-104 C063 .1 pF +80/~20% Z5U 25V cer smd [510-3680-104
C018 |.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 064 |.1 pF +80/-20% Z51] 25V cer smd|510-3680-104
C019 |.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 065 |220 pF £5% NPO 50V cersmd  |510-3674-221
C 020 |.1 pF +80/-20% Z5U 25V cer smd:510-3680-104 C 066 |.1 pF +80/~20% Z5U 25V cer smd [510-3680-104
C 021 |.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 067 |3900 pF £10% X7R 25V cer smd [510-3675-392
C 022 .1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 068 1.1 uF +80/-20% Z5U 25V cer smd|510-3680-104
C 023 |.1 pF +80/-20% Z5U 25V cer smd |510-3680-104 C 069 |470pF £5% NPO 50V cersmd  |510-3674-471
C 024 |.1 pF +80/-20% Z5U 25V cer smd |510-3680-104 CO070 220 pF £5% NPO 50V cersmd  [510-3674-221
C025 (10pF .1 pF NPO 50V cersmd |510-3673-100 CO071 (220 pF £5% NPO 50V cer smd 510-3674-221
C026 |.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 0672 |470 pF +5% NPO 50V cer smd 510-3674-471
C027 |10pF+.1pF NPO 50V cersmd {510-3673-100 CO073 |1 pF £20% Z5U 25V cer smd 510-3636-105
C 028 [|62pF=1pFNPOS50Vcersmd |510-3673-629 C 074 |1 pF +20% Z35U 25V cer smd 510-3636-105
C029 |5.1pF=+.1pFNPO 30V cersmd |[510-3673-519 C 075 |1 uF £20% Z5U 25V cer smd 510-3636-105
C 030 |[470 pF £5% NPO 50V cer smd 510-3674-471 C076 |.1 pF +80/-20% Z5U 25V cer smd |510-3680-104
C 031 470 pF £5% NPO 50V cer smd 510-3674-471 C 077 |1 pF £20% Z5U 25V cer smd 510-3636-105
C032 .22 uF £10% Z5U 25V cer smd 510-3686-224 C 078 (470 pF £5% NPO 50V cer smd 510-3674-471
C 033 (220 pF =5% NPO 50V cer smd 510-3674-221 CO079 [.1 pF +80/-20% Z5U 25V cer smd|510-3680-104
C 034 |.1pF +80/~20% Z5U 25V cer smd|510-3680-104 C 080 {220 pF 5% NPO 50V cersmd  |510-3674-221
C 035 [.1 pF +80/-20% Z5U 25V cer smd |510-3680-104 C 081 |.I pF +80/-20% Z5U 25V cer smd [510-3680-104
C036 |.1 uF +80/-20% Z5U 25V cer smd|510-3680-104 C 082 |.1 uF +80/~20% Z5U 50V cer smd |510-3636-104
C 037 |220 pF £5% NPO 50V cersmd  |510-3674-221 C 083 ].001 uF +£10% X7R 50V cersmd [510-3675-102
C 038 [.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 084 .1 pF +80/-20% Z5U 25V cer smd |[510-3680-104
C 039 220 pF £5% NPO 50V cersmd  }510-3674-221 C 085 |1 uF £20% Z5U 25V cer smd 510-3636-105
C 040 |330pF £10% XT7R 25V cersmd |510-3675-331 C 086 |220 pF +5% NPO 50V cer smd 510-3674-221
C 041 1.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 087 [100pF £5% NPO 50V cersmd  [510-3674-101
C042 (.01 pF=10% X7R 50V cersmd  {510-3675-103 C 088 1 pF +20% Z5U 25V cer smd 510-3636-105
C 043 (.1 pF +80/~20% Z5U 25V cer smd|510-3680-104 C 089 |.1 uF +80/-20% Z5U 25V cer smd |510-3680-104
C 044 |1 puF +80/-20% Z5U 25V cer smd |510-3631-105 C 090 4700 pF £10% X7R 23V cer smd [510-3673-472
C 045 .1 pF +80/-20% Z5U 25V cer smd |510-3680-104 C 091 (220 pF £5% NPO 50V cer smd 510-3674-221
C 046 |220pF £5% NPO 50V cer smd  [510-3674-221 C 092 |220 pF +£5% NPO 50V cer smd 510-3674-221
C 047 |220 pF £5% NPO 50V cersmd  [510-3674-221 C 093 1220 pF +£5% NPO 50V cersmd  [510-3674-221
C048 |i10pF+.1 pFNPO S0V cersmd  |510-3673-100 C 094 220 pF =5% NPO 50V cersmd  |510-3674-221
C 049 |10 pF £.1 pF NPO 50V cersmd  {510-3673-100 C 095 |220 pF £3% NPO 50V cer smd 510-3674-221
C 050 (68 uF £10% 16V tantalum 510-2625-680 C 096 |220 pF £3% NPO 50V cersmd  |510-3674-221
C 051 (33 pF=10% X7R 25V cer smd 510-3675-330 C097 1.1 pF +80/20% Z35U 25V cer smd [510-3680-104
C 053 1.1 pF +80/-20% Z5U 25V cer smd ;510-3680-104 C 098 220 pF £5% NPO 50V cersmd  |510-3674-221
C 054 {33 pF+10% X7R 25V cer smd 510-3675-330 C 099 |.1 uF +80/~20% Z5U 25V cer smd [510-3680-104
C 055 |68 uF £10% 16V tantalum 510-2625-680 C 100 [.} pF +80/-20% Z5U 25V cer smd|510-3680-104
C 056 |220 pF £5% NPO 50V cersmd  |510-3674-221 C 101 1.1 uF +80/-20% Z5U 50V cer smd |510-3636-104
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C 102 {10 pF 10V tantalum smd 510-2624-100 C 148 470 pF £5% NPO 50V cer smd 510-3674-471
C 103 |.1 uF +80/=20% Z5U 25V cer smd|510-3680-104 C 149 (470 pF 3% NPO 50V cer smd 510-3674-471
C 105 |.1 uF +80/-20% Z51J 25V cer smd|510-3680-104 C 150 1470 pF £5% NPO 50V cer smd 510-3674-471
C 106 |.1 uF +80V—20% Z5U 25V cer smd |510-3680-104 C 151 |470 pF =5% NPO 50V cer smd 510-3674-471
C 107 |.1 uF +80/~20% Z5U 25V cer smd|510-3680-104 C 152 470 pF £5% NPO 50V cer smd 510-3674-471
C 108 |.1 uF +80/~20% Z5U 25V cer smd|510-3680-104 C 153 1470 pF £5% NPO 50V cer smd 510-3674-471
C 109 |.1 pF +80/~20% Z5U 25V cer smd|510-3680-104 C 154 |470 pF 5% NPO 50V cer smd 510-3674-471
C 110 |.1 uF +80/-20% Z5U 25V cer smd|510-3680-104 C 155 |470 pF =5% NPO 50V cer smd 510-3674-471
C 111 |.1 pF +80/-20% Z5U 25V cer smd|510-3680-104 C 157 |220 pF £5% NPO 50V cer smd 510-3674-221
C 112 {.1 uF +80/-20% Z5U 25V cer smd |510-3680-104 C 158 |33 pF £10% X7R 25V cer smd 510-3675-330
C 113 1220 pF +5% NPO 50V cersmd  |510-3674-221 C 159 |33 pF %10% X7R 25V cer smd 510-3675-330
C 114 |.1 uF +80/-20% Z5U 25V cer smdi510-3680-104 C 160 |33 pF £10% X7R 25V cer smd 510-3675-330
C 115 470 pF +£5% NPO 50V cer smd 510-3674-471 C 161 |220 pF 5% NPO 50V cer smd 510-3674-221
C 116 {470 pF 5% NPO 50V cer smd 510-3674-471 C 162 |220 pF £5% NPO 50V cer smd 510-3674-221
C 117 |470 pF £5% NPQ 50V cer smd 510-3674-471 C 163 |33 pF +10% X7R 25V cer smd 510-3675-330
C 118 |470 pF £5% NPO 50V cer smd 510-3674-471 C 164 |33 pF £10% X7R 25V cer smd 510-3675-330
C 119|470 pF +5% NPO 50V cer smd 510-3674-471 C 165 |33 pF£10% X7R 25V cer smd 510-3675-330
C 120 (470 pF 5% NPO 50V cer smd 510-3674-471 C 166 |33 pF £10% X7R 25V cer smd 510-3675-330
C 121 {470 pF £5% NPO 50V cer smd 510-3674-471 C 167 |33 pF £10% X7R 25V cer smd 510-3675-330
C 122 |470 pF +5% NPO 50V cer smd 510-3674-471 C 168 |33 pF +10% X7R 25V cer smd 510-3675-330
C 123|470 pF £5% NPO 50V cer smd 510-3674-471 C 169 |33 pF £10% X7R 25V cer smd 510-3675-330
C 124 |470 pF +£5% NPO 50V cer smd 510-3674-471 C 170 133 pF £10% X7R 25V cer smd 510-3675-330
C 125 |470 pF £5% NPO 50V cer smd 510-3674-471 C 171 .1 pF +80/=20% Z5U 25V cer smd |510-3680-104
C 126 1470 pF £5% NPQ 50V cer smd ~ |310-3674-471 C 172 |.1 uF +80/-20% Z5U 25V cer smd |510-3680-104
C 127 1470 pF £5% NPO 50V cersmd  |510-3674-471 C 173 |.22 pF electrolytic 510-9510-055
C 128 {470 pF 5% NPO 50V cer smd 510-3674-471
C 129|470 pF £5% NPO 50V cer smd 510-3674-471 D 001 |Switching diode 523-1504-029
C 130 (470 pF +5% NPO 50V cer smd 510-3674-471 D 002 |Dual switch-com cath 523-1504-022
C 131 |470 pF +£5% NPO 50V cer smd 510-3674-471 D 003 |Dual switch-com cath 523-1504-022
C 132 [470 pF £5% NPO 50V cer smd 510-3674-471 D 004 |[18V zener 523-2601-180
C 133|470 pF +5% NPO 50V cersmd  |510-3674-471 D 005 |Dicde, Schottky rect 523-0519-034
C 134|470 pF +5% NPO 50V cer smd 510-3674-471 D006 |Dual switch-com cath 523-1504-022
C 135 |470 pF +5% NPO 50V cer smd 510-3674-471 D 007 |Dual switch-com cath 523-1504-022
C 136|470 pF £3% NPO 50V cer smd 510-3674-471 D008 |18V zener 523-2601-180
C 137|470 pF £5% NPO 50V cer smd 510-3674-471 D 009 Dual switch-com cath 523-1504-022
C 138 1470 pF £5% NPO 50V cersmd  |510-3674-471 DO10 |18V zener 523-2601-180
C 139 1470 pF £5% NPO 50V cersmd  {510-3674-471] D011 |51V zener SOT-23 523-2601-519
C 140 |470 pF +5% NPO 50V cer smd 510-3674-471 D012 |Dual switch-com cath 523-1504-022
C 141 [470 pF £5% NPO 50V cer smd 510-3674-471
C 142|470 pF +5% NPO 50V cer smd 510-3674-471 F 001 {Fuse 0.5A smd 534-5002-009
C 143|470 pF £5% NPO 50V cer smd 510-3674-471
C 144 [470 pF +5% NPO 50V cer smd 510-3674-471 J 001 |Connector, 16-pin 515-7000-668
C 145 [470 pF £5% NPO 50V cer smd 510-3674-471 J 002 |Connector, 18-pin 515-7010-438
C 146 |470 pF £5% NPO 50V cer smd 510-3674-471 J 003 |Connector, 18-pin . 515-7010-438
C 147 [470 pF +5% NPO 50V cer smd 510-3674-471 J004 |Connector, 25-pin 515-7113-071
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1005 |Connector, 13-pin 515-7111-262 R 012 |100 ohm £5% 1/16W smd 569-0155-101
J 006 |Connector, 13-pin 515-7111-262 R 013 |4.7k ohm +5% 1/16W smd 569-0155-472
1007 [Connector, 5-pin S515-7111-254 R 014 |10k ohm +5% 1/16W smd 569-0155-103
J 008 |Connector, 12-pin 515-7111-261 R 015 |47k ohm +£5% 1/16W smd 569-0155-473
J009 [Connector, 2 x 14-pin 515-9500-045 R 016 |100 ohm £5% 1/16 W smd 569-0155-101

R0O17 |1k chm +5% 1/16W smd 569-0155-102
L 001 ;1.8 uH 350 masmd 542-9230-027 R 018 [10k ohm 5% 1/16W smd 569-0155-103
L 002 !1.8uH 350 masmd 542-9230-027 RO19 [10k ohm £5% 1/16W smd 569-0155-103
L 003 |[33uH 1.2A smd 542-9230-025 R 020 |6.8k ohm +5% 1/16W smd 569-0155-682
L 004 [Ferrite bead smd 542-9230-005 R 021 {1.0m ohm +5% 063W smd 569-0155-105
1. 005 [Ferrite inductor 542-9230-021 R 022 |15K ohm +5% 1/16W smd 569-0155-153
L 006 |Ferrite bead smd 542-9230-005 R 023 |6.8k ohm +5% 1/16W smd 569-0155-682
L. 007 |[1.8uH 350 masmd 542-9230-027 R 024 |1k ohm +£5% 1/16W smd 569-0155-102
L 008 |Ferrite inductor 542-9230-021 R 025 [Zero ohm jumper 569-0155-001
L 009 [Ferrite inductor 542-9230-021 R 026 |47k ohm £5% 1/16W smd 569-0155-473
L 010 (33 uH 70 ma smd 542-9230-029 R 027 |510k ohm £5% 1/16W smd 569-0135-514
L 011 [Ferrite inductor 542-9230-021 R 028 |Zero ohm jumper 569-0155-001
L 012 [Ferrite inductor 542-9230-021 R 029 |10k chm 5% 1/16W smd 569-0155-103

R 030 |10k ochm +5% 1/16W smd 569-0155-103
PC 000 |PC board, logic 035-1800-400 R 031 |10 ohm £5% 1/16W smd 569-0155-100

R 032 |10 ohm £5% 1/16W smd 569-0155-100
Q 001 |NPN general purpose 576-0003-658 R 033 |Zero ochm jumper 569-0155-001
Q002 [NPN switching 576-0003-714 R 034 |22k ohm +£5% 1/16W smd 569-0155-223
(Q 003 |NPN general purpose 576-0003-658 R 035 |22k ohm £5% 1/16W smd 569-0155-223
Q 004 |NPN general purpose 576-0003-658 R 036 |22k ohm 5% 1/16W smd 569-0155-223
Q 005 |NPN general purpose 576-0003-658 R 037 |Zero ochm jumper 569-0155-001
Q 006 |Transistor 576-0003-725 R 038 |10k ohm +5% 1/16W smd 569-0155-103
Q 007 |NPN general purpose 576-0003-658 R 040 {10k ohm +5% 1/16W smd 569-0155-103
(Q 008 [NPN Darlington SOT-23 576-0003-700 R 041 |47k ohm £5% 1/16W smd 569-0155-473
(Q 009 |NPN general purpose 576-0003-658 R 042 |Zero ohm jumper 569-0155-001
Q010 |NPN general purpose 576-0003-658 R 043 |1.0M ohm +5% 063 W smd 569-0155-105
Q011 [NPN general purpose 576-0003-658 R 044 |100k ohm +5% 1/6W smd 569-0155-104
Q012 [NPN general purpose 576-0003-658 R 045 {22k ohm +3% 1/16W smd 569-0155-223

R 046 |22k ohm +£5% 1/16W smd 569-0155-223
R 001 [4.7k ohm +5% 1/16W smd 569-0155-472 R 047 |22k ohm £5% 1/16W smd 569-0155-223
R 002 14.7k ohm £5% 1/16W smd 569-0155-472 R 048 |22k ohm +5% 1/16W smd 569-0155-223
R 003 {10k ohm £5% 1/16W smd 569-0155-103 R 049 |22k ohm £5% 1/16W smd 569-0155-223
R 004 [4.7k ohm +5% 1/16W smd 569-0155-472 R 050 |22k ohm £5% 1/16W smd 569-0155-223
R 005 |10k ohm £3% 1/16W smd 569-0155-103 R 051 |22k ohm 5% 1/16W smd 569-0155-223
R 006 |10k ohm +5% 1/16W smd 569-0155-103 R 052 |22k ohm +5% 1/16W smd 569-0155-223
R 007 [390k ohm +5% 1/16W smd 569-0155-394 R 053 |22k ohm +£5% 1/16W smd 569-0155-223
R 008 |10k ohm 5% 1/16W sind 569-0155-103 R 054 |22k ohm +£5% 1/16W smd 569-0155-223
R 009 |4.7k ohm +£5% 1/16W smd 569-0155-472 R 055 |22k ohm +5% 1/16W smd 569-0155-223
R 010 |Zero ochm jumper 569-0155-001 R 036 [22k ohm £5% 1/16W smd 569-0155-223
R 011 |10k ohm +3% 1/16W smd 569-0155-103 R 057 |22k ohm £5% 1/16W smd 569-0155-223
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PARTS LIST

Logic Board Assembly (Cont'd)

[Ref No, Description Part No. ef No. Description Part No.
R 058 |[22k ohm +5% 1/16W smd 569-0155-223 R 104 |6.8k ohm £5% 1/16W smd 569-0155-682
R 059 |22k ohm +5% 1/16W smd 569-0155-223 R 105 |[100k ohm +5% 1/6W smd 569-0153-104
R 060 |22k ohm £5% 1/16W smd 569-0155-223 R 106 |[100k ohm £5% 1/6W smd 569-0155-104
R 061 (22k ohm £5% 1/16W smd 569-0155-223 R 107 [10Ck ohm +5% 1/6W smd 569-0155-104
R 062 |(22k ohm +5% 1/16W smd 569-0155-223 R 108 |6.8k chm +£5% 1/8W smd 569-0105-682
R 063 |22k ohm £5% 1/16W smd 569-0155-223 R 109 |6.8k ohm +5% 1/16W smd 569-0155-682
R 064 iZero ochm jumper 569-0155-001 R 110 150 ohm £5% 1/16W smd 569-0155-151
R 065 |1k ohm +5% 1/16W smd 569-0155-102 R 11T ]150 ohm £5% 1/16W smd 569-0155-151
R 066 |10k ohm +5% 1/16W smd 569-0155-103 R 112 [100k ohm £5% 1/6W smd 569-0155-104
R 067 |10k ohm +£5% 1/16W smd 569-0155-103 R 113 |[100k ohm £5% 1/6W smd 569-0155-104
R 068 |10k ohm +5% 1/16W smd 569-0155-103 R 114 |10 ohm +£5% 1/16W smd 569-0155-100
R 069 |10k ohm +5% 1/16W smd 569-0155-103 R 115 [100k ohm £5% 1/6W smd 569-0155-104
R 070 |100k ohm +5% 1/6W smd 569-0155-104 R 116 |100 ohm £5% 1/16W smd 569-0155-101
R 071 |10k ohm +5% 1/16W smd 569-0155-103 R 117 |100k ohm £5% 1/6W smd 569-0155-104
R 072 [10k ohm £5% 1/16W smd 569-0155-103 R 118 |180k ohm +5% 1/6W smd 569-0155-184
R 073 [10k ohm +5% 1/16W smd 569-0155-103 R 119 |68k ohm 5% 1/16W smd 569-0155-683
R 074 110k ohm £3% 1/16W smd 569-0155-103 R 120 {390k ohm 5% 1/16 W smd 569-0155-394
R 075 |10k ohm £5% 1/16W smd 569-0155-103 R 121 |[6.8k ohm +3% 1/16W smd 569-0155-682
R 076 |[560 ohm +£5% 1/8W smd 569-0105-561 R 122 |56k ohm £5% 1/16W smd 569-0155-563
R 077 |100k ohm £5% 1/6W smd 569-0155-104 R 123 |47k ohm +5% 1/16W smd 569-0155-473
RO78 |47k ohm £5% 1/16W smd 569-0155-473 R 124 [47k ohm +5% 1/16W smd 569-0155-473
R 079 |10k ohm £5% 1/16W smd 569-0155-103 R 125 |6.8k ohm +£5% 1/16W smd 569-0155-682
R 080 [10k ohm +5% 1/16W smd 569-0155-103 R 126 |100k ohm £5% 1/6W smd 569-0155-104
R 081 [47k ohm +5% 1/16W smd 569-0155-473 R 127 |68k ohm £5% 1/16W smd 569-0155-633
R 082 |10k ohm £5% 1/8W smd 569-0165-103 R 128 |10k ohm +5% 1/16W smd 569-0155-103
R 083 |10k ohm £5% 1/8W smd 569-0105-103 R 129 |10k ohm +5% 1/16W smd 569-0155-103
R 084 |47k ohm +5% 1/16W smd 569-0155-473 R 130 |Zero ohm jumper 569-0155-001
R 085 100k chm £5% 1/6W smd 569-0155-104 R 131 [47k ohm +5% 1/16W smd 569-0155-473
R 086 {100k ohm +5% 1/6W smd 569-0155-104 R 132 |47k ohm £5% 1/16W smd 569-0155-473
R 087 |Zero ohm jumper 569-0155-001 R 133 |10k ohm £5% 1/16W smd 569-0155-103
R 088 ([47k ohm +5% 1/16W smd 569-0155-473 R 134 |10k ohm +£5% 1/16W smd 569-0155-103
R 089 (330 ohm +5% 1/16W smd 569-0155-331 R 135 |10k ohm £5% 1/16W smd 569-0155-103
R 090 |10k ohm +5% 1/16W smd 569-0155-103 R 136 |10k ohm £5% 1/16W smd 569-0155-103
R 092 [100k ohm +5% 1/6W smd 569-0155-104 R 137 |10k ohm £5% 1/16W smd 569-0155-103
R 093 {47k ohm £5% 1/16W smd 569-0155-473 R 138 |10k ohm +5% 1/16W smd 369-0155-103
R 094 [100k ohm £5% 1/6W smd 569-0155-104 R 139 |47k ohm £5% 1/16W smd 569-0155-473
R 095 (330 ohm +5% 1/16W smd 569-0155-331 R 140 {47k ohm #5% 1/16W smd 569-0155-473
R 096 [6.8k chm £5% }/16W smd 569-0155-682 R 141 [100k ohm 5% 1/6W smd 569-0155-104
R 097 6.8k ohm +5% 1/16W smd 569-0155-682 R 142 (100 ohm +5% 1/16W smd 569-0155-101
R 098 |47k ohm +5% 1/16W smd 569-0155-473 R 144 |10 ohm £5% 1/16W smd 569-0155-100
R 099 |47k ohm £5% 1/16W smd 569-0155-473 R 145 |Zero ohm jumper 569-0105-001
R 100 [6.8k ohm 5% 1/16W smd 569-0155-682 R 146 |4.7k ohm +5% 1/16W smd 569-0155-472
R 101 [390k ohm +3% [/16W smd 569-0155-394 R 147 |1k ohm £5% 1/16W smd 569-0155-102
R 102 [47k ohm +5% 1/16W smd 569-0155-473 R 148 |10k ohm +5% 1/16W smd 569-0155-103
R 103 |47k ohm +5% 1/16W smd 569-0155-473 R 149 |10k ohm +5% 1/16W smd 569-0155-103
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PARTS LIST

Logic Board Assembly (Cont’d)

Front Panel Assembly

[Ref No. Description Part No. [Ref No. Description Part No.
R 150 |10k ohm £5% 1/16W smd 569-0155-103 U021 | A/D converter, serial 8-bit AD7823|544-1010-041
R 151 |10k ohm +5% 1/16W smd 569-0155-103 U022 [Multiplexer, triple 4053 544-1014-053
R 152 [330 ohm £5% 1/16W smd 569-0155-331
R 153|330 ohm £5% 1/16W smd 569-0155-331 Y 001 |Crystal, 20.0000 MHz smd 521-3060-037
R 154 |100k ohm £5% 1/6W smd 569-0155-104 Y 002 |Crystal, 3.6864 MHz smd 521-3060-053
R 155 |100k ohm +5% 1/6W smd 569-0155-104
R 156 |10k ohm £5% 1/16W smd 569-0155-103 Front Panel Assembly
R 157 |47k ohm +5% 1/16W smd 569-0155-473 Part No. 023-5300-710
R 158 |100 ohm +5% 1/16W smd 569-0155-101
R 159 |10k ohm £5% 1/16W smd 569-0155-103 A 151 {Plastic front panel assembly 587-9650-002
R 160 4.7k ohm £5% 1/16W smd 569-0155-4728 15 713 | Display board assembly 023-5300-713
R 161 |Zero ohm jumper 569-0155-001
R 162 |Zero ohm jumper 569-0155-001 C 701 4.7 uF 20V tantalum smd 510-2626-479
R 163|100k ohm £1% 1/16W smd 569-0156-104 C702 |1 pF£10% X7R 50V cersmd  |510-3606-104
R 164 [33.2k ohm £1% 1/16W smd 569-0103-332 C703 |1 uF £10% XTR 50V cersmd  |510-3606-104
R 165 |10k ohm +5% 1/16W smd 569-0155-103 C 704 |4.7 uF 20V tantalum smd 510-2626-479
R 166 |Zero ohm jumper 569-0155-001 C705 |.1 pF=10% X7R 50V cersmd  |510-3606-104
R 167 |4.7k ohm =5% 1/16W smd 569-0155-4721 1= 706 |1 uF £10% X7R 50V cersmd  |510-3606-104
R 168 | Zero ohm jumper 569-0155-001 C 707 4.7 uF 20V tantalum smd 510-2626-479
R 169 | Zero ohm jumper 569-0105-001 C 708 |20 pF NPO £5% cer smd 510-3601-200

C 709 {20 pF NPO +£5% cer smd 510-3601-200
$001 |Switch, detector mom norm-on 583-9512-002 C 710 |.1 pF 210% X7R S0V cer smd 510-3606-104
C711 |1 pF £10% X7R 50V cersmd  |510-3606-104
U001 |Programmable logic 023-1870-043 C 712 |.047 uF £10% X7R 50V cersmd |510-3605-473
U002 |Flash CMOS 512k x 16 ATASF  |544-1028-192 C713 |47 uF 63V tantalum smd 510.2623-479
U003 |ADSIC, DSP support BGA106  1544-1010-015 C714 |.1 uF£10% X7R 50V cersmd  |510-3606-104
U 004 | NAND, 2-input TC7SHOO 544-1010-012 C715 |1 uF£10% X7R 50V cersmd  |510-3606-104
U005 |RAM, static 128k x 8 544-1011-028 C716 |.1 uF+10% X7R 50V cersmd  |510-3606-104
U o0s g?\f ls‘:z?; 1152\;&( . entononel  [C717 |1 HE£10%XTR 50V cersmd - [510-3606-104
CY7(_:1009—15VC C750 |47 pF IOVotantalum smd 510-2624-479
U007 {RS-232 driver LTC1338IG 544-1015-706 (c: ;ii '8: :‘; i:g ;‘: i;i ; g:// EZ: 223 : :g:gzgzigg
U008 |EEPROM,32k x 8 AT24C256W  |544-1020-256 cres |0 F £10% XTR 30V corsmd | 510.3606.103
U009 |Microprocessor MC68HC708 544-1030-007 c 754 .l 0 uF 35V tantalum smd 510-2628-109
U010 |EEPROM lk 2.5V 24LC02B 544-1012-402 '
U0l |DC-DC converter, 5V MAXT44AE| 544-1010-744]  |C 73> |#7 HF 10V tantalum smd 510-2624-479
U012 |Dig sign proc TMS320C50PGEA |s4d-1010-018]  |C 720 |01 KF £10% XTR S0V cersmd ) 310-3606-103
U013 |Regulator, 5V LT1121IST-5 544-1011-121 _
U014 |RS-485 driver SN65176 544-2023-027 CR 701 HC diode SOT-23 323-1304-016
UOLS {Op amp, quad 324 544-1020-3241 0 700 | Duat color, red/gr LED 549-4001-215
U016 |Multiplexer, triple 4053 544-1014-053 :
U017 |Op amp, dual 358 544-1020-385 DDSSTI%E LED, green smd 349-4001-145
U018 1 Op amp, dual 358 544-1020-3851  15g 707.|LED, green smd 549-4003-011
U019 |Op amp, dual 358 544-1020-385 DS726
U020 |UART, dual SCC2692 544-1010-038 DS 727 |LCD assembly 549-4501-010
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PARTS LIST

Front Panel Assembly (Cont’d)

IRef No. Description Part No. [Ref No, Description Part No.
R 701 620 ohm +5% 1/8W smd 569-0105-621
EP 101 |Key cap kit (see Section 2.5) 587-5300-001 R 702 |47k ohm £5% 1/8W smd 569-0105-473
R 703 {47k ohm +5% 1/8W smd 569-0105-473
F 700 |Fuse, 2.0 A simd 534-5001-009 R 704 |47k ohm £5% 1/8W smd 569-0105-473
R 705 |47k ohm +5% 1/8W smd 569-0105-473
HW 010, Washer, 438 x .274 x .030 596-9410-010 R 706 |47k ohm +£5% 1/8W smd 569-0105-473
HWO011|Nut, spanner 3/8 x 7mm 013-1313-018 R 707 |47k ohm +5% 1/8W smd 569-0105-473
HW 012 Screw, 2-56 x 1/4” 575-1602-008 R 708 |47k ohm 5% 1/8W smd 569-0105-473
HW 013 Lockwasher, internal No. 2 596-2102-006 R 709 [47k ohm £5% 1/8W smd 569-0105-473
R 710 |620 ohm +5% 1/8W smd 569-0105-621
J101  Connector, 2-pin 515-9031-281 R 711 |47k ohm £5% 1/8W smd 569-0105-473
J 102 [Connector, elastomeric 515-9900-002 R 712 |47k ohm £5% 1/8W smd 569-0105-473
J700 {Connector, 16-pin 515-7000-668 R 713 |[47k ohm 5% 1/8W smd 569-0105-473
J 701 [Connector, micro-miniature 515-7113-073 R 714 |10k ohm +5% 1/8W smd 569-0105-103
J 702 (Connector, 9-pin ZIF flex 515-7111-321 R 715 |47k ohm £5% 1/8W smd 569-0105-473
J 703 Connector, 13-pin circular recept |515-1009-025 R 7t6 |47k ohm £5% 1/8W smd 569-0105-473
J704 Connector, 3-pin 515-7000-643 R 717 |47k ohm £5% 1/8W smd 569-0105-473
J 705 Connector, 31-pin 515-7109-130 R 718 [47k ohm +5% 1/8W smd 569-0105-473
R 720 [47k ohm £5% 1/8W smd 569-0105-473
LS 001 {Speaker, 2 x 3 in 16-ohm 589-1015-006 R 721 |47k ohm 3% 1/8W smd 569-0105-473
R 722 |10k ohm £5% 1/8W smd 569-0105-103
MP 101 | Display bezel 017-2226-046 R 723 |47k ohm 5% 1/8W smd 569-0105-473
MP 102 Display gasket 018-1136-120 R 724 {47k ohm £5% I/8W smd 569-0105-473
MP 103 Light pipe 032-0792-032 R 725 {10k ohm £5% 1/8W smd 569-0105-103
MP 108 Support-keypad 017-2226-090 R 726 {47k ohm +5% 1/8W smd 569-0105-473
MP 151{Gasket front lens 018-1136-108 R 727 {10k ohm +5% 1/8W smd 569-0105-103
MF 1321Control knob 032-0792-010 R 728 {1M chm +5% 1/8W smd 569-0105-105
MP 153{Control knob 032-0792-010 R 729 110k ohm +£5% 1/8W smd 569-0105-103
MP 154 |Speaker membrane 018-1136-112 R 730 {4.7k ohm +5% 1/8W smd 569-0105-472
MP 155{Pad, display board 018-1136-122 R 731 3.3k ohm £5% 1/8W smd 569-0105-332
MP 158! Front panel lens -, 1032-0792-034 R 732 |10k ohm +5% 1/8W smd 569-0105-103
MP 160i Spacer (between boards) h \1 Pld}—} 188-053 R 733 |10k ohm £5% 1/8W smd 569-0105-103
MP 161 Keypad, standard 032-0792-030 R 734 |10k ohm +5% }/8W smd 569-0105-103
MP 162 |Speaker retainer 016-2187-250 R 735 |4.7k ohm £5% 1/8W smd 569-0105-472
NP 001 {Johnson label raised 559-9001-310 R 736 |10k ohm £5% 1/8W smd 569-0105-103
R 737 |4.7k ohm =5% }/8W smd 569-0105-472
PC 010 |Flex circuit 035-5300-010 R 738 |10k ohm £5% 1/8W smd 569-0105-103
PC 710 |PC board, display/controller 035-5300-710 R 739 3.3k ohm 5% 1/8W smd 569-0105-332
R 740 |47k ohm £5% 1/8W smd 569-0105-473
Q 701 [NPN general purpose 576-0003-658 R 741 |300 ohm +5% 1/8W smd 569-0105-301
(Q 702 |NPN general purpose 576-0003-658 R 742 |47k ohm +5% 1/8W smd 569-0105-473
Q 710 |PNP general purpose 576-0003-650 R 743 |47k ohm £5% 1/8W smd 569-0105-473
Q 711 |NPN general purpose 576-0003-658 R 744 |47k ohm £5% 1/8W smd 569-0105-473
Q 712 |NPN general purpose 576-0003-658 R 745 |10k ohm £5% 1/8W smd 569-0105-103
R 746 |3.3k ohm 5% 1/8W smd 569-0105-332
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DC Power Cable Assembly

[Ref No. Description Part No. IRef No, Description Part No.

R 747 |47k ohm £5% 1/8W smd 569-0105-473]  [R813 [47k ohm =5% 1/8W smd 569-0105-473
R 748 |10k ohm 5% 1/8W smd 569-0105-103|  [R 814 |47k ohm +5% 1/8W smd 569-0105-473
R 749|470 ohm 5% 1/8W smdl 569-0105-471 R 815 |1.0k ohm £5% 1/8W smd 569-0105-102
R 750 |470 ohm 5% 1/8W smdl 569-0105-471
R 751 |470 ohm £5% 1/8W smdl 569-0105-471 S 001 |DIP switch, 10-position 583-5100-210
R 752 {Zero ohm jumper 569-0105-001 S 154 | On-off’Vol push on w/50k pot 562-0018-075
R 753 47k ohm +5% 1/8W smd 569-0105-473 S 155 |Switch rotary and push 583-2042-001
R 754 |47k ohm +£5% 1/8W smd 569-0105-473
R 755 |47k ohm 5% 1/8W smd 569-0105-473]  |U 700 |Op amp, quad MC3303 544-2020-008
R 756 |Zero ohm jumper 569-0105-001 U701 |RS-485 driver SN65176 544-2023-027
R 757 |100k ohm +5% 1/8W smd 569-0105-104|  |U 702 |Regulator, 5V LP2951 544-2003-067
R 758 |Zero ohm jurnper 569-0105-001 U 703 |Microprocessor, MC 023-9998-450
R 761 |2.20hm £5% 2512smd 1W 569-0175-229|  |U 704 |Buffer, open drain MM74C906  |544-3716-906
R762 |10k ohm +5% 1/8W smd 569-0105-103|  |U710 |LCD driver, PCF8576TD 544-2027-010
R 763 |47k ohm £5% 1/8W smd 569-0105-473|  |U711 |LCD driver, PCF8576TD 544-2027-010
R 764 |10k ohm +5% 1/8W smd 569-0105-103|  fU 712 |Regulator, 8V 0.5A 78M08 544-2003-081
R 765 |47k ohm 5% 1/8W smd 569-0105-473
R 766 |47k ohm £5% 1/8W smd 569-0105-473 W 103 |Cable assembly, display 597-2002-265
R 767 (300 ohm £5% 1/8W smd 569-0105-301 Y 700 |3.6864 MHz crystal fundamental |521-0003-685
R 768 |47k ohm 5% 1/8W smd 569-0105-473
R 769 |10k ohim =5% 1/8W smd 569-0105-103 DC Power Cable Assemb|y
R 770 |47k ohm 5% 1/8W smd 569-0105-473 Part No. 023-9750-010
R 771|100k ohm +5% 1/8W smd 569-0105-104
R 772 1200k ohm £5% 1/8W smd 569-0105204 |4 001 [Fused DC power cable 023-0650-008
R 774 {300 ohm +5% 1/8W smd 569-0105-301 (sce separate listing)
R 775 {200k ohm +5% 1/8W smd 569-0105-2041 | A 602 |Mic clip ground wire 023-7171-911
R776 |31 ohm £5% 1/8W smd 369-0105-5101  1Ep 002 |Ring terminal, 3/4” 10-12 AWG | 586-0001-036
R777 |47k ohm £5% 1/8W smd 569-0105-473  1Ep 003 |Ring terminal, 3/8” 10-12 AWG  |586-0001-019
R 778|100k ohm %5% 1/8W smd 569-0105-104[ £ 101 |Fuse, 15 amp 32V 534-0003-038
R779 100k ohm +5% 1/8W smd 369-0105-104 HW 000 Key extraction tool 017-2226-000
R780 300 ohm +5% 1/8W smd 269-0105-3011  Hpw 001/ Butt splice insulated (2) 586-9008-061
R 781 1300 ohm 5% 1/8W smd 569-0105-3011 113w 002 Screw, 4-40 x 3/8” pan head (1) |575-0604-012
R 800 180k ohm £5% I/BW smd 269-0105-184) 3y 003 Screw, 4-24 x 1/4” phil (3) 575-3604-008
R 801 100k ohm +5% 1/8W smd 569-0105-1041 13w 004 Screw, 4-20 x 5/8” phil (3) 575-5604-020
R 802 |100k ohm 5% 1/8W smd 569-0105-104] | \1p 001 | Heavy-duty mic clip 023-3514-001
R 803 |620hm+5%2010.75Wsmd  |569-0135-620
R804 |62 0hm+5%2010.75W smd  |569-0135-620 Fused DC Power Cable
R 805 |62 ohm £5% 2010 .75W smd 569-0135-620 Part No. 023-9650-008
R806 |62 0hm+5%2010.75Wsmd  [569-0135-620]  |Ep 101 [Female crimp pin 515-0032-540
R 807 1510 ohm +5% 1/8W smd 569-0105-511 FH 001 |Fuse holder in-line includes:
R 808 |620hm=+5%2010.75Wsmd  |569-0135-620 Contact 534-1004-037
R 809 |620hm=5%2010.75W smd  |569-0135-620 Body 534-1004-031
R 810 [510 ohm =5% 1/8W smd 569-0105-511 Knob 534-1004-032
R 811 |10k ohm 5% 1/8W smd 569-0105-103 Spring 534-1004-035
R 812 |10k ohm 5% 1/8W smd 569-0105-103
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PARTS

LIST

[Ref No. Description Part No. Ref No| Description Part No.
HW 101 Wire seal 574-9025-035 MKO001 | Dynamic mic cartridge 589-1011-003
ML 001{Negative ground warning tag 559-4014-001 MPO0O01 |Case front black 032-0426-100
ML 002|Jump start warning label 559-4057-010 MPOQ2 |Case back black 032-0427-100
P 101 |2-pin female power connector 515-9032-535 MP003 |Actuator black 032-0428-0350
W 101 [Wire, 12 AWG stranded blue 597-7021-206 MPO04 |Cartridge gasket 032-0429-075
W 102 |Wire, 12 AWG stranded red 597-7021-202 MPO0OS (Btlast filter 018-1033-002
MP006 | Switch bracket 017-1885-030
Accessory Wire Harness Kit MP007 [Hanger button 013-1216-005
Part No. 023-9750-011 MP008 |Crimp retainer 017-2222-006
MP009 [Rubber bumper 018-0798-009
Fuseholder components: MPO10 |Backing plate 015-0876-026
EP 001 | Contact 586-9004-001 MPO11 |Strain relief, mic cord 032-0429-
FO01 | Fuse, 1A 250V FB AGC 534-0003-020 _ 0867
MP001 | Fuseholder body 534-1004-031 MP(012 |Shim support, rubber bumper 017-2222-007
MP002 | Fuseholder knob 534-1004-032 ?\1411:(?3? :‘;ﬁ;};‘im g;gggggg;
MP003 | Fuseholder spring 534-1004-035 .
PC001 |PC board, amplifier 035-0441-020
HW 001|Pin contact, crimp type 515-1501-055 Q001 |NPN amplifier SOT—23' 576-0003-658
P 101 |8-pin receptacle housing 515-1501-050 RO01 |51k ohm x3% 1/8W cl.np 269-0115-513
R 002 {18 ohm +5% 1/8W chip 569-0115-180
S 001 {Leafswitch SPST 583-1004-031

Mounting Bracket Assembly
Part No. 023-9750-012

HW 001
HW 002
MP 101
MP 201

Self-drilling screw 1/4” (4)
Self-drilling screw #10 (4)
Knob 10-32 1/2”

Transceiver mounting bracket

575-9077-565
575-9077-545
547-0016-007
017-2226-034

15 Watt, 4.0-ohm Speaker (Black)
Part No. 250-0151-006

HW001
HW002
HWO003

Strain relief (in case back)
Screw, self drilling

Screw, 4-20 x /2 pan head
Foam gasket

Urethane foam, 1/16” thick
Speaker, 5" 15W 4.0 ohm
Case front (black)

Case back (black)
Mounting bracket (black}
Tri knob 10-32

Overlay, speaker front
Crimp wire contact
Speaker wire, 22 AWG (6 ft used)

574-0003-008
574-9077-543
575-5604-016
018-1126-001
042-0361-318
589-1016-003
032-0758-004
032-0759-004
032-0760-004
547-0016-004
559-0072-010
515-5010-055

597-2006-002

HWO005

Amplified Dynamic Microphone gg‘]”
C 001 {3.3 uF 16V tantalum chip 510-2625-339 MP002
C 002 220 pF +£5% NPQ 50V cerchip  [510-3602-221 MP003
EP001 [Contact .038" diameter 586-9008-100 MP004
EP002 |Mic cord w/Hirose connector 597-2002-255 NP0OO1
EP004 |Terminal (on hanger) 022-0069-011 P 001
HWOO01 [Screw 4-20 x 3/8 575-5604-012 W 001
HWO004{Screw 2-56 x 3/8 575-1602-012
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